
 
1. Report No. 
 
FHWA/OH-2008/3 

2. Government Accession No. 3. Recipient's Catalog No. 

5. Report Date 
 
   March 2008 

4. Title and subtitle 
 
 
Pavement Forecasting Models 

6. Performing Organization Code 

8. Performing Organization Report No. 7. Author(s) 
 
Eddie Chou, Haricharan Pulugurta, Debargha Datta 

10. Work Unit No. (TRAIS) 

11. Contract or Grant No. 
 
   134148 

9. Performing Organization Name and Address 
 
University of Toledo 
Department of Civil Engineering 
Mail Stop 307 
Toledo, OH  43606-3390 

13. Type of Report and Period Covered 
12. Sponsoring Agency Name and Address 
 
Ohio Department of Transportation 
1980 West Broad Street 
Columbus, Ohio  43223 

14. Sponsoring Agency Code 

15. Supplementary Notes 

16. Abstract 
 
 

The primary objectives of this study were to develop models to forecast future pavement conditions and to 
determine remaining service life of pavements based on the forecasted conditions.  Based on available data 
in the ODOT pavement database, which contains the condition history of each pavement section, along with 
its location, year of construction, thickness, materials used, climate, and rehabilitation records, individual 
regression, family regression, and Markov probabilistic models were developed .  For the latter two models, 
pavements were first grouped into “families” with similar characteristics, based on pavement type, priority, 
District location, and past performance.  Forecasting models were then developed for each such “family”.  
The developed models were evaluated by comparing the predicted conditions with the actual observed 
conditions for the five year period between 2001 and 2005.  The Markov model was found to have the 
highest overall prediction accuracy among all the models evaluated, and it can also predict future distresses 
in addition to the PCR values.  As a result of this study, ODOT can forecast future pavement conditions and 
estimate the remaining service life of pavements. Future rehabilitation needs can also be determined. Such 
capabilities will significantly benefit planning and management decision-makings at both project and 
network levels. 

 
 
 
17. Key Words                                                                                               
 
Pavement Condition Forecasting, Performance Prediction, Markov 
Probabilistic Model 

18. Distribution Statement 
 
No restrictions. This document is 
available to the public through the 
National Technical Information Service, 
Springfield, Virginia 22161 

19. Security Classif. (of this report) 
Unclassified 

20. Security Classif. (of this page) 
Unclassified 

21. No. of Pages 
       212 

22. Price 

Form DOT F 1700.7 (8-72)                        Reproduction of completed pages authorized 



 

 

 



 

 
 
 
 
 
 
 

Pavement Forecasting Models 
 
 
 

Final Report 

State Job No. 134148 

 
 
 

Principal Investigator: Eddie Y. Chou 
 

Co-Authors: Haricharan Pulugurta, Debargha Datta 
 
 

The University of Toledo 
 
 
 

Prepared in Cooperation with  

The Ohio Department of Transportation 

 and 

The U. S. Department of Transportation 

 Federal Highway Administration 

 
 
 
 
 

March 2008 



 

 

 
 



 

 

 
 
 
 
 
 
 
 
 
 

DISCLAIMER 
 

The contents of this report reflect the views of the authors who are responsible for the facts 

and the accuracy of the data presented herein.  The contents do not necessarily reflect the 

official views or policies of the Ohio Department of Transportation or the Federal Highway 

Administration.  This report does not constitute a standard, specification, or regulation. 



 

 

 

 

 

 

ACKNOWLEDGMENTS 

 
The authors would like to thank the Ohio Department of Transportation and the Federal 

Highway Administration for supporting this study. 

 

The assistance provided by the technical liaisons of this project ─ Mr. Andrew Williams, Mr. 

Roger Green, and Mr. Aric Morse ─ are greatly appreciated.  The authors also thanks Mr. 

Emil Marginean of the Office of Pavement Engineering for providing updates on the 

pavement condition and traffic data.  Without their assistance, this study could not have been 

completed.   



 

 

 

 

 

TABLE OF CONTENTS 

Page 

 
List of Figures ................................................................................................................. v 

List of Tables .................................................................................................................. vii 

Executive Summary ....................................................................................................... I 

Introduction .................................................................................................................... 1 

Objective of Research .................................................................................................... 6 

General Description of Research ................................................................................... 7 

Findings of the Research Effort ..................................................................................... 35 

Conclusion and Recommendations ................................................................................ 74 

Implementation Plan ...................................................................................................... 79 

 

 

Appendix A: References ...........................................................................................  A1 

Appendix B: Rehabilitation Decision Trees .............................................................  B1 

Appendix C: PMIS User Manual ..............................................................................  C1 

Appendix D: Local PMIS User Manual....................................................................  D1 

 



 

 

List of Figures 
 

Figure 1.  Role of Condition Forecasting Model in a Pavement Management System 
 …………………………………………………………………………   2 

Figure 2.  Pavement Condition Deterioration Trend for General System Flexible Pavement 

treated with Activity Code 50 in Districts 2 and 11……………………  5 

Figure 3.  Actual versus Predicted PCR Using Straight Line Equations …………  10 

Figure 4.  Adjusting Individual Deterioration in Relation to Family Deterioration...  13 

Figure 5.  Markov PCR Prediction versus Actual Average Trends ………………  15 

Figure 6.  Imputed Average and Actual Average …………………………………  16 

Figure 7.  Predicted and Actual Average Rutting Deducts in District 11…………  19 

Figure 8.  Predicted and Actual Average Block and Transverse Cracking Deducts in 

District 11……………………………………………………  20 

Figure 9.  PCR Family Curves (District 11, General Flexible Overlays, 1995-2006)  21 

Figure 10.  Predicted and Actual Average Rutting Deducts, District 2………..……  22 

Figure 11.  Predicted and Actual Average Wheel Track Cracking Deducts (District 2) 

 ……………….……………….……………….…………………….…  22 

Figure 12.   Predicted and Actual Average of Block and Transverse Cracking Deducts, 

District 2……………….……………….……………….………………  23 

Figure 13.  Predicted and Actual Average PCR Trends, District 2…………………..  23 

Figure 14.  Mileage Distribution of Repair Type, for Composite Pavements………..  27 

Figure 15.  Mileage Distribution of Repair Type, for Flexible Pavements …………  27 

Figure 16.  Initial Value of Raveling from Linear Fit of Years 2, 3, and 4…………..  28 

Figure 17.  Markov Model Predicted PCR for an Individual Pavement Section………… 37 

Figure 18.  Predicted Conditions with Confidence Interval…………………………..  37 

Figure 19.  Actual PCR versus Different Model Predicted PCR for a Pavement Section in 

District 11 Treated with Activity Code 50………………………………… 39 

Figure 20.  Markov Predicted PCR vs. Actual PCR (2002-2006) ……………………. 41 

Figure 21.  Sudden Drop in PCR……………………………………………………… 42 

Figure 22.  Fluctuation in PCR ………………………………………………………  43 

Figure 23.  Family Regression Predicted PCR vs. Actual PCR (2002-2006)………..  44  

Figure 24.  Family Regression Predicted PCR vs. Actual PCR (2002-2006) ………..  45 



 

 

Figure 25. Prediction Error Increases with Time………..………..………..………..  46 

Figure 26. Remaining Service Life of Pavements in Each Districts………..………..  48 

Figure 27. Determine Initial Distress Level from the Distress Levels in Years 2, 3, 4, 5 51 

Figure 28. Initial Distress Level after Overlay as a Function of Prior Distress Level  52 

Figure 29. View Predicted Pavement Condition with Work Plan Tool……………… 64 

Figure 30. Predicted PCR Trend with and without Planned Treatment……………… 64 

Figure 31. Condition Distribution of Local Pavements in Each District……………… 70  

Figure 32.  PCR Trend Based on Individual Slope for a Pavement Section …………… 72 

Figure 33.  PCR Trend based on Average Sloped for a Pavement Section …………… 72 

 
 
 
 
 
 



 

 

  
 

List of Tables 
 

Table 1. Existing Performance Prediction Equations ………………………………  9 

Table 2. Transition Matrix for Rutting Distress, District 11, General Flexible Pavements 

Overlays (1995-2006) ...…...…...…...…...…...…...…...…...…...…...…...  18 

Table 3.  Transition Matrix for Block and Transverse Cracking, District 11, General 

Flexible Pavements Overlays (Activity 50) 1995-2006…………………….  20 

Table 4.  Activity Codes ………………………………………………………...…… 26 

Table 5.  Distress Types Included in Structural and Cracking Deducts ……………... 29 

Table 6.  Flexible and Composite Pavements Distress Codes and Deducts Pre-2004 and 

Since 2004…………………………………………………………….........  31 

Table 7.  Concrete Pavements Distress Codes and Deducts Pre-2004 and Since 

2004……………………………………………………………..…………  32 

Table 8.  Predicted Pavement Conditions from the Three Models…………………… 36 

Table 9. Data Used for Validation…………………………………………………… 38 

Table 10. Actual PCR vs. Different Model Predicted PCR…………………………… 40 

Table 11. Comparison of Model Accuracies…………………………………………… 47 

Table 12. Average Distress Levels Before and After Treatment and Average Initial PCR 

Values………………………………………………………………………… 55 

Table 13. Effect of Planned Work Example…………………………………………… 67 

Table 14. Summary of Local Pavement PCR Data and Current Condition…………… 69  

 

 
 
 
 



 

The Ohio Department of Transportation 
Office of Research & Development 
Executive Summary Report 
 

 
Pavement Forecasting Models

 
 
Start Date: November 1, 2003 
 
Duration: 54 months 
 
Completion Date: April 30, 2008 
 
Report Date: March 2008 
 
State Job Number: 134148  
Report Number: 
 
Funding: $308,040  
 
Principle Investigator: 

Eddie Y. Chou, Ph.D., P.E. 
University of Toledo 
419-530-8123 
ychou@utnet.utoledo.edu 

 
ODOT Contacts: 

Technical: 
Roger Green 
Andrew Williams 
Office of Pavement Engineering 
614-995-5993 
614-752-4059 
Administrative: 
Monique R. Evans, P.E. 
Administrator, R&D 
614-728-6048 

 
For copies of this final report go to 
http://www.dot.state.oh.us/divplan/

research 
or call 614-644-8173. 

 
Ohio Department of Transportation 
Office of Research & Development 

1980 West Broad Street 
Columbus, OH 43223 

 
 

 

 
 

Problem 
 

The ability to forecast future pavement condition 
is highly valuable in supporting various pavement 
management decisions.  ODOT has compiled 
roadway inventory, pavement condition history, 
and construction activities data into a 
comprehensive pavement management database.  
To fully benefit from this database to support 
decisions regarding future repair strategies, it is 
necessary to forecast future conditions and to 
determine the remaining service life of pavement 
sections.  Such forecasting capability will 
significantly benefit ODOT in choosing the most 
cost-effective rehabilitation strategies to maintain 
and preserve the State’s highway systems. 
  

Objectives 
 
1. To develop models to forecast future 

pavement conditions using data available to 
ODOT. 

2. To determine remaining service life of 
pavement sections based on the forecasted 
condition.   

3. To develop decision trees for selecting 
rehabilitation strategies. 

4. To determine an appropriate initial PCR rating 
for a rehabilitated pavement section. 

5. To include local federal aid routes in the 
pavement management database. 

 
Description 

 
After reviewing the literature, several different 
pavement condition forecasting models were 
developed based on available data in the ODOT 

http://www.dot.state.oh.us/divplan/research
http://www.dot.state.oh.us/divplan/research


 

 

pavement database, which contains the 
condition history of each pavement section, 
along with its location, year of construction, 
thickness, materials used, climate, and 
rehabilitation records.  

Individual regression, family regression, 
and Markov probabilistic models were 
developed.  For the latter two types of 
models, pavement sections were first 
grouped into “families” of similar 
characteristics, based on pavement type, 
priority, District location, and past 
performance.  Forecasting models were then 
developed for each such “family”.  The 
developed models were evaluated by 
comparing the predicted conditions with the 
actual measured conditions for the five year 
period of 2001-2005.   

 
Findings 

 
The Markov model has the highest overall 
prediction accuracy among all the models 
evaluated, and it has the important 
advantage of being able to predict future 
distresses in addition to the PCR values.      

The remaining service life of each 
pavement section is determined based on the 
conditions predicted by the Markov model 
and a terminal condition specified by the 
user.  The default terminal condition for 
Priority system pavements is a PCR value 
below 65, and for General system 
pavements, a PCR below 60.   

Appropriate initial PCR values after 
various maintenance and rehabilitation 
treatments were determined after analyzing 
distress progressions after the treatment.  
These initial PCR values provide a more 
realistic reflection of the actual pavement 
condition, and encourage selection of 
treatments that are longer-lasting. 

A set of rehabilitation treatment decision 
trees were developed in cooperation with the 
Office of Pavement Engineering staff.  
These decision trees consider pavement 

type, priority, traffic volume, past treatment 
and performance, and current distress 
condition to recommend an appropriate 
maintenance or rehabilitation treatment for a 
given pavement.  A tool has also been 
developed to apply the decision trees to the 
forecasted pavement conditions, thereby 
allowing the consequences of different 
multiyear work plans to be evaluated.   

In addition to the database for the entire 
State highway network, a database for local 
federal-aid routes was developed as an 
addendum to this study.  Although the data 
currently available for local routes are much 
less complete than that for State routes, tools 
have been developed to help local agencies 
manage their pavement assets.   

 
Conclusions & Recommendations 

 
As a result of this study, ODOT can forecast 
future pavement conditions and estimate the 
remaining service life of pavements.  
Current and future rehabilitation needs can 
also be determined.  Such capabilities will 
benefit planning and management decision-
makings at both project and network levels.   

The Markov model is recommended due 
to its overall accuracy and its ability to 
predict individual distress in addition to 
PCR.  Further efforts to integrate the 
outcomes of this study into a decision 
support tool that will be used routinely by 
the Central and Districts Offices is 
recommended. 
 

Implementation Potential 
 
The pavement forecasting model and 
various tools developed in this study have 
been included in the current ODOT 
pavement management database.  They may 
be implemented readily as part of a 
comprehensive Pavement Management 
System.  
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INTRODUCTION 
 

The Ohio Department of Transportation (ODOT) spends several hundred million dollars each 

year on pavement reconstruction and rehabilitation.  Allocating the available budget to 

various competing projects requires a proper decision making process supported by 

knowledge regarding the current and future system conditions.  

 

The ability to forecast future pavement condition is very useful in supporting various 

pavement management decisions.  Decision makers can use the predicted future pavement 

conditions to determine the budget level required for maintenance and rehabilitation, to 

prioritize pavement repairs, and to develop multiyear rehabilitation work plans.   

 

ODOT has compiled roadway inventory, pavement condition history, and construction 

activities data into a pavement management database.  To fully benefit from this database to 

support decisions regarding future repair strategies, it is necessary to forecast future 

conditions and determine the remaining service life of pavement sections.    

 

The main purpose of this study was to use the data available in the ODOT pavement database 

to develop a pavement forecasting model to predict future pavement conditions and to 

estimate the remaining service life of pavements.  The ability to forecast the future condition 

and to estimate the remaining service life of pavements will significantly benefit ODOT in 

choosing the most cost-effective maintenance and rehabilitation strategies to preserve the 

State’s highway systems. 

 

Figure 1 shows the central role of pavement condition forecasting models within a pavement 

management system.    
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Figure 1.  Role of Condition Forecasting Model in a Pavement Management 

System 
 

 

The current pavement condition rating (PCR) system assigns a rating of 100 to new/under 

construction sections, if the pavement is being rehabilitated when the rater visits.  However, 

depending on the actual rehabilitation treatment performed, some of the existing distresses 

may not be completely eliminated and could resurface rather quickly after treatment.  As a 

result, some rehabilitated pavement sections deteriorate much faster than others, depending on 

the repair treatment applied and the distress condition prior to the repair.  If many such ‘band-

aid’ repairs were performed, the average PCR values in a single year can be misleading.  

Therefore, the second purpose of this study was to determine the most reasonable initial rating 

for the repaired section taking into account the distress condition of the pavement being 

repaired and the specific repair treatment applied.   

 

Given the specific condition and traffic loading of a pavement, the most suitable maintenance 

or rehabilitation treatment action can often be determined with the help of a decision tree.  

Another purpose of this study was to develop and implement pavement maintenance and 

rehabilitation decision trees for different pavement types and priorities, in cooperation with 
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the Office of Pavement Engineering.  By applying the decision trees to the forecasted 

pavement conditions, treatment needs in future years can be determined.  ODOT decision 

makers can then formulate multi-year work plans based on budgetary and other constraints.  

 

Background 

 

Various models have been proposed to predict future pavement conditions.  Given the 

numerous known and unknown parameters that can influence the performance of a pavement, 

a statistical approach based on past performance history is most widely accepted by highway 

agencies.  Some statistical models are developed based on data collected from a single test 

road.  For example, the AASHTO Design Equations originated from the results of the 

AASHO road test.  Other statistical models are based on data collected from test roads located 

at diverse geographical locations.  The LTPP test project is a rather extreme example, with 

pavement sections monitored throughout the entire United States.  However, due to the 

enormous cost to construct and monitor pavements, the number of LTPP sites in Ohio is 

rather limited.  Therefore, a more practical and sensible approach is to develop prediction 

models based on data collected from in-service pavements in a state or region.  The ODOT 

pavement management database, which contains detailed in-service pavement conditions, 

traffic, and construction records since 1985 for all highways in the State of Ohio, provides an 

excellent basis to develop pavement condition forecasting models for Ohio.  This database 

includes the most essential information needed to forecast pavement performance.  These 

include functional class, pavement type and location, construction date (pavement age) and 

the specific maintenance and rehabilitation treatment performed, pavement structural buildup 

and materials used, pavement condition rating (PCR) and individual distress rating history, 

and traffic loading.   

 

The first step in developing a pavement condition forecasting model is to determine the 

parameter or parameters to be predicted and the factors that affect the predicted parameter.  

ODOT has been using PCR as the primary indicator of pavement condition and for decision-

making.  Therefore, predicting a pavement section’s PCR is obviously important.  Previous 

studies have found that a pavement’s PCR value is mostly dependent on age, with different 

pavement types having different rates of deterioration.  Despite their simplicity, however, 
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such models are rather inaccurate in their prediction.  That is, they often have relatively large 

prediction errors and low coefficients of determination (R-square).  In fact, pavements of the 

same type can have significantly different deterioration trends due to differences in structures 

(layer thicknesses and materials), subgrade soil support, climate, pre-existing defects, traffic 

loadings, maintenance practices, etc.  Figure 2 show the deterioration trends of overlays 

constructed between 1995 and 2006 on Districts 2 and 11 General system flexible pavements.  

It is apparent that pavements with the same age can have significantly different PCR values. 

 

A pavement’s PCR value is determined from the observed surface distresses: cracking, rutting, 

raveling, etc.  The ODOT pavement database contains both the PCR history and the 

corresponding individual distresses.  Different distresses may progress quite differently with 

time, and different repair treatments may be required depending on the type of distresses 

present.  Therefore, it is desirable to utilize the individual distress data available in the ODOT 

pavement database to provide prediction of the future distress conditions.  The PCR value of a 

pavement section can then be obtained by combining the predicted individual distresses.   

 

The ODOT PCR procedure rates each individual distress based on its severity and extent.  

Severity levels are categorized as low, medium or high (represented using L, M and H).  

Extent levels are categorized as occasional, frequent and extensive (represented using O, F 

and E).  Hence, the resulting distress rating categories are LO, LF, LE, MO, MF, ME, HO, 

HF, and HE.  For example, a distress rating of HF indicates that the severity of the distress is 

high and frequently occurring.  Further, a category of NULL is used to indicate the absence of 

a particular distress.  Therefore, for each distress, a total of ten levels ranging from NULL, 

LO, LF, LE, …, to HE, corresponding to ten discrete deduct values are possible.  However, 

these discrete deducts values are ‘stepped.’  For example, a pavement section may receive a 

transverse cracking rating of MF (medium severity and frequent extent) five years in a row, 

followed by a rating of HE (high severity and extensive extent).  The numerical deduct values 

would indicate the distress condition remained the same during those five years, but became 

significantly worse at the following year.  The actual deterioration of the pavement is more 

likely to progress gradually, rather than following a ‘stepped’ function with time.  A method 

to ‘extract’ and ‘smooth’ the individual distress data to reflect the actual deterioration is 

necessary to predict future distresses.  The “smoothing” of distress data also lays the 
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foundation to calibrate available mechanistic models, such as for rutting and cracking 

distresses. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
  
 
 

Figure 2. Pavement Condition Deterioration Trend for General System Flexible 
Pavement Treated with Activity Code 50 in Districts 2 and 11 
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Objective of the Research 

 
 

The objectives of the study were: 

 

1. To develop models to forecast future pavement conditions using data available to 

ODOT; 

2. To determine remaining service life of pavement sections based on forecasted 

condition; 

3. To develop decision trees for selecting rehabilitation strategies based on estimated 

remaining life of pavement sections; and  

4. To determine an appropriate initial PCR rating for a rehabilitated pavement section. 

 

The first addendum to the original contract added the following objectives: 

 

5.  To incorporate the new distress types, for example, thermal cracking, into the pavement 

forecasting models based on 2004, 2005, and 2006 PCR data.  

6. To implement the Pavement Quality Index into the pavement management information 

system. 

7. To revise the recommended rehabilitation treatment report function in the Pavement 

Management Information System to include estimated project cost based on user supplied 

unit cost. 

 

The objectives of the second addendum were:   

 

8. To incorporate the existing pavement condition data for local federal aid routes into the 

ODOT pavement management database.  

9. To modify the existing analysis and reporting tools to support pavement management 

decisions for local federal routes.   
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GENERAL DESCRIPTION OF RESEARCH 
 

This research project consists of the following tasks. 
 

• Task 1 was to review literature and survey existing models 

• Task 2 was to develop and select a forecasting model for predicting future pavement 

conditions 

• Task 3 was to determine remaining pavement service life based on specified 

terminal conditions 

• Task 4 was to determine appropriate initial PCR for rehabilitated pavements 

• Task 5 was to develop decision trees for selecting rehabilitation strategies 

• Task 6 was to update the existing PMIS to accommodate the updated PCR procedure 

implemented in 2004 

• Task 7 was to incorporate local federal aid routes into the pavement database and 

develop corresponding management tools 

• Task 8 was to prepare a draft final report for this study. 

 

The above tasks are further described in the following paragraphs. 

 

Task 1 Literature Review and Survey of Existing Models  

 

The pavement deterioration process is influenced by many interacting parameters including, 

but not limited to, pavement design, layer thicknesses, materials used, construction quality, 

underlying soil characteristics, climate, traffic loading, and maintenance activities.  Some of 

the parameters are not quantifiable or yet fully understood, while most of the parameters are 

subject to different levels of variations.  Therefore, in order to predict future pavement 

condition, statistical models based on observed past performance of pavements are the most 

accepted approach.   

 

Most of the existing statistical forecasting models can be categorized into two types: 

regression models and Markov transitional probability models.  Both models rely on available 
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past performance data to predict likely future conditions.  To reduce the variability typically 

associate with pavement performance data, both models first group pavements into similar 

“families,” based on pavement type (concrete, asphalt or composite), functional class, and/or 

District jurisdiction.  The regression models then use a selected set of independent variables, 

such as the age of the pavement, cumulative traffic loading, climatic conditions, etc., to 

predict the dependent variable – future pavement condition.  Linear or nonlinear regression 

models (i.e., sigmoid or reversed S-shaped curves) have been developed by various 

researchers/highway agencies. 

 

The current ODOT Pavement Design & Rehabilitation Manual contains a set of linear 

regression equations (Section 101-1) as the pavement deterioration models for new or 

rehabilitated rigid, flexible, and composite pavements.  These equations are shown in Table 1.  

Factors not considered in these equations include: (1) functional class (i.e., priority versus 

general/urban systems) as the traffic levels, design thicknesses, and construction 

specifications are quite different among different functional classes, resulting in different rates 

of deterioration, (2) district jurisdiction, which contributes to variations in climate, materials 

used, traffic composition, and maintenance and rehabilitation practices.  As a result, these 

simple linear regression models may not provide very accurate predictions.   

 

Figure 3 shows a comparison of the actual versus the predicted PCR during the time period of 

2000-2006 for overlays without repair (treatment activity 50) on District 11 General system 

flexible pavements.  The regression equation used for prediction is the non-structural overlays 

with minimum repair on flexible pavements.  As can be seen in Figure 3, the predicted and 

actual PCR values do not match very well, as pavement age is the only independent parameter 

for prediction.  As shown earlier, pavements with the same age can have very different 

conditions, and hence, PCR values. 

 

Saraf and Majidzadeh (1992) developed 40 different equations to forecast pavement distress 

and PCR for Ohio. An exponential deterioration trend was assumed, and pavement condition 

data from 1986 to 1990 were used to determine the model parameters.  Pavement conditions 

were assumed to be a function of traffic ESAL, pavement thickness, and estimated modulus 

of elasticity of subgrade and each pavement layer.  The 40 regression equations developed  
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Table 1. Existing Performance Prediction Equations 
(from ODOT Pavement Design and Rehabilitation Manual Section 101-1) 

 

Type of M&R Action Equation as in Section 101 

(1) (2) 
RIGID PAVEMENT  

All Overlays with and without Repairs PCR = 96.0 - 3.7*AGE 

CPR 96.2 - 7.0 *AGE 

New Rigid Pavement & Unbonded Concrete 
Overlay 99.1 - 0.9 *AGE 

FLEXIBLE PAVEMENT   

Non-Structural Overlay with Minimal Repairs 98.1 - 3.3 *AGE 

Non-Structural Overlay with Repairs 98.6 - 3.8 *AGE 

Structural Overlay with Minimal Repairs 98.3 - 3.3 *AGE 

Generic Minor Rehabilitation (all of the above) 98.0 - 3.3 *AGE 

Fractured Slab Technique 98.0 - 3.4 *AGE 
New Flexible Pavement 99.5 - 2.0 *AGE 
COMPOSITE PAVEMENT  

Non-Structural Overlay with Minimal Repairs 96.1 - 4.0 *AGE 

Non-Structural Overlay with Repairs 96.1 - 3.8 *AGE 

Structural Overlay with Minimal Repairs 96.1 - 4.3 *AGE 

Structural Overlay with Repairs 96.1 - 3.3 *AGE 

Generic Minor Rehabilitation (all of the above) 96.0 - 3.7 *AGE 

New Composite Pavement 99.6 - 3.3 *AGE 
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Predicted PCR = 98 – 3.3 * AGE 
 

Figure 3. Actual versus Predicted PCR Using Straight Line Equation    
 
 

were for 5 different M&R actions (8 for each action).  The M&R actions included were: non-

structural AC overlay (less than or equal to 3 inches thick) with and without repairs, structural 

AC overlay with and without repairs (greater than 3 inches), and crack and seat with AC 

overlay.  The model requires the modulus of elasticity for subgrade and each pavement layer.  

These modulus values were estimated from the soil classifications and material types used.  

Actual modulus values vary significantly with temperature and moisture content, and between 

individual pavements.  Therefore, accuracies of these regression models are questionable.  

Since accurate soil and pavement modulus values are not available for most pavements, this 

approach is not used in the current study. 

 

The Markov models require defining pavement conditions into a finite number of ‘states.’  

For example, a pavement may be in the condition state of excellent, good, fair, poor, or very 

poor, defined by its PCR values or individual distresses.  The probabilities that a pavement 
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constant.  These probabilities are called transitional probabilities, and are stored in a Markov 

Transition Matrix, P, expressed by:  
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⎥
⎥
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where ]|[
1

iXjXPP
nn ttij ===
−

 is the transitional probability that the pavement deteriorates 

from condition state i  to state j , and n is the total number of condition states.  The 

transitional probabilities are subject to the following constraints: 

 

 ,0≥ijP  for all i  and j .      (2) 

 
,1

1
=∑

=

n

j
ijP  for all i .      (3) 

 

If a particular Pij has value of 1.0, then all the other probabilities in the same row (Pik, k = 1, .., 

n, but k ≠  j) must all be equal to zero, indicating once a pavement reaches the condition state 

corresponding to Pij, it will not go to other condition states.  This condition state is called a 

“absorbing state.”  In most cases, the poorest distress condition, HE (high severity and 

extensive extent), should be the absorbing state, unless no pavement ever reach that level of 

distress condition.   

 

Previous researchers often used assumed transitional probabilities.  When historical pavement 

condition data are available, the transitional probabilities can be estimated based on the 

mileage of the pavements that deteriorate from one condition state to other condition states in 

the subsequent year.  This approach was employed in the current study.   

 

Pavement condition is typically measured on a yearly basis; resulting in a transition period of 

one year.  The above Markov transition matrix, P, is therefore a one-year transition matrix.  
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By multiplying the one-year transition matrix, predicted condition in future years can be 

obtained, i.e. PPPPPPPPPPPP n ×××=××=×= .....,.....,, 32 . 

 

Task 2  Develop Pavement Condition Forecast Models for Ohio 

 

The two most common types of pavement forecasting model ─ the regression models and the 

Markov transition models ─ were investigated in this study.  Two of the regression models, 

namely the family regression and the individual regression models, were investigated.   

 

Family Regression Models 
 

A “family” regression model is developed for a group of pavements with similar 

characteristics.  In this study, system priority, pavement type, activity performed, and district 

jurisdictions are used as parameters to form pavement groups, or pavement ‘families’.  

Pavements in some Districts tend to perform more poorly than those in other Districts, due to 

differences in subgrade soils, quality of locally available materials, climatic conditions (e.g., 

average temperature and amount of snow fall), traffic loading, maintenance practices, and 

rehabilitation decisions.   

 

It has been shown that pavements constructed during different time periods, e.g., those 

constructed prior to 1995 versus those constructed since 1995, have different performance 

trends, likely due to improved specifications and quality control practices.  Therefore, time 

period of construction is also a “family” characteristic.  However, a “family” must have a 

significant number of pavements at various condition states in order to have a reliable forecast 

of future pavement conditions.  Therefore, the time period selected should be sufficiently 

long, say, ten years. 

 

To predict an individual pavement section’s future condition, the corresponding family 

regression model is modified based on the known current condition of this particular 

pavement using a method called ‘Age Shift,’ originally proposed by Shahin (1994).  Figure 4 

illustrates the ‘Age Shift’ method, where a six-year old pavement has a PCR score of 85, 

which is the typical PCR score for a three-year old pavement in the same pavement “family.”  



 

13 

Therefore, the ‘age shift’ is three years to the right, which means the entire family PCR curve 

is shifted three years to the right to represent the predicted PCR curve for this particular 

pavement. 

Figure 4. Adjusting Individual Deterioration in Relation to Family Deterioration 
(Adapted from Shahin 1994) 

 

 

Individual Regression Models 
 

In this approach, a best fit regression curve is fitted for each pavement section that has three 

or more PCR data points.  Future PCR values for the pavement are obtained by extrapolating 

the fitted curve.   When a pavement section has less than three available PCR data points 

(either because it’s a recently rehabilitated pavement, or because the pavement was 

rehabilitated before three PCR values were measured), the “family” regression curve that the 

pavement corresponds to is used to represent the pavement’s “expected” performance.  The 

“Age Shift” method is employed to predict future condition starting from the latest available 

PCR data. 
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Markov Models 

 

In this study, the Markov transitional probabilities are derived from the past condition data 

available in the ODOT pavement database.  For a specific group of pavements with similar 

characteristics (i.e., in the same ‘family’), the transition probabilities are calculated using the 

following equation: 

 i
jiPij Statein MilesTotal

 State  to State from Miles Total
= .  (4) 

 

A pavement currently in condition state i may be in one of several condition states the 

following year, as long as the corresponding transition probability, Pij, is not zero.  The 

condition state that the pavement will most likely to be in can be determined by finding the 

expected value of the distribution: 
 

 
j

n

j
ij

k
t WPw
n

×= ∑
=

+
1

1
,   (5) 

where k
tn

w
1+
 is the expected deduct value of distress k  at time 1+nt , ,15) . . . ,2 ,1(=k , ijP  is 

the probability that the pavement is moving from state i  to j  for distress k , and jW  is the 

corresponding deduct value of distress k at state j , obtained from the PCR Rating System 

(ODOT 2004).  The final predicted PCR value is obtained by using Equation (6). 
 

 
∑
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−=
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100
k

k
tt nn

wPCR ,       (6) 

 

where 
1+nt

PCR is the predicted PCR value at time 1+nt .     

 

Dropouts 

 

Pavement performance data are often subject to attrition over time; that is, fewer pavements 

survive to later ages.  This attrition of data is referred to as “dropouts” (Laird 2004).  For 

example, when pavement condition data are arranged according to age (i.e., condition scores 

for newly rehabilitated pavements are denoted as PCR0, and scores for one year old 
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pavements are denoted as PCR1, etc.,) the available PCR data for older pavements are less 

than for newer pavements, as poorer-performing pavements receive rehabilitation and “drop 

out” from the analysis.  Overtime, only better performing pavements remain, and the PCR 

values in the later years are biased towards the better performing pavements.  Forecasting 

models that do not consider dropouts tend to overestimate PCR value in the later stages of a 

pavement’s life.  This overestimation of pavement condition increases as the forecasting 

model predicts pavement conditions further into the future.   

 

Figure 5 shows the actual average and Markov predicted PCR curves for the Priority system 

flexible pavements after receiving an overlay without repair (treatment activity code 50).   

 

Markov Predicted PCR for Priority System 
Overlays without Repair on Flexible Pavements 
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Figure 5. Markov PCR Prediction versus Actual Average Trends 
 

It can be seen from Figure 5 that the differences between the Markov predicted PCR values 

and the actual average PCR values are very small during the first several years after overlay.  

In later years, however, the average PCR values are higher than the Markov predicted PCR 

values.  This is due to the tendency of poorly performing pavements receiving repair 

treatment sooner than better performing pavements.  As a result, the average PCR scores in 

later years are biased towards the better performing and longer lasting pavements.  The 
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dropout phenomenon also causes the Markov prediction to demonstrate decreasing 

deterioration rates in later years.  Dropouts cause overestimation of PCR values (and 

remaining service life), particularly at the later stage of pavement life span, when a significant 

portion of poorly performing pavements have been repaired and “dropped out” from the data.   
 

This overestimation can be countered by imputation (Laird 2004), a widely accepted approach 

for handling dropouts.  In its simplest form, imputation is conducted by extrapolating the 

deterioration trends for those pavement sections that have “dropped out” of the analysis.  

Figure 6 compares the average actual PCR deterioration trend and the average imputed trend, 

where all individual pavement deterioration trends are extrapolated by extending their final 

year PCR deterioration rates.  The average actual PCR curve shows a decrease in the 

deterioration rate starting around six years of age, when poor performing pavements began to 

be replaced, and even shows an unrealistic upward trend after about 13 years, when very few 

pavements actually survived.  In contrast, the imputed curve shows a more consistent 

deterioration trend.   
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Figure 6. Imputed Average and Actual Average 
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Prediction of Individual Distresses 
 

In this study, the severity and extent of each individual distress is predicted first, and then the 

deduct values from all the distresses are combined to determine the predicted PCR value.   
 

The ODOT PCR procedure describes pavement distress condition according to its severity 

and extent.  Severity of each distress is classified as either low (L), medium (M), or high (H), 

whereas the extent is described by three levels: occasional (O), frequent (F), or extensive (E).  

Furthermore, a NULL rating is given when a distress is not present.  Therefore, each distress 

can be in one the following ten condition states: NULL, LO, LF, LE, MO, MF, ME, HO, HF, 

HE.  A more detailed description of the PCR distress rating procedure can be found in the 

PCR manual available at the Office of Pavement Engineering web site.  
 

For a group of pavements in the same “family”, the Markov transitional probabilities for each 

individual distress are generated based on actual distress data collected during a given time 

period.  A separate Markov transition matrix is developed for each distress, and future levels 

of each distress can then be predicted.  By adding the predicted individual distress deducts 

and subtracting the total deduct from 100, the predicted PCR for future years can be obtained.   
 

A “family” must have a sufficiently large number of pavements in various condition states in 

order to develop a reliable Markov transition matrix.  This requirement is even more 

important for the Markov model than for the family regression model, and it is the main 

reason that the Markov model has not been widely used.  However, the ODOT pavement 

management database contains a very large number of pavement sections, allowing many 

“families” to be formed, except for treatment activities that have not been used extensively.  

For this study, it was determined that a “family” must have at least 300 pavement sections, 

otherwise it is ‘merged’ with other similar families.  
 

Table 2 shows the various states and transitional probabilities between these states for rutting 

distress on District 11 General system flexible pavements after an overlay without repairs 

(Activity Code 50).  This transition matrix is denoted as P. 
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Table 2. Transition Matrix for Rutting Distress, District 11, General Flexible 
Pavements Overlays (Activity 50) Constructed During 1995-2006 

 
Next Year Condition 

    NULL LO LF LE MO MF ME HO HF HE 
NULL 0.82 0.14 0.03 0.01 0 0 0 0 0 0 

LO 0.01 0.76 0.19 0 0.03 0 0 0 0 0 
LF 0.01 0.05 0.69 0.18 0.05 0.02 0 0 0 0 
LE 0 0.06 0.06 0.78 0.08 0.01 0.01 0 0 0 
MO 0 0.03 0 0 0.50 0.36 0.05 0.06 0 0 
MF 0 0 0 0 0 0.41 0.33 0.22 0.04 0 
ME 0 0 0 0 0 0.07 0.64 0 0.19 0.05
HO 0 0 0 0 0 0 0.74 0.24 0.02 0 
HF 0 0 0 0 0 0 0 0 0.59 0.41C

ur
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nt
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HE 0 0 0 0 0 0 0 0 0 1 
 

 

For example, within this group of pavements, a section with a rutting rating of NULL (non-

existent) has a 82% chance to remain at NULL the following year, 14% chance that it will 

deteriorate to LO (Low Severity, Occasional Extent), 3% chance that it will deteriorate to LF 

(Low Severity, Frequent Extent), and 1% chance that it will deteriorate to LE (Low Severity, 

Extensive Extent).  Mathematically, the second year probability vector is obtained by 

multiplying the first year probability vector to the one-year transition matrix, P:  

 

< 1  0  0  0  0  0  0  0  0  0 > P = < 0.82  0.14  0.03  0.01  0  0  0  0  0  0 >    (7) 

 

Since each distress condition level corresponds to a known deduct value, the expected deduct 

value can be obtained by summing up the product of each probability to the corresponding 

deduct.  The pavement will most likely be in the condition state closest to the expected 

deduction value the following year.   
 

To predict the condition two years later, the second year probability vector is multiplied to the 

one-year transition matrix P:   

 

< 0.82  0.14  0.03  0.01  0  0  0  0  0  0 > P = < 0.67  0.22  0.07 0.04  0  0  0  0  0  0>  (8) 
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In other words, the same section has a 67% chance to remain at NULL in the third year, 22% 

chance that it will deteriorate to LO, 7% chance that it will deteriorate to LF, and 4% chance 

that it will deteriorate to LE (Low Severity, Extensive Extent).  The above process is repeated 

for prediction of any future year conditions and for other distresses. 
 

Figure 7 shows a comparison of the Markov Model predicted deterioration trends versus the 

actual average trend for rutting distress on General system flexible pavement overlays in 

District 11.  Note the Markov predicted trend is ‘smoother’ than the actual average trend.      
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Figure 7. Predicted and Actual Average Rutting Deducts in District 11 

 

 

Table 3 shows the transition matrix for block and transverse cracking (District 11 General 

system overlays on flexible pavements).  Figure 8 shows the average distress trend and the 

predicted based on Markov model block and transverse cracking for this group of pavements.   
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Table 3. Transition Matrix for Block and Transverse Cracking, District 11, 
General Flexible Pavements Overlays (Activity 50) 1995-2006 

 

Next Year Condition   
   NULL LO LF LE MO MF ME HO HF HE 

NULL .35 0.37 0.19 0.05 0.02 0.01 0.01 0 0 0 
LO 0 0.49 0.44 0.01 0.03 0.02 0 0 0 0 
LF 0 0.03 0.55 0.22 0.03 0.13 0.02 0.01 0 0 
LE 0 0 0.07 0.55 0.02 0.24 0.10 0.02 0 0 
MO 0.01 0 0 0.16 0.45 0.37 0.01 0.01 0 0 
MF 0 0 0.05 0 0 0.60 0.21 0.11 0.02 0 
ME 0 0 0.02 0.04 0 0.07 0.73 0 0.05 0.09
HO 0 0 0 0 0 0.01 0.40 0.52 0.07 0 
HF 0 0 0 0 0 0 0.55 0 0.18 0.26C
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HE 0 0 0 0 0 0 0.16 0 0 .84 
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Figure 8. Predicted and Actual Average Block and Transverse Cracking 
Deducts in District 11 

  
By summing up all the distress deducts for a pavement at a particular age, the PCR value can 

be determined.  Figure 9 shows the average PCR deterioration trend and the Markov model 

predicted PCR trends (with and without imputation) for overlays on District 11 General 

system flexible pavements.   
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Figure 9. PCR Family Curves (District 11, General Flexible Overlays, 1995-2006) 

 
 
 

Comparing the predicted distress and PCR curves with the average curves obtained from 

actual PCR measurements provides a good indication of the accuracy of the prediction model.  

It can be seen from Figures 7, 8, and 9 that the Markov model reproduces the actual 

deterioration trends very well, while smoothing out the actual average curves.  

 

Figures 10-13 show the individual distress deduct trends for three major distresses and the 

PCR deterioration trend for District 2 overlays (Activity 50) on General flexible pavements 

constructed between 1995 and 2006.  Again, the Markov model can reproduce the average 

deterioration trends very well.   
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Markov Predicted Deduct vs. Actual Average Deduct Curve for 
Rutting Distress occuring

in General System Flexible Pavement with overlays without repair 
(Activity Code 50) in District 2
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Figure 10.  Predicted and Actual Average Rutting Deducts, District 2 
 
 
 

Markov Predicted Deduct vs. Actual Average Deduct Curve for
Wheel Track Cracking Distress  occuring

in General System Flexible Pavement with overlays without repair 
(Activity Code 50) in District 2
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Figure 11.  Predicted and Actual Average Wheel Track Cracking Deducts, 
District 2 
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Markov Predicted Deduct vs. Actual Average Deduct Curve for
Block and Transverse Cracking Distress  occuring

in General System Flexible Pavement with overlays without repair 
(Activity Code 50) in District 2

0

2

4

6

8

0 3 6 9 12 15Age (Years)

PC
R

 D
ed

uc
t

Actual Average (1995-2006) Markov (Imputed) Markov (Non-Imputed)
 

Figure 12.  Predicted and Actual Average of Block and Transverse Cracking 
Deducts, District 2 
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Figure 13.  Predicted and Actual Average PCR Trends, District 2 
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Task 3  Determine Remaining Pavement Service Life Based on Appropriate Terminal 

Pavement Condition 

 

The remaining service life (RSL) of a pavement can be defined as the time it takes for the 

pavement to deteriorate from its current condition to a specified terminal condition.  The RSL 

provides important information for making various pavement management decisions.  Based 

on the forecasted pavement conditions and a specified terminal condition, the remaining 

service life of a pavement is determined by counting the number of years from the present 

year until the year the predicted condition will fall below the specified terminal condition.  

The terminal condition of a pavement can include multiple criteria, as a pavement may be 

considered at the end of its service life due to various functional or structural deficiencies.  

Therefore, the terminal condition may be defined by not only a threshold PCR value, but by a 

critical distress level or a combination of several critical distresses.  For example, a high 

severity of rutting or a severe and extensive wheel track cracking may both be considered as 

terminal.  Some distresses may be repairable by a specific treatment, but other distresses 

require more significant rehabilitation.  A tool to estimate the remaining service life was 

developed in this task.  The user can specify different terminal conditions for different 

pavements.  The default terminal condition for Priority system pavements is when the PCR 

value is below 65, and for General system pavements, below 60.  

 

Task 4 Determination of Initial PCR Rating for Rehabilitated Pavements 

 

Currently, a PCR value of 100 is assigned to pavement sections that are being rehabilitated.  

Even for pavement sections that are actually rated after a rehabilitation treatment, the PCR 

value may be overrated as some rehabilitation treatments can “mask” certain underlying 

distresses for a short period of time, but not eliminate them.  As a result, depending on the 

rehabilitation treatment performed and the prior distresses presented, some distresses may 

resurface quickly within a few years after receiving rehabilitation. 

   

A more realistic estimate of the initial PCR rating is necessary to avoid distorting the average 

PCR value caused by repair treatments that do not provide long term benefit.  This distortion 

may prevent decision makers from having an unbiased impression of the overall pavement 
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network conditions.  In addition, a more realistic initial PCR rating would avoid having many 

drastically different ‘rates of deterioration’ (or ‘slopes’) after the same repair treatment due to 

presence of different distresses prior to repair.  The goal of this task was to determine a 

realistic estimation of initial PCR for newly rehabilitated pavements.   

 

By comparing the distresses prior to repair and the distresses within a few years after repair, 

the effectiveness of the repair treatment to address a specific distress may be established.  

Certain distresses, such as transverse cracking, may not be entirely erased by a given 

treatment, but may only be ‘masked’ or delayed.  Therefore, the distress condition is not 

entirely eliminated.  Instead, the ‘residual damage’ may be carried over after a repair 

treatment.  The amount of ‘residual damage’ depends on the repair treatment used and the 

degree of damage existed prior to repair.  By summing up all the residual damages that can 

not be erased by the specific rehabilitation treatment, a more realistic initial PCR value of a 

rehabilitated pavement can be determined.     

 

The rehabilitation treatments performed by ODOT can be grouped into three categories: 

maintenance, minor rehabilitation, and major rehabilitation.  Maintenance activities include 

crack sealing, chip seal, micro-surfacing, etc.  Minor rehabilitation treatments primarily 

involves asphalt concrete (AC) overlays (with or without repairs), and major treatments range 

from rubblized and roll, unbonded concrete overlay, to new flexible or new rigid pavement.  

Table 4 shows the complete list of treatment activities performed by ODOT.  

 

Figures 14 and 15 show the distribution of treatments performed on all composite and flexible 

pavements since 1985.  It can be seen that overlays with or without repair (activity codes 50 

or 60) constitute the vast majority (85-90%) of treatments, for both composite and flexible 

pavements.  The total length of pavement sections studied was 12104.2 miles.  This total 

length includes multiple counts of the same pavement section that may have been repaired 

multiple times.  Each time a pavement section is repaired, its length is added to the total in 

this analysis. 
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Table 4. Activity Codes 
 

Treatment Class Activity Code Description 

10 Reactive Maintenance 

20 Crack Sealing 

25 Chip Seal 

30 Micro-Surfacing 

31 Double Application Micro-Surfacing 

35 Nova-Chip Resurfacing 

38 Fine Graded Polymer AC Overlay 

Maintenance 

40 CPR 

45 Intermediate Coarse Recycled AC 

50 AC Overlay without Repairs 

52 AC Inlay 

55 Double Chip Seal 

Minor 

60 AC Overlay with Repairs 

70 Crack and Seat 

73 Break and Seat 

77 Rubblize and Roll 

80 Whitetopping 

90 Unbonded Concrete Overlay 

95 Unbonded Composite Overlay 

100 New Flexible Pavement 

110 New Rigid Pavement 

Major 

120 New Composite Pavement 
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Figure 14. Mileage Distribution of Repair Type, for Composite Pavements 

 
 
 

 
Figure 15. Mileage Distribution of Repair Type, for Flexible Pavements 
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Since the PCR is derived from a set of distresses, a study of the individual distresses was 

necessary to estimate the initial PCR.  In order to deduct a fair and reasonable value for each 

initial individual distress and ultimately, the initial PCR data from 2, 3, and 4 years after a 

treatment were used to get an average intercept between the y axis (value at year 0) and the 

best linear fit between these three values. Figure 16 shows the initial value for raveling on 

priority system overlays on flexible pavements is 2.48, while the actual average from the data 

is 2.10.   

 

Raveling on Priority System Overlays without 
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Figure 16. Initial Value of Raveling from Linear Fit of Years 2, 3, and 4 

 

The same methodology is followed to calculate the initial value of each distress and 

ultimately the initial PCR value. 

 

Based on the data available in the ODOT pavement database, the appropriate initial ratings for 

rehabilitated pavement sections are determined taking into account the type and level of 

distresses presented prior to repair and the repair treatment performed.  Since a large number 

of data are available for overlays (Activity Codes 50 and 60), pavements are grouped 

according to distress deduct levels prior to the overlay, and within each group, the initial 

deduct value for each distress was determined.  When the initial deduct values among 
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different groups are different for a specific distress, it indicates that the level of that distress 

prior to overlay will affect the initial PCR after overlay.  

 

Each pavement type (Concrete, Flexible, and Composite) has 13 to 15 different distresses.  

These distresses can be structural or functional, or both.  ODOT uses Structural Deducts and 

Cracking Deducts, in addition to overall PCR (which is 100 subtracting total deducts), to help 

engineers obtain a general impression of the pavement’s condition.  Table 5 shows the 

distresses included in the structural and cracking deducts for each of the pavement type.   

 

 

Table 5. Distress Types Included in Structural and Cracking Deducts 
 

Type of 
Deduct 

(1) 

Jointed Concrete 
Pavement 

(2) 

 
Flexible Pavement 

(3) 

 
Composite Pavement 

(4) 

Structural 
Deduct 

• Pumping 
• Faulting (Joints & 

Cracks) 
• Transverse 

Cracking, 
Reinforced Concrete 

• Longitudinal 
Cracking 

• Corner Breaks 
• Transverse 

Cracking, Plain 
Concrete 

 

• Rutting 
• Wheel Track 

Cracking 
• Edge Cracking 
• Random Cracking 
• Potholes 

• Pumping 
• Shatter Slab (Jointed 

Base) 
• Tranverse Cracks 

(Unjointed Base) 
• Intermediate 

Transverse Cracks 
(Jointed Base) 

• Longitudinal 
Cracking 

• Corner breaks 
(Jointed Base) 

• Punchouts 
(Unjointed Base) 

Cracking 
Deduct 

• Transverse 
Cracking, 
Reinforced Concrete 

• Longitudinal 
Cracking 

• Longitudinal Joint 
Spalling 

• Transverse 
Cracking, Plain 
Concrete 

• Wheel Track 
Cracking 

• Block and 
Transverse Cracking 

• Longitudinal 
Cracking 

• Edge Cracking 
• Random Cracking 
• Thermal cracking 

• Transverse Cracks 
(Unjointed Base) 

• Joint Reflection 
Cracks (Jointed 
Base) 

• Intermediate 
Transverse Cracks 
(Joined Base) 

• Longitudinal 
Cracking 

• Corner breaks 
(Jointed Base) 

• Punchouts 
(Unjointed Base) 
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Task 5   Develop Decision Trees for Selecting Rehabilitation Strategies 

 

A set of decision trees developed by the Office of Pavement Engineering staff for selecting 

the most appropriate maintenance and rehabilitation treatment based on pavement type, 

system, existing pavement condition and past performance, and traffic level were 

implemented within the pavement management information system.  These decision trees 

were developed after several iterations of revisions to evaluate the various decision criteria. 

The entire set of decision trees is shown in Appendix B. 

 

A work plan generating tool was developed to allow the rehabilitation decision trees to be 

applied to the current as well as predicted pavement conditions.  ODOT decision makers can 

use this tool to determine the repair needs in the current and future years.  After a specific 

work plan is provided by the user, the tool will produce the corresponding future pavement 

conditions and repair needs.  As a result, the consequence of alternative work plans can be 

easily evaluated.  The input work plan can be for a single year or multiple years.  

 

Task 6 Revise PMIS to accommodate the PCR procedure updated in 2004 

 

The ODOT PCR procedure was updated in 2004.  Several additional distress types were 

added.  At the same time, a few distress types that rarely occurred were abolished.  Since this 

change took place after this study had started, it was not anticipated in the original study 

proposal.  An addendum was approved to incorporate the changes in distress categories to 

allow the developed forecasting models to incorporate the updated distresses and PCR scores. 

 

Tables 6 and 7 show the distress types and the corresponding maximum deduct values for 

flexible, composite, and concrete pavements. 

 

The Markov model predicts future pavement conditions based on individual distresses.  The 

distresses included in the 2004 updated PCR procedure are predicted based on the 2004-2006 

PCR data.  
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Table 6. Flexible and Composite Pavements Distress Codes and Deducts Pre-2004 and Since 2004 

 
 

Flexible Pavements 
 

Composite Pavements 
Maximum Deducts Maximum Deducts  

Distress 
Code 

 
Distress Name Pre-2004 Since 

2004 

 
Distress 

Code 

 
Distress Name Pre-2004 Since 

2004 
1 Raveling 10 10 1 Raveling 10 10 
2 Bleeding 5 5 2 Bleeding 5 5 
3 Patching 5 5 3 Patching 5 5 
4 Potholes/Debonding 10 5 4 Surface Disintegration/Debonding 5 5 
5 Crack Sealing Deficiency 5 5 5 Rutting 10 10 
6 Rutting 10 10 6 Pumping 10 10 
7 Settlements 10 --- 7 Shattered Slab (Jointed Base) 10 10 
8 Corrugations 5 --- 8 Settlements 5 --- 
9 Wheel Track Cracking 15 15 9 Transverse Cracks (Unjointed Base) 20 20 

10 Block and Transverse 
Cracking 10 10 10 Joint Reflection Cracks (Jointed 

Base) 12 12 

11 Longitudinal Joint Cracking 5 5 11 Intermediate Transverse Cracks 
(Joined Base) 8 8 

12 Edge Cracking 5 10 12 Longitudinal Cracking 5 5 
13 Random Cracking 5 --- 13 Pressure Damage/Upheaval 5 5 
14 Thermal cracking --- 10 14 Crack Sealing Deficiency 5 5 
15 Potholes --- 10 15 Corrugations 5 --- 

    16 Corner breaks (Jointed Base)  --- 10 
    17 Punchouts (Unjointed Base)  --- 15 
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Table 7.  Concrete Pavements Distress Codes and Deducts Pre-2004 and Since 2004 
 
 

 
Jointed Concrete Pavements  

 

 
Continuously Reinforced Concrete  Pavements 

Maximum Deducts Maximum 
Deducts 

 
 

Distress 
Code 

 
 

Distress Name Pre-2004 Since 
2004 

 
 

Distress 
Code 

 
 

Distress Name Pre-2004 
and Since 

2004 
1 Surface Deterioration 10 10 1 Surface Deterioration 10 
2 Popouts 5 --- 2 Popouts 5 
3 Patching 5 10 3 Patching 5 
4 Pumping 15 15 4 Pumping 15 
5 Faulting (Joints & Cracks) 10 10 5 Settlements and Waves 10 
6 Settlements 5 --- 6 Transverse Crack Spacing 10 
7 Transverse Joint Spalling 15 10 7 Longitudinal Cracking 10 
8 Joint Sealant Damage 5 --- 8 Punchouts or Edge Breaks 15 
9 Pressure Damage 5 5 9 Spalling 15 

10 Transverse Cracking 10 15 10 Pressure Damage 5 
11 Longitudinal Cracking 5 10    
12 Corner Breaks 10 10    
13 Longitudinal Joint Spalling --- 5    
14 Transverse Cracking, Plain Concrete --- 15    
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This task also implements the Pavement Quality Index (PQI) into the existing pavement 

database.  Pavement Quality Index (PQI) combines the two existing measures employed by 

ODOT to characterize distress and roughness, namely PCR and International Roughness 

Index (IRI), into one single index.  This index may be used for overall pavement condition 

assessment purpose. 
 

The PQI is calculated by the following formula: 
 

( )PQI PCR IRI ba= −            (9) 

 

with a = 0.00003716, b = 2.4913 for priority systems and a = 0.00004915, b = 2.4230 for 

general systems.   

 

Task 7 Incorporating Local Federal Aid Routes 

 

In recent years, ODOT’s Office of Pavement Engineering has begun collecting pavement 

condition data for local (county and municipality) routes that receive federal aid.  These local 

routes were not part of the original pavement management database, which contains state 

highways only.  A second addendum was approved to develop a management database for the 

local federal aid routes.   

 

Pavement condition data for the local federal aid routes are available only since 2003, and no 

project date or treatment activity records are currently available.  Therefore, the type of 

analysis allowed is much more limited compared with that for the state routes.  Nevertheless, 

a database for local federal-aid routes was developed to support pavement management 

activities at the county and municipality level.  Some of the functions available in the 

ODOTPMIS were redesigned or modified when appropriate, while others were disabled due 

to lack of data. 

 

The following were accomplished during this task: 

1.  The available pavement condition data for local federal aid routes were imported from 

spreadsheet format into a MS Access database, LOCALPMIS.  Besides the fields already 
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in the spreadsheet, additional fields were added, such as traffic categories, ADT, street 

names, etc, in anticipation of future data collection and local needs. 

2. A method of importing new data and appending additional data to the LOCALPMIS 

database was developed.  This method is described in detail in Appendix D. 

3.  Various analysis functions and reporting tools were modified for use with the local routes 

data.  A separate menu of functions and tools were developed for the local routes 

database.   

4. The pavement condition data for the local routes were collected on alternate years.   

Therefore, for most of the local route pavements, only two years of data are currently 

available.  Pavement age information is also not available.   Furthermore, pavement 

design, construction, and maintenance standards and practices vary significantly among 

counties and municipalities, as compared to that for state highways.  Therefore, predicting 

future pavement condition becomes more difficult, as the Markov model requires a 

relatively large group of similarly performing pavements to generate a reliable transitional 

probabilities matrix, and the Family regression model requires pavement age information.  

A simplified approach of considering the current deterioration rate was chosen, which can 

predict both future PCR and distress.  Since only two (or three) data points are currently 

available for each pavement, linear regression is used.  As more local condition data 

become available, the prediction method may be refined.      
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FINDINGS OF THE RESEARCH EFFORT 

 
The findings of this study are presented in this section.  They include:  

 

I. Forecasted pavement conditions,  

II. Validation of the developed forecasting models,  

III.  Summary of the estimated remaining service life of pavements,  

IV.  Estimated initial PCR after various rehabilitation or maintenance treatments,  

V.   Rehabilitation decision trees and multiyear work plan tool, and  

VI.  Pavement management database for local routes. 

 

I.   Forecasted Pavement Conditions 

 

Future pavement conditions can be forecasted using the developed models.  As mentioned 

earlier, for the Markov model and the Family Regression model, the forecasted conditions are 

based on the latest available condition measurement, while for the Individual Regression 

model, a best fit curve for all know PCR values is used to predict future conditions.  The 

Individual Regression model requires at least three PCR data from the same pavement to 

make a prediction.  Therefore, it can not be used for newer pavements that have less than 

three years of PCR data.       

  

Table 8 shows an example of the predicted PCR values for four pavement sections in District 

11.  Figure 17 illustrates the forecasted pavement conditions from the three models for a 

specific pavement section, COL-39-0-1.06.   

 

For the Markov model, the predictions can also be made with a specified confidence interval.  

Figure 18 shows that when a 90% confidence interval is specified, the predicted pavement 

condition can be in a range.  Generally, however, only the most likely value is reported.   
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Table 8. Predicted Pavement Conditions from the Three Models 
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20
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20
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20
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20
11

 

20
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20
13

 

20
14

 

20
15

 

20
16

 

11 CAR 171R UP 8.82 10.76 1995 G 3 50 Actual 86 87 85 82 78 70 70   
                    I   69 66 63 60 57 54 50 47 46 44 
                    II   67 65 62 59 56 54 51 48 45 43 
                    III   69 69 68 68 67 66 66 65 65 65 

11 CAR 332R UP 6.48 10.31 1995 G 3 50 Actual 72 75 75 68 68 60 58   
                    I   58 57 55 52 50 48 45 44 42 41 
                    II   55 53 50 47 44 42 39 36 33 31 
                    III   57 56 55 55 54 53 52 52 51 50 

11 COL 039R UP 0 1.06 1995 G 3 50 Actual 79 79 76 71 69 70 67   
                    I   66 64 62 59 56 53 49 47 45 43 
                    II   64 62 59 56 53 51 48 45 42 40 
                    III   66 65 64 63 62 61 60 59 58 58 

11 HOL 557R UP 6.57 10.23 1995 G 3 50 Actual 74 71 71 76 74 66 66   
                    I   65 63 60 58 55 52 47 45 43 42 
                    II   63 61 58 55 52 50 47 44 41 39 
                    III   65 64 63 63 62 61 61 60 60 59 

11 TUS 039R UP 23.92 24.92 1995 G 3 50 Actual 87 83 81 78 78 78 77   
                    I   76 72 69 66 63 60 55 53 51 49 
                    II   74 72 69 66 63 61 58 55 52 50 
                    III   77 76 76 76 75 75 75 74 74 74 

 
I – Markov Model 
II – Family Regression Model 
III - Individual Regression Model 
 
*AC – Activity Code 
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Figure 17. Markov Model Predicted PCR for an Individual Pavement Section 
 

Figure 18. Predicted Conditions with Confidence Interval 
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II. Validation of the Developed Forecasting Models 
 

The predicted results of the Markov and both regression models are validated through 

comparison with actual observed pavement conditions.  For validation purpose, overlays on 

General system flexible pavements in District 11 were used as the test data set to verify the 

predicted results.  PCR measurements from 1985 to 2001 were used to develop the models, and 

the predicted PCR values for the 2002 to 2006 period were compared to the actual measured 

PCR during that same period.  If a pavement section was rehabilitated between 2002 and 2006, 

the initial PCR for that rehabilitation treatment was determined and subsequent PCR values 

predicted.  Table 9 shows the amount of PCR data available for District 11 General System 

flexible and composite pavements from 1985 to 2001. 

 

Table 9.  Data Used for Validation 
(District 11 General System Flexible Pavement 

Treated with Activity Code 50 or 60 between 1985 and 2001) 
 

Pavement Type 
Total 

Directional 
Miles 

Total No. of 
Pavement Sections 

Total No. of PCR 
Measurements 

Flexible 634.18 372 1531 
 

 

The Markov model needs a transition matrix to predict PCR values.  In the present study, two 

sets of transition matrices were developed.  The first set of transition matrices were generated 

using pavement sections that were repaired before 1994.  The second set of transition matrices 

were generated using pavement sections that were repaired since 1994.  It was determined that 

pavements repaired after mid 90’s performed better than those repaired in previous years.  

Hence, pavement sections that were repaired before 1994 use the first set of transition matrices, 

while pavement sections repaired after 1994 use the second set of transition matrices.  For the 

family regression model, data were divided into two sets based on the date of 

construction/rehabilitation (similar to Markov model).  For the individual section regression 

model, since each pavement section has its own regression equation, there is no need for a 

separate model to account for improvements in pavement performance in more recent years.   
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Table 10 shows a sample of the validation data.  The actual measured PCR between years 2002 

and 2006 are compared to the predicted PCR during the same time period.  Figure 19 illustrates 

the actual versus predicted PCR conditions for a specific pavement section. 

 

 

 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 19. Actual PCR vs. Different Model Predicted PCR for a Pavement Section 
in District 11 treated with Activity Code 50 

 

 

Actual PCR vs. Different Model Predicted (2002-2006) PCR Plots
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Table 10. Actual PCR vs. Different Model Predicted PCR 
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11 CAR 171R UP 8.82 10.8 1995 G Flexible 50 Actual 97 88 88 87 86 87 85 82 78 70 70 
                    Markov   84 82 79 76 74 

                    Family 
Regression   85 84 82 80 79 

                    Individual 
Regression   86 85 84 83 82 

11 COL 039R UP 0 1.06 1995 G Flexible 50 Actual 96 89 87 83 79 79 76 71 69 70 67 
                    Markov   75 71 68 66 63 

                    Family 
Regression   76 72 69 65 72 

                    Individual 
Regression   77 75 74 63 71 

11 HAS 646R UP 10.6 14.9 1995 G Flexible 50 Actual 90 80 79 77 78 75 71 67 64 62 57 
                    Markov   73 70 67 64 63 

                    Family 
Regression   73 70 68 66 70 

                    Individual 
Regression   74 72 71 63 69 

11 HOL 514R UP 5.73 8.08 1995 G Flexible 50 Actual 99 89 89 83 73 72 69 65 61 57 54 
                    Markov   67 64 62 59 45 

                    Family 
Regression   67 61 56 50 63 

                    Individual 
Regression   69 67 65 57 61 

* AC – Activity Code
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Markov Model Results 
 

The predicted PCR values obtained from the Markov model versus the actual PCR values are 

plotted in Figure 20.  Model accuracy is expressed by (1) root mean squared error (RMSE), 

and (2) coefficient of correlation (ρ).  The RMSE is defined as: 
   

( )

n

PCRPCR AP

n

i

2

1RMSE
−

=
∑
= ,          (12) 

 

where PPCR is the predicted PCR value from the prediction model, APCR is the actual PCR 

measurement and n  is the number of observations.  Smaller RMSE value indicates a more 

accurate model.   
 

The correlation coefficient signifies the degree of match between actual and predicted PCR.  

A perfect match would have a correlation coefficient of 1.0.   

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 20. Markov Predicted PCR vs. Actual PCR (2002-2006) 
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It can be seen from Figure 20 that some of the predicted values are quite different from the 

measured values.  After examining the corresponding PCR curves, it was determined that they 

were due to ‘abnormal’ deterioration trends such as (1) sudden decreases of measured PCR 

values, or (2) nearly flat or even gradually increasing PCR curves where a series of 

undocumented maintenance activities may have been performed.   
 

Figure 21 shows an actual pavement section in the data.  This is typical of the ‘abnormal’ 

trends where PCR drops in initial years are consistent, but the rate of deterioration increase 

significantly after a few years.  The Markov and other models can not predict this type of 

sudden change. 
 

Predicted versus Actual PCR
Rapid Drop in PCR
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Section: COL 558R UP
Blog - Elog : 2.08 - 10.15

 
Figure 21. Sudden Drop in PCR  

 
 

Figure 22 shows another actual case, where the pavement ‘stops’ deteriorating after initially 

deteriorating at a ‘normal’ rate.  This is likely due to undocumented maintenance activities.   

None of the statistical-based prediction models can predict these abnormal trends.   
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Predicted versus Actual PCR
PCR Fluctutation
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Figure 22. Fluctuation in PCR  

 
 
Family Regression Model 
 
Separate regression equations were developed for treatment 50 (overlay without repairs) and 

treatment 60 (overlay with repairs) for General system flexible pavements in District 11.  The 

regression equations are: 
 

Activity Code 50 (1985-1994): 

]11)[(Age438.5634.68PCR 0.728
P −+×−= ,  (17) 

38.0 ,3791 2 == Rn  
 
 
Activity Code 50 (1994-2001): 

]11)[(Age453.9383.98PCR 0.728
P −+×−= ,         (18) 

72.0 ,2803 2 == Rn  
 
 
Activity Code 60 (1985-2001): 

]11)[(Age142.6401.98PCR 0.728
P −+×−= ,         (19) 

 74.0 ,1523 2 == Rn
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Similar to the Markov model, the last five years of data from 2001 to 2005 are removed.  The 

predicted PCR values versus the actual PCR values during the same time period are shown in 

Figure 23.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 23. Family Regression Predicted PCR vs. Actual PCR (2002-2006) 
 

 
Individual Section Regression Model 
 
The individual section regression model is based on fitting a regression between PCR and age 

for each and every individual pavement section.  In other words, each pavement section has 

its own regression equation.  The regression equation has the following form: 
 

]11)[(AgeSlopeInterceptPCR 0.728
P −+×+=  ,         (16) 

 

where PPCR is the predicted PCR value and ]11)[(Age 0.728 −+  is the age transformation used 

to account for the non linear deterioration trend between PCR and age.  As with the Markov 

model, the last five years of data from 2002 to 2006 were removed for model development, 

and used for validation.  The predicted PCR values versus the actual PCR values during the 

same time period are plotted in Figure 24.  
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Figure 24. Individual Regression Predicted PCR vs. Actual PCR  (2002-2006) 
 

Table 11 summarizes the RMSE and correlation values for each of the models before and 

after removing the outliers.  The number of PCR data points included in the individual 

regression model are fewer, because a minimum of three years of PCR data are required to 

develop the individual section regression equation.  Therefore, those pavement sections with 

less than three years of PCR data are excluded from the analysis.  
 

 

Table 11. Comparison of Model Accuracies 
 

Forecasting 
Models 

Total 
Directional 

Miles 
Total No. of 

Sections 
Data 

Points RMSE Correlation 
Coefficients

Markov Model 634.18 372 1531 6.55 0.81 
Family Regression 634.18 372 1531 7.24 0.80 

Individual 
Regression 570.91 336 1342 8.73 0.76 
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The error of prediction increases with the time frame of prediction, that is, prediction of near 

future is more accurate than prediction further into the future.  Figure 25 shows the RMSE 

increases quickly with time period of prediction, especially for the individual regression 

model.  Therefore, the individual regression model is not recommended. 

Figure 25. Prediction Error Increases with Time 
 

From the above analysis, it can be concluded that overall, the Markov model provides better 

accuracy than the two types of regression models.  An important benefit of the Markov model 

is that it can also predict individual distresses.  The Markov model requires a sufficient 

number of pavements with similar deterioration trends in order to develop a reliable 

transitional probabilities matrix.  Since the ODOT database contains a very large number of 

pavement sections, this does not present a problem, especially for overlays, which constitute 

the vast majority of the treatments performed.  However, some treatment activities have not 

been used widely, and the number of pavements that have received the treatment is relatively 

small.  For those cases, a family regression model is recommended.    
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III. Summary of Estimated Remaining Service Life of Pavements 
 

The remaining service life of a pavement can be estimated based on its current and forecasted 

conditions.  The terminal condition of a pavement, the condition at which a pavement is 

considered to reach the end of its useful service life, may be defined by several criteria, such 

as a minimum allowable PCR score and/or specific distress level; for example, rutting distress 

must be less than H (0.5 inch).  A tool has been developed as part of this study to estimate the 

remaining service life of each pavement.  The default terminal conditions are a PCR score 

below 65 for Priority system pavements, and a PCR score below 60 for General/Urban 

systems pavements.   

 

Figure 25 summarizes the estimated remaining service life of pavements in each District as of 

2007.  Pavements with no remaining service life (0 years remaining) are those with current 

PCR scores already below the terminal thresholds.  In other words, these pavements are 

considered as ‘deficient’.   

 

The Districts with large mileage of ‘deficient’ or ‘near deficient’ pavements are experiencing 

excessive rehabilitation needs.  These include Districts 3, 4, 6, 9, 10, and 11.  Note the 

majority of the pavements in District 12 are Priority system pavements, and a significant 

number of them require rehabilitation.  In contrast, Districts 1 and 7 have notably fewer 

pavement sections that are deficient or near deficient.   

 

The estimated remaining service life of pavements can be very useful in assessing the overall 

network condition, estimating rehabilitation needs and funding requirements, and planning 

and prioritizing rehabilitation projects.  
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     Priority System (Terminal PCR Threshold = 65) 
     General System (Terminal PCR Threshold = 60) 
 

Figure 26-a Remaining Service Life of Pavements in each District 
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     Priority System (Terminal PCR Threshold = 65) 
     General System (Terminal PCR Threshold = 60) 

 
Figure 26-b. Remaining Service Life of Pavements in each District 

DISTRICT   7

0

100

200

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20

T
ot

al
 M

ile
ag

e

DISTRICT   8

0

100

200

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20

T
ot

al
 M

ile
ag

e

DISTRICT   9

0

100

200

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20

T
ot

al
 M

ile
ag

e

DISTRICT   10

0

100

200

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20

T
ot

al
 M

ile
ag

e

DISTRICT   11

0

100

200

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20

T
ot

al
 M

ile
ag

e

DISTRICT   12

0

100

200

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20

Estimated Remaining Service Life (in years)

T
ot

al
 M

ile
ag

e



 

50 

VI. Estimated Initial PCR after Various Rehabilitation or Maintenance Treatments 
 

The initial PCR value of a pavement after a rehabilitation treatment will depend on the type 

and level of distress existing prior to the treatment and the effectiveness of that specific 

treatment’s in addressing those distresses.  

 

Figure 27 illustrates how the average deduct value of a particular distress at the initial year 

(Year 0) is obtained from the intercept of a linear regression of the average deducts of this 

distress from two to five years after the rehabilitation treatment.  The resulting initial deduct 

value is then converted to the nearest distress level description.  The average initial PCR value 

after a rehabilitation treatment is obtained by combining all the distress deducts.   

 

Figure 28 shows that for a specific pavement section, the initial distress level is also a 

function of the level of the same distress prior to treatment.  For example, after an overlay, the 

initial rutting level is likely to be NULL, if the rutting level prior to overlay was LO, LF, LE, 

or MO.  However, if the rutting level prior to overlay was MF, ME, HO, HF, or HE, then the 

initial rutting level after overlay is likely LO.  Initial levels of other distresses are determined 

in the same way.  Therefore, the initial PCR value of each pavement section can be 

determined from the prior distress level and the treatment applied.  

 

The average distress levels prior to and after various rehabilitation treatments for Concrete 

Pavements, Priority system flexible and composite pavements, and General system flexible 

and composite pavements, respectively, are shown in Table 12.  The average PCR values 

before and after various treatment are also shown.   
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Figure 27. Determine Initial Distress Level from the Distress Levels in Years 2, 

3, 4, 5   
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Figure 28. Initial Distress Level after Overlay as a Function of Prior Distress 
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Table 12. Average Distress Levels Before and After Treatment and Average Initial PCR Values 
 

CONCRETE PAVEMENYTS 
 

Average Distress Level Prior and After Treatment (* indicates NULL)    
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ra
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            SD SD         SD & 
CD 

SD & 
CD SD CD SD & 

CD       

Prior LE   LF * HF   *   O HF MO LO * * 13.7 24.9 66 Reactive 
Maintenance 10 

After LO   LO * *   LO   * MO * * * * 4.8 5.5 89 
Prior LO   LO * *   *   O LE LO * * * 2.8 4.4 89 Crack Sealing 20 
After LO   LO * LO   *   * LE LO * * * 3.1 5.0 89 
Prior HO   MF * ME   *   F LF * MF * * 1.0 13.8 70 Micro-

Surfacing 30 
After After treatment Pavement Type changes to Composite 1.0 1.0 98 
Prior LF   LO * *   *   * LE LO * * * 3.0 4.6 91 Fine Graded 

Polymer AC 
Overlay 

38 
After After treatment Pavement Type changes to Composite 0.3 0.3 97 

Prior LE   HO * LE   LO   * MF MO HO LO * 13.7 23.0 64 CPR 40 
After LF   LO * LO   LO   * HO * LO LO * 9.3 11.2 82 
Prior LE   LF * LE   *   * MF HO LF MO O 21.5 27.4 62 AC Overlay 

Without 
Repairs 

50 
After After treatment Pavement Type changes to Composite 1.7 2.5 95 

Prior LF   MO * LF   *   * LE * MO LF * 4.1 10.1 81 
AC Inlay 52 

After After treatment Pavement Type changes to Composite 0.0 0.0 98 
Prior MO   HO * MF   *   * HF LE MF LE F 29.2 40.0 49 AC Overlay 

With Repairs 60 
After After treatment Pavement Type changes to Composite 0.6 0.9 96 
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CONCRETE PAVEMENYTS 

 

Average Distress Level Prior and After Treatment (* indicates NULL)    
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            SD SD         SD & 
CD 

SD & 
CD SD CD SD & 

CD       

Prior LE   LF * HO   *   * HF MO MF * * 15.9 26.8 67 Break And 
Seat 73 

After After treatment Pavement Type changes to Composite 0.5 0.5 100 
Prior LE   MO * ME   LO   * MF MF * * * 15.9 22.9 68 Rubblize And 

Roll 77 
After After treatment Pavement Type changes to Composite 9.6 11.6 84 
Prior LE   * * HF   *   * HE MF MF * * 21.3 35.3 61 Whitetopping 80 
After *   * * *   *   * * * * * * 0.5 0.5 98 
Prior MO   HO * HO   LO   * HF LE HF * * 17.1 29.1 59 Unbonded 

Concrete 
Overlay 

90 
After *   * * *   *   * * * * * * 0.0 0.3 99 

Prior MO   LE O HO   *   * MF LE MF LO F 25.3 38.0 51 New Rigid 
Pavement 

11
0 After LO   * * *   *   * LO * * * * 1.5 2.6 95 
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PRIORITY SYSTEM   FLEXIBLE PAVEMENT 

Average Distress Level Prior and After Treatment  (* indicates NULL) 
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              SD     SD & 

CD CD SD & 
CD 

SD 
& 

CD 

SD 
& 

CD 
CD SD      

Prior MO * MF * E *     LE MF MF *   HF * 20.4 9.2 69 Reactive 
Maintenance 10 

After MO * LF * F *     LO LE LE *   MF * 14.8 6.3 77 
Prior MO * LE LO O LO     LF LE HF LO   * * 12.1 9.6 79 Crack 

Sealing 20 
After LO * * * * *     * * LO *   * * 1.5 1.0 96 
Prior MO * LF * O LE     * LE MO LO   * * 8.4 7.9 81 Micro-

Surfacing 30 
After LF * * * * *     * * LO *   * * 0.6 0.3 98 
Prior MO * * * O LF     LO MO MF *   * * 9.4 7.8 83 Double 

Application 
Micro-

Surfacing 

31 
After LO * * * * *     * * LO *   * * 1.9 2.0 95 

Prior MO * * * O LE     * MF LE LO   LF * 12.0 7.2 80 Nova-Chip 
Resurfacing 35 

After MO * * * * *     * LF * *   * * 0.5 0.1 98 
Prior MO * * * O LO     LO MO LE *   LO * 9.9 5.9 84 Fine Graded 

Polymer AC 
Overlay 

38 
After LO * * * * *     * * * *   * * 0.0 0.0 99 

Prior MO * LE * F LE     LO HF HF LO   LO * 15.2 11.2 72 AC Overlay 
Without 
Repairs 

50 
After LF * * * * *     * * * *   * * 0.4 0.3 98 

Prior MO * LF * O LF     LF MF MF LF   HE * 23.3 11.4 66 
AC Inlay 52 

After LO * * * * *     * * LO *   * * 0.0 0.0 99 
 

Prior                                     Double Chip 
Seal 55 

After                                     
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PRIORITY SYSTEM   FLEXIBLE PAVEMENT 

Average Distress Level Prior and After Treatment  (* indicates NULL) 
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Prior MO * LE * F MO     LF HF HO LO   MO * 18.7 12.6 68 AC Overlay 
With 

Repairs 
60 After LF * * * * *     * * * *   * * 0.3 0.1 98 

Prior MO * MO * F LO     * HF MO LE   HF * 19.9 8.7 69 New 
Flexible 

Pavement 
100 

After LO * * * * *     * * * *   * * 0.5 0.3 97 
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PRIORITY SYSTEM    COMPOSITE PAVEMENT 
Average Distress Level Prior and After Treatment (* indicates NULL)  
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Prior MF * MF LO LE O *   * HF HO HO LO F   * * 14.
1 9.0 66 Reactive 

Maintenance 10 
After MO * MO * LO * *   MO MF MO MF LO O   * * 13.

2 
10.
0 75 

Prior MO * HO LO MO * *   * HF HO HO LO F   * * 14.
1 7.7 65 Reactive 

Maintenance, 
None 

Contract 

15 
After MO * MF * MO * *   * MF LF MO * F   * * 8.1 3.1 79 

Prior MO * LE * LE * *   MO ME HO HO LO F   * * 17.
8 

10.
8 67 Crack 

Sealing 20 
After LF * LO * LO * *   LO HO LO LF * O   * * 6.7 2.9 87 

Prior MO O HF * HO * O   * ME HO HO * O   * * 11.
8 9.3 65 Chip Seal 25 

After MF * LF * MO * *   * MF * LF * E   * * 5.7 2.2 81 

Prior MO * MO * MO * *   * HF MO MF LO F   * * 13.
1 5.2 72 Micro-

Surfacing 30 
After LF * * * LO * *   * HO LO LE * O   * * 3.8 1.3 90 

Prior MO * LF * LF * *   HO MO LO HO * O   * * 14.
2 

10.
4 76 Double 

Application 
Micro-

Surfacing 
 

31 
After LO * * * LO * *   * LO * LO * *   * * 1.8 0.9 97 

Prior MO * LO * MO * *   * MF LF MO * O   * * 8.3 2.7 81 Nova-Chip 
Resurfacing 35 

After LF * * * * * *   * LO LO LO * *   * * 0.9 0.2 98 
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PRIORITY SYSTEM    COMPOSITE PAVEMENT 
Average Distress Level Prior and After Treatment (* indicates NULL)  
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SD 
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& 

CD 
      

Prior MO * LE * LF * *   LF HO LO HO * O   * * 10.
3 5.9 77 Fine Graded 

Polymer AC 
Overlay 

38 
After LO * * * * * *   * LF * * * *   * * 1.8 0.7 97 

Prior MO * MF * MO * *   LE HF MO ME LO F   * * 17.
8 

10.
2 65 AC Overlay 

Without 
Repairs 

50 
After LF * * * LO * *   * LO * * * *   * * 0.4 0.1 97 

Prior MO * MO LO MO * *   LE ME MO MF LO F   * * 16.
4 9.7 67 AC Inlay 52 

After LO * * * * * *   * LO * * * *   * * 0.6 0.1 98 

Prior MO * MO * MO * *   MO HF MO MF LO F   * * 19.
6 

12.
5 64 AC Overlay 

With Repairs 60 
After LF * * * * * *   * * * * * *   * * 0.3 0.1 98 

Prior MO * MF * MF * *   * ME LF MF LO O   * * 10.
9 3.8 73 Crack And 

Seat 70 
After LF * * * * * *   * * * LO * *   * * 0.2 0.0 97 

Prior LF * MO LO MO * *   * ME HO HO * O   * * 12.
8 6.6 74 Rubblize 

And Roll 77 
After LO * * * LO * *   * LO * LO * *   * * 0.8 0.3 96 
Prior MO * LF * HO O *   * MO MF LE MF O   * * 8.4 8.6 72 New 

Composite 
Pavement 

120 
After MO * * * LO * *   * LE * LE * *   * * 1.9 1.0 93 
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GENERAL SYSTEM   FLEXIBLE PAVEMENT 

Average Distress Level Prior and After Treatment  (* indicates NULL) 
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              SD     SD & 

CD CD SD & 
CD 

SD & 
CD 

SD & 
CD CD SD      

Prior MO * MO * F LE     LF HO HO MO   LO * 18.4 14.0 68 Reactive 
Maintenance 10 

After LF * LO * O LO     LO LE MO LO   LO * 8.9 6.5 84 
Prior MO * MO LO F MO     MO HF HF HO   HO * 24.9 17.8 60 Reactive 

Maintenance
, None 

Contract 

15 
After LF * * * O LF     LO MO MO LF   * * 9.8 8.8 82 

Prior MO * LF * O LO     MO LE LF LE   LO * 16.1 12.0 75 Crack 
Sealing 20 

After MO * * * * LO     * LF * LF   * * 3.5 3.0 91 
Prior MO * LO * F LE     LF MF MF MO   LO * 15.5 12.9 74 Chip Seal 25 
After LF O * * * LE     LO LO LO LF   * * 4.0 5.0 90 
Prior MO * LO * O LF     LO LE MF LF   LO * 14.8 11.0 76 Micro-

Surfacing 30 
After LF * * * * LO     LO LO LO LO   * * 5.2 3.3 91 
Prior MO * LF * O LF     LO MF MF LF   LO * 14.0 10.2 76 Double 

Application 
Micro-

Surfacing 

31 
After LO * * * O LF     * LE MO LO   * * 4.4 3.3 92 

Prior MO * * * O LO     * LF LF LO   * * 7.5 6.6 84 Nova-Chip 
Resurfacing 

 
 

35 
After MO * * * * *     * LO * *   * * 2.5 0.4 95 

Prior MO * LO * O LO     LF MO LF LF   * * 13.5 10.8 78 Fine Graded 
Polymer AC 

Overlay 
38 

After LF * * * * *     * LO * *   * * 2.4 1.5 95 

Prior ME * MO LO E MO     MF HE HF HF   LF * 30.1 21.1 51 Intermediate 
Coarse 

Recycled AC 
45 

After LO * * * * *     * * * *   * * 0.0 0.0 99 
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GENERAL SYSTEM   FLEXIBLE PAVEMENT 

Average Distress Level Prior and After Treatment  (* indicates NULL) 
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              SD     SD & 

CD CD SD & 
CD 

SD & 
CD 

SD & 
CD CD SD      

Prior MF * MO * F MO     MO HF HF LE   LE * 23.3 16.6 61 AC Overlay 
Without 
Repairs 

50 After LF * * * * LO     * * * *   * * 0.4 0.4 98 

Prior MF * LE LO F LE     MO HF HF LE   MF * 24.7 16.1 61 AC Inlay 52 
After LO * * * * *     * * LO *   * * 0.8 1.0 98 
Prior MO * MO * E *     LO HF MF MO   * * 16.0 9.0 74 Double Chip 

Seal 55 
After MO * * HO * *     * LO * LO   * * 4.0 2.0 91 
Prior MF * MO * F MO     LE HF HO LE   LE * 23.1 16.6 62 AC Overlay 

With Repairs 60 
After LF * * * * *     * * * *   * * 0.3 0.2 98 
Prior MF * MO LO F MO     LO HF HO HO   HO * 23.8 15.6 61 New 

Flexible 
Pavement 

100 
After LO * * * * *     * * * *   * * 0.4 0.5 98 
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GENERAL SYSTEM    COMPOSITE PAVEMENT 

 
Average Distress Level Prior and After Treatment (* indicates NULL)  
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                SD SD   
SD 
& 

CD 
CD SD &  

CD 

SD 
& 

CD 
      

SD 
& 

CD 

SD 
& 

CD 
      

Prior MF * LF * MO * *   ME ME HO ME LO F   * * 25.3 17.9 58 Reactive 
Maintenance 10 

After LF * * * LF * *   LE HO LF MO LO O   * * 9.0 4.8 84 
Prior MF * MF LO MO * *   ME HF MF HF MO E   * * 29.5 21.1 51 Reactive 

Maintenance, 
None 

Contract 

15 
After LF * LO * LF * *   LE HO LF MO LO O   * * 11.1 7.0 80 

Prior MO * MO * MO * *   ME ME MO HO * F   * * 23.7 15.9 61 Crack 
Sealing 20 

After MO * LO * LE * *   HO HO LE HO * O   * * 15.6 11.4 76 
Prior MO * * * LE * *   MF ME MO HO LF F   * * 21.7 13.7 66 Chip Seal 25 
After LF * * * LF * *   LE LF LO MO LO *   * * 7.0 5.0 86 
Prior MO * LO * LE * *   LF ME HO HO LO F   * * 15.0 8.9 72 Micro-

Surfacing 30 
After LF * * * LO * *   HO LE LO LF LO *   * * 10.4 7.9 84 
Prior HO * HO * MO * *   HO HF MF ME LO F   * * 25.2 15.6 56 Double 

Application 
Micro-

Surfacing 
 

31 
After LF * * * LF * *   LO LE LO LO * *   * * 5.6 3.1 89 

Prior ME * HO LO LE O *   HO ME ME ME * O   * * 23.2 17.7 59 Nova-Chip 
Resurfacing 35 

After MF * LO * LO * *   MO * * HO * O   * * 6.6 6.6 84 
Prior MO * LO * LE * *   MF HO LF HO LO O   * * 16.8 12.2 71 Fine Graded 

Polymer AC 
Overlay 

38 
After LO * * * * * *   LF * * * * *   * * 1.6 1.4 97 
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GENERAL SYSTEM    COMPOSITE PAVEMENT 

 
Average Distress Level Prior and After Treatment (* indicates NULL)  

Activity 
Name 

A
ct

iv
ity

 C
od

e 

Pr
io

r 
/ I

m
m

ed
ia

te
ly

 
A

ft
er

 T
re

at
m

en
t 

R
av

el
in

g 

B
le

ed
in

g 

Pa
tc

hi
ng

 

Su
rf

ac
e 

D
is

in
te

gr
at

io
n/

 
D

eb
on

di
ng

 

R
ut

tin
g 

Pu
m

pi
ng

 

Sh
at

te
re

d 
Sl

ab
 

(J
oi

nt
ed

 B
as

e)
 

Se
tt

le
m

en
ts

 

T
ra

ns
ve

rs
e 

C
ra

ck
s 

(U
nj

oi
nt

ed
 B

as
e)

 

Jo
in

t R
ef

le
ct

io
n 

C
ra

ck
s 

(J
oi

nt
ed

 B
as

e)
 

In
te

rm
ed

ia
te

 T
ra

ns
ve

rs
e 

C
ra

ck
s (

Jo
in

ed
 B

as
e)

 

L
on

gi
tu

di
na

l C
ra

ck
in

g 

Pr
es

su
re

 D
am

ag
e/

 
U

ph
ea

va
l 

C
ra

ck
 S

ea
lin

g 
D

ef
ic

ie
nc

y 

C
or

ru
ga

tio
ns

 

C
or

ne
r 

B
re

ak
s 

(J
oi

nt
ed

 B
as

e)
 

Pu
nc

ho
ut

s 
(U

nj
oi

nt
ed

 B
as

e)
 

A
ve

ra
ge

 
C

ra
ck

in
g 

D
ed

uc
t (

C
D

) 

A
ve

ra
ge

  
St

ru
ct

ur
al

 D
ed

uc
t (

SD
) 

A
ve

ra
ge

 / 
In

iti
al

 
PC

R
 

                SD SD   
SD 
& 

CD 
CD SD &  

CD 

SD 
& 

CD 
      

SD 
& 

CD 

SD 
& 

CD 
      

Prior HE O MF LO ME * *   * HE ME HE MF E   * *       Intermediate 
Coarse 

Recycled AC 
45 

After MO * * * LE * *   * MF * * LO F   * *       

Prior MF * MO * MF * *   MF HF MF ME LF E   * * 27.0 17.4 55 AC Overlay 
Without 
Repairs 

50 
After LF * * * LO * *   * LO * * * *   * * 0.8 0.4 97 

Prior ME * LF LO LE * *   MF HF ME HF MO F   * * 28.4 19.4 54 AC Inlay 52 
After LO * * * * * *   * * * LO * *   * * 0.8 0.6 98 
Prior MF * MO * MO * *   ME HF MF ME LF F   * * 28.7 19.8 53 AC Overlay 

With Repairs 60 
After LF * * * * * *   * * * * * *   * * 0.5 0.3 97 
Prior ME * MF LO LE * *   * HE MO HE * E   * * 18.9 6.9 64 Rubblize 

And Roll 77 
After LO * * * * * *   * * * * * *   * * 0.0 0.0 99 
Prior MO * HO LO LE * *   * ME MF MF * E   * * 13.4 6.4 72 New 

Composite 
Pavement 

120 
After MO * * * LE * *   * LO * MO * O   * * 0.0 0.0 94 
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V. Rehabilitation Decision Trees and Multiyear Work Plan Tool 

 
A set of rehabilitation treatment decision trees was developed in cooperation with the Office of 

Pavement Engineering.  Separate decision trees were developed for Priority system major 

rehabilitation candidates, concrete pavements, Priority system composite and flexible 

pavements, General system composite and  flexible pavements, General system low volume 

pavements, and poor performance and poor condition pavements.  These recommended 

rehabilitation treatment decision trees are shown in Appendix B.    

 

By applying the recommended treatment decision trees to the current and forecasted future 

pavement conditions, the rehabilitation needs for the current and future years can be obtained.  

As the available budgets are not likely to satisfy all rehabilitation needs, an actual work plan 

must be developed with consideration of budget and other constraints such as keeping the 

percentage of ‘deficient’ pavements below a certain limits. 

 

A tool has been developed to evaluate and compare alternative multiple-year work plans based 

on their effect on predicted future conditions.  Figure 29 shows the View Predicted Pavement 

Condition with Work Plan menu.  The planned future projects are imported from a spreadsheet 

and saved in a table named DATA_FutureProjects.       

 

Table 13 shows the resulting predicted PCR values after the effects of planned work have been 

incorporated for a group of selected pavements.  Figure 30 shows the existing and predicted 

PCR trends with and without planned treatment for a specific pavement section. 
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Figure 29. View Predicted Pavement Condition with Work Plan Tool 
 
 

 
Figure 30.  Predicted PCR Trend with and without Planned Treatment 

50 6050 60
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Table 13.  Effect of Planned Work Example 
 

Activity Code PCR PaveID District County Route Blog Elog Pave 
Type 2008 2009 2010 2004 2005 2006 2007 2008 2009 2010 2011 2012 

1 11 BEL 007A 0 0.46 2       74 73 72 70 66 62 58 54 50 
20 11 BEL 009R 16.26 20.4 3       89 81 79 70 67 64 60 57 54 
21 11 BEL 009R 20.4 22.8 3       91 83 83 75 71 67 63 60 56 
34 11 BEL 040R 19.72 20.13 4 60     62 99 96 93 97 94 92 89 86 
66 11 BEL 147R 14.05 14.38 3     60 67 61 59 59 55 52 96 91 86 
67 11 BEL 147R 14.38 19.19 3     60 67 61 61 57 54 51 96 91 86 

195 11 CAR 009R 21.82 28.08 3       61 56 54 99 96 93 90 87 85 
196 11 CAR 039R 0 4.5 3       60 57 54 51 48 45 42 39 37 
200 11 CAR 039R 7.29 10.23 4       75 75 72 71 68 66 64 61 60 
201 11 CAR 039R 10.23 14.25 3       99 93 92 89 83 77 71 66 60 
203 11 CAR 039R 15.18 23.41 3   60   72 62 62 62 59 96 91 86 82 
204 11 CAR 039R 23.41 25.92 3   60   68 62 62 54 53 96 91 86 82 
205 11 CAR 039R 25.92 27.35 3   60   68 62 62 54 53 96 91 86 82 
210 11 CAR 043R 14.1 16.19 4       67 61 60 61 57 54 52 50 49 
283 11 COL 014R 6.41 8 4       91 80 78 76 73 71 69 66 64 
285 11 COL 014R 8.83 8.89 4       75 75 95 93 90 87 84 82 79 
286 11 COL 014R 9.33 9.41 4 50     68 62 60 60 96 90 85 80 76 
287 11 COL 014R 12.67 19.26 4 60     72 66 71 70 97 94 92 89 86 
291 11 COL 030R 0 7.33 4       78 67 67 68 65 63 60 58 57 
292 11 COL 030R 7.33 8.87 4       77 71 71 68 65 63 60 58 56 
466 11 HAS 009R 6.24 6.48 3 100   200 77 75 73 68 97 93 90 88 85 
483 11 HAS 022R 9.24 9.27 4 200     73 71 70 98 94 91 88 86 83 

  
- Actual PCR   - Predicted PCR              - Predicted PCR below threshold 85 58 75 
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VI. Pavement Management Database for Local Routes 

 

Table 14 shows a summary of the data contained in the LOCAL PMIS database for local 

federal-aid routes and the current (or latest) condition based on the available PCR 

measurements.  As can been from Table 14, Districts 1, 2, 6, 7, 8 have PCR data from 2003 and 

2005, whereas the other Districts have data from 2003, 2004, and 2006.   
 

Statewide, a total of 11,611 miles of local pavements are included in the database.  

Approximately 32.9 percent are in very good condition, 24.9 percent are in good condition, 

21.7 percent are in fair condition, 12 percent are in poor condition, and 8.5 percent are in very 

poor (or deficient) condition.  On average, local pavements in Districts 1, 6, 7, 8, 9 are in better 

conditions than the rest of the State.  Figure 31 shows the condition distribution of local 

pavements in each District. 
 

Some of the analysis functions and reporting tools available in the ODOTPMIS had to be 

disabled due to lack of project history data.  The primary tools remaining include current 

condition report, condition forecasting for a single or a group of pavements, remaining service 

life estimation, and rehabilitation recommendations based on decision trees.   

 

Forecasting Pavement Condition by Linear Regression 
 

Since the database for local federal-aid routes contains only two or three years of PCR data in 

the most recent past, with no project history or construction dates, a linear regression model is 

used to calculate the average deterioration rate.  The linear regression model predicts both 

individual distresses and overall PCR value for each pavement section.   As more data become 

available in the future, a nonlinear regression or a Markov model may be adopted.   
 

For pavement sections where the best fit line cannot be drawn from the data or where the 

resulting PCR slope is abnormal (e.g., positive slope which indicates non-deteriorating 

condition or PCR is decreasing by more than 10 points a year), prediction is done based on the 

statewide average.  Figures 32 and 33 show the PCR trend based on the actual predicted PCR 

slope and on District average PCR slope respectively.   
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Table 14. Summary of Local Pavement PCR Data and Current Condition 
 

Data Availability Latest Pavement Condition in Percent 
Miles District County Miles 

2003 2004 2005 2006 PCR: 
> 90 

PCR: 
80-90 

PCR: 
70-80 

PCR: 
60-70 

PCR: 
< 60 

ALL 146.07 D  D  32.4 36.9 17 4.3 9.3 
DEF 42.56 D  D  36.9 37 19.9 6 0.2 
HAN 89.68 D  D  41.6 13.9 16.2 15.7 12.6 
HAR 34.28 D  D  49.2 40.9 7.9 2 0 
PAU 28.54 D  D  45.6 9.4 4.1 36.8 4.2 
PUT 30.85 D  D  76.8 17.3 1.6 4.2 0 
VAN 44.09 D  D  20.6 42.4 31.9 3.1 2.1 

 
1 
 

WYA 44.38 D  D  36.4 35.3 23.9 1 3.3 
1   460.45 Average Condition 38.9 30.1 16.7 8.1 6.2 

FUL 149.14 D  D  32.7 13 25.6 19.6 9.1 
HEN 62 D  D  23 14.5 48.8 7.7 6.1 
LUC 430.19 D  D  30.9 25.3 26.1 9.6 8.1 
OTT 45.17 D  D  58.2 28.7 4.9 4.4 3.7 
SAN 111.96 D  D  32.3 13.2 41 10.2 3.3 
SEN 131.42 D  D  29.4 36.7 28.6 4.4 0.8 
WIL 50.1 D  D  16 30.2 26.5 27.2 0 

 
2 
 

WOO 167.27 D  D  16.1 24.8 21.5 18.4 19.2 
2   1147.3 Average Condition 28.9 23.5 27.5 12.1 7.9 

ASD 51.06 D D  D 36.2 16.1 14.5 15.3 17.9 
CRA 67.87 D D  D 10 34.8 25.8 23 6.5 
ERI 96.64 D D  D 55.8 24.7 7.8 8.9 2.9 
HUR 69.38 D D  D 22 16.2 27.5 9.5 24.8 
LOR 248.64 D D  D 21.8 20.3 21.4 20.4 16.1 
MED 146.86 D D  D 24.4 22.6 20.4 17.9 14.7 
RIC 161.3 D D  D 23.7 25.3 18.3 23.3 9.3 

 
 
 
3 
 

 
 

 
WAY 176.08 D D  D 34.3 33.2 16.8 4.5 11.2 

3   1017.8 Average Condition 27.8 24.6 19 15.8 12.8 
ATB 106.04 D D  D 38.2 16.9 17.7 12.7 14.6 
MAH 285.21 D D  D 18.4 11.6 24 19.5 26.5 
POR 142.69 D D  D 16.5 28.4 22.9 22.5 9.7 
STA 495.33 D D  D 29.2 28.9 19.1 14.8 8 
SUM 501.32 D D  D 28.4 23.7 29.1 13.6 5.1 

 
4 
 

TRU 198.12 D D  D 20.9 13.8 20.6 28.4 16.3 
4   1728.7 Average Condition 25.8 22 23.2 17.3 11.7 
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Data Availability Latest Pavement Condition in Percent 
Miles District County Miles 

2003 2004 2005 2006 PCR: 
> 90 

PCR: 
80-90 

PCR: 
70-80 

PCR: 
60-70 

PCR: 
< 60 

COS 29.58 D D  D 42 23.2 24.6 7.8 2.4 
FAI 128.27 D D  D 37.8 24.8 22.2 9.1 6.1 

GUE 69.49 D D  D 58.3 10.5 20.1 9.5 1.5 
KNO 41.59 D D  D 28.3 19.5 14.5 33.6 4 
LIC 149.75 D D  D 29.7 12 29.3 14.6 14.4 

MUS 123.25 D D  D 37.7 19.1 22.1 8.4 12.6 

5 

PER 16.49 D D  D 83.7 5.7 3.2 7.4 0 
5   558.42 Average Condition 39.1 17.3 22.8 12.2 8.6 

DEL 134.1 D  D  51.9 26.2 16.4 4.6 0.8 
FAY 34.81 D  D  43.3 39.8 3.9 12.7 0.3 
FRA 830.37 D  D  40.1 32.9 17.5 4 5.5 
MAD 22.85 D  D  4.8 19.4 27.8 8.4 39.6 
MAR 76.87 D  D  28.7 18 35.1 13.2 5 
MRW 22.25 D  D  23.3 5.4 6.3 64.9 0 
PIC 18.76 D  D  61.6 17.1 8.3 12 1 

 
6 
 

UNI 86.24 D  D  33.2 26.7 24.4 13.2 2.5 
6   1226.3 Average Condition 39.6 30 18.4 6.9 5.1 

AUG 52.63 D  D  38.6 21.2 27.2 4.3 8.7 
CHP 34.68 D  D  47.6 33.6 7.5 7.1 4.2 
CLA 182.28 D  D  32.7 20.7 37.9 8.4 0.3 
DAR 69.18 D  D  38 39.9 21.8 0.4 0 
LOG 63.27 D  D  23.2 31.3 27 4.6 13.8 
MER 37.41 D  D  44.9 24 26.4 4.4 0.4 
MIA 119.04 D  D  35.8 18.8 14.3 17.6 13.5 
MOT 714.29 D  D  36.9 30.8 21.1 4.3 6.9 

 
7 
 

SHE 51.23 D  D  31.8 43.4 7.7 7.6 9.5 
7   1324 Average Condition 36 28.8 22.6 6.1 6.5 

BUT 263.83 D  D  32.7 32.6 14.8 11.3 8.7 
CLE 104.48 D  D  37.5 23.6 15.8 22.3 0.8 
CLI 56.31 D  D  41.1 34.9 17.6 3.3 3 

GRE 198.92 D  D  31.4 17.4 26.3 21 3.9 
HAM 639.57 D  D  34.9 29.2 22.4 10 3.5 
PRE 36.24 D  D  46 24.9 18.6 7.6 3 

 
8 
 

WAR 95.13 D  D  45.6 11 14.8 7.9 20.6 
8   1394.5 Average Condition 35.4 26.6 20.2 12.3 5.5 
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Data Availability Latest Pavement Condition in Percent 
Miles District County Miles 

2003 2004 2005 2006 PCR: 
> 90 

PCR: 
80-90 

PCR: 
70-80 

PCR: 
60-70 

PCR: 
< 60 

ADA 44.61 D D  D 46.1 40.1 12 0 1.7 
BRO 69.62 D D  D 60.5 39.3 0 0 0.1 
HIG 54.19 D D  D 78.3 17.9 2.1 1.2 0.6 
JAC 57.11 D D  D 16.7 17.4 25.3 25.4 15.3 
LAW 79.26 D D  D 33.7 20.1 11 21 14.2 
PIK 33.66 D D  D 2.2 4.5 33.3 47.7 12.2 

ROS 110.86 D D  D 27.8 35.1 12.1 19 6 

 
9 
 

SCI 54.87 D D  D 26.6 31.8 26.7 12.6 2.2 
9   504.18 Average Condition 37.2 27.5 13.7 15 6.6 

ATH 80.73 D D  D 27.2 11.7 24.9 15.5 20.8 
GAL 48.9 D D  D 33.3 9.7 12.9 39.8 4.3 
HOC 28.06 D D  D 8 29.7 50.7 11.6 0 
MEG 51.28 D D  D 35.7 19.5 28.1 2.6 14.1 
MOE 45.14 D D  D 22 19.5 1.1 22.5 34.9 
MRG 21.36 D D  D 16.1 38.6 7.5 2.1 35.7 
NOB 13.3 D D  D 43.5 0 0 28.2 28.3 
VIN 38.63 D D  D 35.9 17.8 46.3 0 0 

 
10 

 

WAS 83.83 D D  D 30.8 35.4 27.5 1 5.4 
10   411.23 Average Condition 28.6 20.9 23.8 12.6 14 

BEL 118.25 D D  D 19.1 4.5 17.9 29.2 29.4 
CAR 24.79 D D  D 30.9 51.1 12.9 4 1.3 
COL 134.49 D D  D 17 21.8 43.1 13.9 4.1 
HAS 46.7 D D  D 53 21.9 7.1 1.7 16.3 
HOL 50.32 D D  D 37.3 14.7 35.7 12.1 0.2 
JEF 103.72 D D  D 31.1 29 17.6 13 9.2 

 
11 

TUS 158.1 D D  D 54.4 24.2 13.3 2 6 
11   636.37 Average Condition 33.8 21 22.5 12.2 10.6 

CUY 904.59 D D  D 37.5 20.8 21.6 11 9.2 
GEA 138.93 D D  D 24.3 38.2 27.7 5.9 3.9 12 
LAK 158.28 D D  D 8.1 23.2 31.6 29 8.2 

12   1201.8 Average Condition 32.1 23.1 23.6 12.8 8.4 

Statewide 11611 Average Condition 32.9 24.9 21.7 12 8.5 

 
 
 



 

70 

District 2

28.9

23.5

27.5

12.1
7.9

District 1

38.9

30.1

16.7

8.1
6.2

PCR > 90
PCR: 80-90
PCR: 70-80
PCR: 60-70
PCR < 60

District 3

27.8

24.619

15.8

12.8

District 4

25.8

22
23.2

17.3

11.7

District 5

39.1

17.3

22.8

12.2

8.6
District 6

39.6

30

18.4

6.9
5.1

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 31-a. Condition Distribution of Local Pavements in Each District 
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Figure 31-b. Condition Distribution of Local Pavements in Each District  
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Figure 32. PCR Trend Based on Individual Slope for a Pavement Section  
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
Figure 33. PCR Trend based on Average Sloped for a Pavement Section 
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Estimation of Remaining Life of Pavement 

LOCALPMIS uses the predicted PCR and distress information to estimate the remaining life of 

the pavement. The terminal condition in terms of PCR or distress thresholds can be defined by 

the user.  The default terminal condition is PCR value below 60. 

Repair Candidates 

The pavement database for federal aid local routes includes four types of pavements: Jointed 

Concrete Pavement (JCP), Local Pavement (Asphalt), Brick Pavement, and Gravel Pavement.  

The rehabilitation decision tree for Local Pavement was designed in cooperation with ODOT 

officials.  For JCP, the same rehabilitation decision tree for state highways was used.  Decision 

trees for the brick and gravel pavements are not available at this time. 

Based on the repair decision tree and the current PCR and distress information, LOCALPMIS 

generates a report listing the pavement sections that require Preventive Maintenance (PM), 

Minor Rehabilitation, or Major Rehabilitation.  The report also lists the pavement sections 

which do not require any repair. 

Report 

LOCALPMIS can generate both the existing and future pavement condition report and can also 

generate a graph displaying PCR trend for any individual pavement section.  Both the existing 

and future condition reports contain the section-wise information of PCR and distresses.  

More detailed information on the LOCALPMIS is presented in Appendix D. 
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CONCLUSIONS AND RECOMMENDATIONS 
 

Transportation agencies around the Country must find ways to cope with rapidly rising 

construction costs, which are unlikely to be offset by highway budget increases in the 

foreseeable future.  Prudent use of available rehabilitation budget is essential to maintain and 

preserve the existing highway infrastructure during this challenging period.  Selection of the 

most beneficial projects among competing needs and determination of the most cost-effective 

rehabilitation strategies require knowledge regarding future system conditions.  This research 

study has developed models and tools to forecast future conditions and estimate remaining 

service life of pavements.  The results can be used to support pavement maintenance and 

rehabilitation planning and management decisions. 

 

Based on the findings of this research study, the following conclusions can be made: 

 

1.   Pavement condition can be predicted using the models developed in this study.  Having the 

capability to forecast future conditions and to estimate the remaining service life of 

pavements provides invaluable decision support in choosing the most cost-effective 

strategies 

2. The following three forecasting models: the individual section regression, the “family” 

regression, and the Markov transition models were developed in this project.  These 

statistical models were developed based on past performance data available in the ODOT 

pavement management database. 

3. The family regression model and the Markov transition model require pavements to be 

grouped into “families” with similar characteristics.  In this study, pavements within the 

same system, pavement type, or District, or those having received the same treatment 

activity are considered as in the same “family.  However, there still can be fairly large 

variations in deterioration trends within the same “family”.  This “within family” variation 

is one of the sources of prediction errors.     

4. A tool was developed to allow the user to define “families” with different characteristics.  

This provides more flexibility in choosing the “family” members yielding more accurate 

prediction.  However, each family should include a significant number of pavements with 
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varying ages for the forecasting to be reliable.  A minimum number of approximately 300 

sections is recommended.   

5. The prediction models were validated by comparing the predicted pavement distress and 

PCR conditions to the measured actual conditions.  Predicted pavement conditions for the 

period of 2002-2006 were compared with measured actual conditions during the same 

period.  In general, the predicted results matched reasonably well with measured data.  The 

Markov model delivers the best overall accuracy, followed by the family regression model.   

6. The individual regression model relies only on the available past deterioration trend to 

predict future conditions.  It requires at least a few years of known PCR condition data for a 

specific pavement section.  Therefore, it cannot be applied to newer pavements, where 

predictions of future conditions would be most useful.   

7. Both the family regression and Markov models predict future conditions based on the 

known current (or latest available) condition.  The prediction error increases as the time 

span increases.  That is, prediction of the near future is more accurate.  Therefore, condition 

forecasting should be performed each year based on the latest, most updated current 

condition.  

8. The Markov model developed in this study first predicts the deduct trend of each individual 

distress.  It then predicts the PCR value by summing up the total deducts from of the all 

distresses.  The ability of the Markov model to predict the individual distress level (and the 

likely severity and extent) is an important benefit over the other forecasting models. 

9. Attrition of pavement condition data due to fewer pavements with more advanced ages, also 

called “drop outs”, can cause the average deterioration trend to appear to ‘level off’ and not 

deteriorate any further beyond a certain age.  This can result in overestimation of pavement 

conditions and possibly cause under funding of the rehabilitation program.  A technique 

called ‘imputation’ was used to address this problem for both the family regression and 

Markov models.    

10. All three of the developed forecasting models can predict non-linear deterioration trends.  

The Markov model has the advantage of forming the best-fit non-linear deterioration curve 

without requiring the non-linear function to be specified.   

11.  The predictions provided by the forecasting models are not perfect.  All three models fail 

to accurately predict pavement conditions when the deterioration trends are inconsistent, 
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such as pavements that deteriorate suddenly following a steady deterioration, pavements 

that stop deteriorating after relatively rapid deterioration, or pavements with fluctuating 

conditions but no apparent deterioration trend. 

12. The Markov model requires a significant number of pavement sections with similar 

characteristics in order for the developed transition matrix to be reliable.  Since the ODOT 

pavement database contains a large number of pavement sections, this does not present a 

major problem, especially for the more commonly performed treatment activities such as 

overlays.  For treatment activities that do not have a sufficient number of pavement 

sections, the family regression model with Shahin’s ‘shift’ method can be used.      

13. The remaining service life of a pavement is estimated by counting the number of years 

between the current year and the year its predicted conditions fall below a specified 

terminal condition.  The default terminal condition for Priority system pavements is PCR 

value of 65, and for General system pavements, PCR of 60. 

14. Pavements with zero years of remaining service life are considered as ‘deficient’.  Based on 

the forecasted pavement conditions and the rehabilitation work planned by ODOT for the 

next five years, the number of pavements that will be in deficiency will rise substantially in 

the next few years.        

15. Reasonable initial PCR values after various rehabilitation treatments were determined based 

to on average distress condition progressions after the same rehabilitation treatment.  The 

type and level of distresses presented prior to the rehabilitation were also factored in.  The 

resulting initial PCR values reflect more realistically the actual pavement condition than 

assigning a perfect score to all newly rehabilitated pavements.     

16. A set of rehabilitation recommendation decision trees developed by the Office of Pavement 

Engineering was used to establish the most appropriate treatment for each pavement 

section.  The recommended rehabilitation treatment, if any, was determined based on the 

type of pavement structure, traffic volume on the pavement, current pavement distress 

conditions, past performance, and treatment history.   

17. Current and future maintenance and rehabilitation needs can be determined.  The future 

needs are dependent upon the work being performed and planned.  A tool has been 

developed to allow various multiple-year work plans to be evaluated as to their impact on 

forecasted future network conditions.  
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18. A separate pavement database for local federal-aid routes has been developed.  The amount 

and type of data available to these local pavements are very different from that of the state 

highway pavements.  Therefore, a separate database and different functions have been 

developed. 

 

The following recommendations are made based on the findings of this study: 

 

1. Overall, the developed forecasting models provide acceptable accuracy in predicting future 

pavement conditions.  Therefore, it is recommended that ODOT use the predicted 

conditions to support pavement management decisions such as developing rehabilitation 

work plans. 

2. The Markov transition model is the recommended model for predicting pavement 

conditions after overlay (with or without repair), which is the predominant rehabilitation 

treatment, accounting for 85-90 percent of total repair mileage.   

3. When the number of pavements in a “family” group is relatively small (for example, less 

than 300 miles total), family regression model with ‘shift’ is recommended.   

4. The individual regression model is recommended for local Federal-aid route pavements, 

since no pavement age data are currently available.  The dependent variable is the PCR 

value, whereas the independent variable is the calendar year.  

5. Further study to refine the “family group” definition is recommended to further improve the 

prediction accuracy.   

6. The predicted pavement conditions and remaining service life estimations should be 

updated each year based on the latest pavement condition rating.  The corresponding 

rehabilitation treatment recommendations for current and future years and the multiple-year 

work plan should also be updated on a yearly basis.      

7. Continuing yearly collection of pavement condition data in a consistent manner is highly 

recommended.    

8. The initial PCR value estimates after various rehabilitation treatments developed in this 

study are recommended to be used by ODOT to reflect more realistically the actual 

pavement conditions.  
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9. The statewide pavement network conditions are projected to worsen in the next several 

years based on the forecasted pavement conditions and the scheduled work.  It is 

recommended that ODOT take countermeasures to preserve the existing pavement assets.  

Such countermeasures may include more careful selection of pavement sections for 

rehabilitation, applying more cost-effective rehabilitation treatments, and adopting best 

pavement management practices at both Central and District offices.      
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IMPLEMENTATION PLAN 
 

The results of this research study can be implemented as follows: 

 

1. The pavement condition forecasting models, the remaining service life estimation function, 

and the rehabilitation recommendation decision trees have been incorporated into the 

ODOT Pavement Management Database.  Predicted future conditions, estimated remaining 

service lives, and rehabilitation treatment recommendations for a specified group of 

pavements or for the entire state highway network can be generated.  Alternative multiyear 

rehabilitation work plans can be evaluated with regard to their impact on future network 

conditions. The Office of Pavement Engineering has taken a proactive role in leading the 

efforts to implement the results of this research study.  Most of the tools developed in this 

study have been used by the Office to support pavement management activities.  

2. The results of this study may be integrated with findings from other related research 

projects to support a comprehensive pavement management system.   Such a system can 

fully support the various critical pavement management decisions routinely made by the 

Central Office as well as District Offices in a timely manner.   

3. Local agencies (counties and municipalities) can use the local Federal-aid routes pavement 

database developed in this study to support local pavement management decisions.  Since 

the same pavement condition rating system is used for both State highways and local roads, 

more consistency in the pavement management process is possible.      
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APPENDIX B.  REHABILITATION DECISION TREES 
 
 
 
 

 
 

FIGURE B-1.  Priority System Major Rehabilitation Candidates List 
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FIGURE B-2.  Priority System Concrete Pavements Decision Tree 
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FIGURE B-3.  Priority System Flexible and Composite Pavements Decision Tree
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FIGURE B-4.  Priority System Flexible and Composite Pavements Decision Tree (Continued)
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FIGURE B-5.  General System Decision Tree 
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FIGURE B-6.  General System Decision Tree for Poor Performing and Poor Condition Pavements 
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FIGURE B-7.  General System Decision Tree for Low Volume Pavements 
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FIGURE B-8.  General System Decision Tree for Composite Pavements 
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FIGURE B-9.  General System Decision Tree for Flexible Pavements 
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APPENDIX C.  ODOTPMIS USER MANUAL 
 
 
 
The pavement management database (ODOTPMIS) has been extensively updated as part of this study.  

Several new tools were added and a few of the existing tools were revised.  This Appendix provides a 

detailed user manual to the entire updated ODOTPMIS. 

 

The new tools include:  Generate Markov Predictions, Show Predicted Pavement Conditions, Estimate 

Remaining Life, and Import Planned Projects.   

 

The tools that have been revised are: Derived Performance Trend, Rehabilitation Candidate Lists, 

Apparent Projects Determination, and Import Pavement Condition Data. 
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INTRODUCTION 
 
The Infrastructure Information System Laboratory at the University of Toledo has developed a 
Pavement Database for the Ohio Department of Transportation using the Microsoft Access 
database format.  The ODOTPMIS includes the database and a set of reporting tools to extract 
the data necessary for pavement performance analysis.   
 
This section of the user’s manual includes installation procedures of the ODOTPMIS, an 
introduction to the menu items, and a brief overview of the basic operations. 
 
1.1 System Installation 
 
Three types of installations may be performed: full, lightweight, and executable file only.  The 
full version includes the entire database, and is necessary for new users. The lightweight 
version is for users who have the database, but wish to update the program and the required 
runtime components.  During installation, click the “Yes,” “Next,” and “OK,” buttons to install 
ODOTPMIS successfully.  The default directory where PMIS is installed is “C:\Program 
Files\ODOT Pavement Management Information System.” Users can change this installation 
directory by selecting a different location. Figure C-1 shows the sequential steps in installing 
ODOTPMIS for the full and lightweight versions. 
 

 

 
FIGURE C-1. Installation Procedure 

 
Users requiring an executable file only installation should download the new executable file 
from the ODOTPMIS download page and replace the existing executable file 
(ODOTPMIS.exe) found in the installation directory. 
 
Some program updates may also require updating tables in the database.  To replace only these 
tables in the database: 

1. Download the updated tables 
2. Open the original database (odot.mdb) in Microsoft Access 
3. Delete or rename the tables which will be replaced 
4. Under the “File” menu choose “Get External Data” and click “Import” 
5. Select the newly downloaded database 
6. Select the updated tables 
7. Click OK 
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Newer versions and updates of ODOT PMIS can be downloaded from 
http://www.eng.utoledo.edu/civil/chou/index.htm under the OdotPMIS Download  Page link. 
Once ODOTPMIS is installed, it attempts to locate the most recently accessed database. If no 
database can be found, it prompts the user to locate the database manually. To store this path, 
go to the “File” menu, choose “Preference,” check the “Load Last Database” and “Save 
Database Path” checkboxes, and click the “Apply” button. In the future, ODOTPMIS will use 
this saved path as the default database path. 
 
1.2 Reinstallation 
After each reinstallation of the ODOPMIS, the user must locate the path to the database. 
 
1.3 Uninstallation 
ODOTPMIS should be uninstalled before a full reinstallation. When uninstalling an older 
version of the ODOTPMIS, the database is not deleted automatically. If a database with the 
same name already exists in the same directory where a full version of ODOTPMIS is to be 
installed, the new database can not be copied into the same directory. The user must manually 
delete of the older database.  This is done to prevent accidental overwriting of the existing 
database.   
 
1.4 System Requirements 
Recommended software platform requirements for running this package are: 

1. Windows 98 / Me / 2000 / XP 
2. Microsoft Access 2000 

 
Recommended minimum hardware platform requirements for running this package are: 

1. Pentium II 300Mhz CPU 
2. 128MB RAM 
3. 14" color monitor 
4. 2GB free hard disk space 
5. Mouse 
6. Color printer 
7. 4MB video memory 
8. CD-ROM drive 

 
1.5 Compact Database 
 
Users may find it is necessary to compact the database when its size exceeds 1GB. The 
database can be compacted by the following process. 
 

1. Choose “Compact and Repair Database” in the “File” menu 
2. Open the Access database file “ODOT.MDB” and in the “Tools” menu, choose 

“Database Utilities,” and click on “Compact and Repair Database” 
 

This operation may take 5 – 10 minutes, depending on the size of the database and the 
specifications of the computer. 

http://www.eng.utoledo.edu/civil/chou/index.htm
http://eng.utoledo.edu/~hpulugur
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1.6 Required Tables 
 
For the PMIS utility to operate, several Data and Look-Up tables are required in the database. 
The tables are: 
 
 

TABLE C-1. PMIS Required Tables 
DATA_Apparent Projects LU_MarkovFamilyDistress LU_Slope 
DATA_FutureProjects LU_MarkovFamilyPCR LU_STD Base Class 
DATA_InitialCondition LU_MarkovTree LU_STD Surface Class 
DATA_ODOT LU_Median Type LU_Structural Number 
DATA_PERF_Analysis LU_NLFID LU_Weather 
DATA_PERF_BASE LU_Parameter Range LU_STD Surface Class 
DATA_Project History LU_PaveType LU_Structural Number 
DATA_Road Inventory LU_PQIParameters LU_Weather 
LU Pavement Layer LU_Priority LU_STD Surface Class 
LU_Activity LU_Project AggType LU_Structural Number 
LU_Activity Modified LU_RehabCost LU_Weather 
LU_AggType LU_Repair Limits LU_Structural Number 
LU_BinSummary LU_Repair Logic LU_Weather 
LU_Centerline Length LU_Route_Suffix LU_Color 
LU_FHWA Surface Class LU_Deduct_1998 LU_COST 
LU_Functional Class LU_Distress LU_County 
LU_Inflation LU_Distress_1998 LU_Deduct 
LU_Jurisdiction LU_LAYER 

 
 
PMIS prevents all operations from being performed in the database if any of these tables are 
missing. 
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BASIC USER INTERFACE ELEMENTS 
 
ODOTPMIS was developed using Microsoft Visual Basic 6.0 to replicate common window-
based graphical user interfaces.  As such, the PMIS interface utilizes drop down menus located 
at the top of the screen, a number of buttons located beneath the menus, and an object browser 
to list queries and tables stored in the pavement management database.  The following is a 
screenshot of ODOTPMIS. 
 

 
FIGURE C-2. ODOTPMIS User Interface 

 
File Menu  
 
The following figure shows the “File” menu options. 
 

 
FIGURE C-3. ODOTPMIS File Menu 

Table

Object

Buttons
Menus 
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3.1 Open Database 
 
This command is used to open the desired database for use within ODOTPMIS. The dialog box 
shown in Figure C-4 is shown when this option is clicked. 
 

 
FIGURE C-4. Open Database Dialog Box 

 
Choose the database file by selecting the directory from the drop down selector labeled “Look 
in.” Select the file and click “Open.” 

 
 
3.2 Print Preview 
 
All the tools in ODOTPMIS have a “Print Preview” option. Check this option to get a preview 
of the output obtained from the tools (reports, tables, or charts). Figure C-6 shows the preview 
of the lookup table “LU_Activity.” 
 
To preview the same table, use the following process: 
 

1. In the object browser, select “LU_Activity” 
2. In the “File” menu, select “Print Preview” 
3. The preview shown in Figure C-6 will be generated 
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FIGURE C-6. Print Preview of [LU_Actvity] 

 
 This preview page has the following options: 
  

 Print the current page only 

 Go to first page 

 Go to previous page 

 Current page number 

 Go to next page 

 Go to last page 

 Open the print setup window 

 Close the print preview 
FIGURE C-7. Preview Page Options 

 
The “Print Setup” window provides options to customize the document for printing. This 
allows users to change the layout, column widths, column orders, and other organizational 
aspects. Figure C-8 shows the “Print Setup” window. 
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FIGURE C-8. Print Setup Dialog Box – Layout Tab 

 
The “Print Setup” dialog has two tabs: layout and data. The layout tab, shown above in Figure 
C-8, provides options to select the printer, printed page range, orientation, layout, line spacing, 
and header and footer spacing and text. 
 

 
FIGURE C-9. Print Setup Dialog Box – Data Tab 

 
The data tab, shown above in Figure C-9, lists the fields that will be printed, along with options 
to change their appearance. 
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Users can click on any of the first three columns to change the font, style, and size of the text as 
shown below in Figure C-10. The following dialog box will be displayed when one of the 
options is clicked. Users then select the required font, style, and size in the dialog and click 
“OK.” The fields will reflect the new changes. 
 

 
FIGURE C-10. Font Dialog Box 

 
The main “Print Setup” window has additional options for users to customize the data printout. 
These options are explained below.  
 

1. Color: Changes the text color of the data in selected column 
2. Width: Columns are adjusted to a default width based on their length in the printout. 

The “Width” field allows users to enter a custom width length in inches 
3. Skip: Select a column to hide or show in the printout 
4. Char: Shows the character length of the field 

5.    The buttons on the right of the screen allow users to change the order of the 
fields that will be on the printout 

6. Preview: Displays a mockup with the changes applied 
7. Print: Print and close the “Print Setup” window 
8. Close: Closes the “Print Setup” window without making any changes 

 
3.3 Print  
 
This command under the “File” menu is used for printing a table, chart or a grid. 
 
3.4 Preference 
 
This option is used to set the default options for ODOTPMIS as shown in Figure C-11. The 
presence or absence of a checkmark next to an option indicates its state. 
 
Startup options appear when the application is opened. These are explained below. 
 

1. Show Splash Window: Displays a window showing application information when 
ODOTPMIS is opened. 

2. Load Last Database: Loads the last database opened on ODOTPMIS startup.   
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Exit options appear when the application is closed. These are explained below. 
 

1. Confirm Exit: Displays a warning confirmation window when users attempt to close 
the application. 

2. Compact Database Before Exit: Compacts the database before each close. 
3. Save Database Path: Saves the current database path to allow users to open the same 

database without reentering the location the next time it is opened. 
 

 
FIGURE C-11. Preference Setup Interface 

 
 
3.5 Compact and Repair Database 
 
The “Compact and Repair Database” command activates a utility that compresses the database, 
which increases the analysis speed.  This command should be performed regularly to ensure 
optimal performance.  WARNING: If the database is allowed to reach its maximum size of 
two gigabytes, none of the PMIS functions will function. Furthermore, at two gigabytes, the 
database cannot be used for executing queries. To prevent or alleviate these problems, compact 
the database regularly. 
 
3.6 Close PMIS 
 
This option is used to exit from the PMIS application. 
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Edit Menu 
 
The “Edit” menu contains commands for changing, creating, and deleting tables and queries. 
This menu will affect whichever data type is displayed in the object browser, either a query or 
table.  The commands included on this menu are “Open,” “Design,” “Delete,” and “New.” The 
following figure shows the drop down menu 
 

 
FIGURE C-12. ODOTPMIS Edit Menu 

 
4.1 Open 
 
This option opens a table for editing values. To open a table, highlight a table in the object 
browser and select “Open” in the edit menu. 
 
4.2 Design 
 
The “Design” command allows for the creation and deletion of columns in tables or 
modification of the SQL in queries. To modify a table or query, select it in the object browser 
and in the “Edit” menu, choose “Design.”  

 
FIGURE C-13. ODOTPMIS Design Menu 
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To add, click on the “Add Field” radio button in the lower left corner of the window. To delete, 
select the field and click the “Delete” button in the lower left corner of the window. To modify, 
select the field. ODOTPMIS will allow users to make the changes directly in the table. 
 
4.3 Delete 
 
This command deletes the selected table or query from the database. 
 
4.4 New  
 
Creating a New Table: 

1. Click “New” in the “Edit” menu 
2. The dialog box as shown in Figure C-14 will appear 
3. Enter the desired table name in the dialog and click “Create” 
4. This will display the “Design Table Dialog” shown in Figure C-15. Users can add or 

delete fields, and set field properties like the field name, data type, and size, as well as 
toggle whether this field is required and whether a zero length is allowed 

 

 
FIGURE C-14. New Table Name Input Interface 

 
FIGURE C-15. New Table Name Input Interface 
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Creating a New Query: 
 

1. Select “Queries” in the sidebar of the object browser 
2. Click “New” in the “Edit” menu 
3. A dialog box as shown in Figure C-16 will be displayed 
4. Enter a name for the query in the “Query Name” text box 
5. Type in a query. The typed query must follow the standard syntax as Access SQL 
6. Close the dialog to auto-save 

 

 
FIGURE C-16. Query Edit Interface 

 
Modifying an Existing Query 
 

1. Select a query in the object browser 
2. In the “Edit” menu, click “Design” 
3. A similar dialog box as above will appear displaying the selected query 
4. Change the query and close the dialog box to auto-save 
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View Menu 
 

The “View” menu contains commands for ensuring that the toolbars and the object browser are 
updated and visible.  The commands include “Show Toolbar,” “Show Object Browser,” and 
“Refresh Object Browser.”  
 

 
FIGURE C-17. ODOTPMIS View Menu 

 
5.1 Show Object Browser (Shortcut Key: CTRL+O) 
 
This option is used to show the object browser. The presence of a check mark next to its name 
in the “View” menu indicates that the object browser will be displayed in the main 
ODOTPMIS window. 
 

 
FIGURE C-18. Show Object Browser 

 
The object browser displays a list of the tables and queries in the current database. The object 
browser contains two filters: 
 

1. Tables: Displays a list of all the tables in the database 
2. Queries: Displays a list of all the queries in the database 
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5.2 Show Toolbar (Shortcut Key: CTRL+T) 
 
This option is used to show or hide the toolbar, which contains the following buttons:  
 

 Print 

 Print Preview 

 Delete Table or Query 

 New 

 New 

 
Sort the records of a table in ascending order for selected column (this 
button appears only when a table is opened) 

 
Sorts the records of a table in descending order for selected column (this 
button appears only when a table is opened) 

 Linear Superposition* 

 Project History Plot* 

 Project History 

 Statistical Report* 

 Map View of a Table* 
*See Part IV: Advanced Features 

FIGURE C-19. Tool Bar Options 
 
 
5.3 Refresh Object Browser (Shortcut Key: F5) 
 
This option is used to refresh the object browser to display updated information. 
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Data Menu 
 
The “Data” menu contains functions that add or modify tables needed for the successful 
operation of PMIS.   
 

 
FIGURE C-20. ODOTPMIS Data Menu 

 
 
6.1 Import Road Inventory Data  
 
This tool allows users to update the road inventory table with new data from text files. Road 
inventory tables include the following information: road geometry, classification, priority, 
system, and traffic volume. These tables should be updated every year. The name of this table 
in ODOTPMIS is DATA_Road Inventory. 

 

Table to Apply: [DATA_Road Inventory] 
Data file type: Fixed column position text file 
Data format: 
[Value 1][Value 2] [Value 3] [Value 4] … [Value 55] 
[Value 1][Value 2] [Value 3] [Value 4] … [Value 55] 
[Value 1][Value 2] [Value 3] [Value 4] … [Value 55] 
… 
   

To import data, click on the “Data” menu and select “Import Road Inventory Data.” The 
window shown in Figure C-21 will appear. Select the drive on which the file is stored using the 
“Drives” drop down menu, or use the “Network” button to select a network drive. Navigate to 
the directory of the data files using the “Folders” sub-window and use the “File name” sub-
window to select the correct text file. Click “OK.” 
 
Users may or may not check the “Read only” box to prevent changes to the data, depending on 
their uses for this specific table. 
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FIGURE C-21 Import Road Inventory Data 

 
Note: Field values must be in the order specified in following table. 

 
 

TABLE C-2. Field Order, Name and Data Format 

Order Field Name Data 
Type 

Column 
Position Example 

1 Jurisdiction Text 1 S 
2 County Text 2-4 ADA 
3 Route Text 5-7 032 
4 Route Suffix Text 8 R 
5 Blog Text 10-13 0000 
6 Log Point Suffix Text 14 Space 
7 Road Identification Text 15 D 
8 Data Type Integer 16-19 PSTB 
9 Data Status Text 20 E 
10 Transaction Number 21 A 
11 Inventory Perpetuation Date Number 22-25 0100 
12 FIPS Code Number 27-29 Space 
13 Mile Class Byte 31 1 
14 Section Length Text 32-35 0035 
15 System Class Text 36 M 
16 Standard Surface Classification Text 38 G 
17 Standard Base Classification Text 39 L 
18 Summary FHWA Surface Type Text 40-41 I 
19 Surface Width Number 42-43 48 
20 Summary Roadway Width Number 44-45 64 
21 Population (100's) Number 46-49 0 
22 Left Side Standard Surface Class Text 50 G 
23 Left Side Standard Base Class Text 51 L 
24 Left Side FHWA Surface Type Text 52-53 I 
25 Left Side Surface Width Number 54-55 24 
26 Median Width Number 56-57 60 
27 Right Side Standard Surface Class Text 58 G 
28 Right Side Standard Base Class Text 59 L 
29 Right Side FHWA Surface Type Text 60-61 I 
30 Right Side Surface Width Number 62-63 24 
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31 Year in Inventory Number 64-65 96 

32 Federal-Aid Primary (FAP) 
Number Number 66-69 0009 

33 National Highway System (NHS) Text 70 S 
34 System  Text 71 SR 

35 Highway Performance Monitoring 
System Text 72  

36 Maintenance Route Type Number 73-74 20 
37 Population (over/Under 5000) Number 75  
38 Municipality Name Text 76-91  
39 Divided Highway Indicator Text 92 * 
40 Access Control Text 93 L 
41 Lanes Number 94 4 
42 District Number 95-96 09 
43 Number of Lanes (two character) Number 97-98  
44 Station Equation Sort Field Number 99 1 
45 Elog Number 100-103 0035 
46 Priority Text 104 P 
47 Area Code Number 105-107 000 
48 Functional Class Number 108-109 02 
49 Car ADT Number 111-116 4790 
50 Truck ADT Number 117-122 1370 
51 Total ADT Number 123-128 6160 
52 ADT - Year of counts Number 129-130 92 
53 ESALx1000 Number 133-137 230 
54 Year Number 138-141 2000 
55 NLFID Text 142-155 SADASR00032**C 

 
 
 
A typical road inventory text file will exhibit the data structure shown in Figure C-22. 
 

 
FIGURE C-22 Snapshot of Road Inventory File 

 
 
6.2 Data_Project History 
 
The [Data_Project History] sub-menu contains tools that update the Data_Project History 
table. The tools available under this menu are Project History Menu, Populate Structural 
Number Added, Populate Modified Activity Code, and Calculate Thickness Added. 
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6.2.1 Project History Entry 
 
Projects performed on pavement each year are recorded in the DATA_Project History table. 
This table can be updated by selecting “Project History Entry” under the “Project History 
Menu.” This will launch the data entry form shown in Figure C-23 for users to view, edit, and 
input the data to be displayed in the DATA_Project History table.  
 

Table to Apply:   [DATA_Project History] 
Data type and format:  User input 

 

 
FIGURE C-23. Project History Entry 
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There are several options provided on the form for browsing, updating and deleting the records. 
These are as follows: 
 

  Record navigator 

 Add a new blank record 

 Copy the current record as a new record 

 Restore the current record to its original status 

 Update current record and make all changes permanent 

 Delete current record. The deleted record cannot be restored. 

 Close this tool 
 

Comments: 

Until the user leaves the input window,  button can be used to restore the current record 
to its original status and discard any changes. To permanently update the current record, 

 button must be clicked. To delete the current record, user can use  button. If a 
record is deleted, it cannot be restored. You can also locate a record by using the “Record 
Locator” search tool or the “Entry No.” box. Any field not having a specific input box will 
appear in the “Extra Parameters” list. This means the user can input more fields into table 
[DATA_Project History]. However, the total number of fields in any table is limited to 256. 
 
6.2.2 Populate Structural Number Added 
 
This tool calculates the “Structural Number” of every entry in the DATA_Project History table 
and adds a new field [SN_Add]. The “Structural Number” is calculated according to the 
definitions in the table [LU_Structural Number]. 
 
6.2.3 Populate Modified Activity Code 
 
This tool determines the “Modified Activity Code” for every entry in the DATA_Project 
History table. “Modified Activity Code” differs from “Activity Code” only in that it 
distinguishes between “Thin” and “Thick” overlays. If the thickness added of 50 or 60 is less 
than or equal to 2 inches, its “Modified Activity Code” becomes 41 or 42 correspondingly. This 
tool facilitates the analysis of thin and thick overlays. 
 
6.2.4 Calculate Thickness Added 
 
This tool calculates the “Total Thickness Added” and stores the result DATA_Project History 
table. A pavement can contain different layers. The thickness of each added layer is stored 
separately in the table. Sometimes it is useful to know the total thickness added to a pavement 
in a project. This tool calculates the total thickness added and stores the result in DATA_Project 
History table. 
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6.3 Data_ODOT 
 
The Data_ODOT sub-menu contains tools that update the Data_ODOT table. The tools 
available under this menu are Import Pavement Condition Data, Calculate PCR and Deducts, 
and Calculate PQI. 
 
6.3.1 Import Pavement Condition Data 
 
This tool allows for updating of the DATA_ODOT table. In ODOTPMIS, pavement condition 
data such as PCR, RN, IRI, PSI, etc. are stored in DATA_ODOT table.  This table also stores all 
road classification and distress data. This pavement condition data should be updated annually.  
To import condition data correctly, the source data file must have the required format. 
 

Table to Apply: [DATA_ODOT] 
Data file type: Coma delimited text file 
Data format: 

Value 1,Value 2,Value 3,Value 4,… 
Value 1,Value 2,Value 3,Value 4, … 
Value 1,Value 2,Value 3,Value 4,… 

 
To import data, click on the “Data” menu and select “Import Pavement Condition Data.” The 
window shown in Figure C-24 will appear. Select the drive on which the file is stored using the 
“Drives” drop down menu, or use the “Network” button to select a network drive. Navigate to 
the directory of the data files using the “Folders” sub-window and use the “File name” sub-
window to select the correct text file. Click “OK.”  Checking the “Read only” box will prevent 
any changes to the data. 

 

 
FIGURE C-24. Import Pavement Condition Data 
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Note: Field values must be in the order specified in Table C-3. 

 
 

TABLE C-3. Field Order, Name and Data Format 
Order Field Name Data Type Example 

1 NLFID Text SDARUS00036**C 
2 District Byte 7 
3 County Text DAR 
4 Route Text 036R 
5 Station Text UP 
6 Blog Single 13.41 
7 Elog Single 13.43 
8 Year Integer 1996 
9 Priority Text G 

10 PCR Byte 97 
11 TDC Single 3 
12 STRD Single 0 
13 Pavement Type Byte 3 
14 Project Number Text 22871 

15-39 Code 1 – Code 25 Text Code 1 = LE 
40 Rater 1 Text RS 
41 Rater 2 Text  
42 Divided - RI Text  
43 Divided - PCR Text U 
44 Mile Class Text 1 
45 Urban Area Code Integer 735 
46 Functional Class Integer 14 
47 NHS Field Text  

48 National Highway 
System (NHS) Text  

49 Route Type Byte 2 
50 MPC Byte 6 
51 Access Control Text N 
52 Lanes Byte 2 
53 Surface Type Text I 
54 Surface Width Byte 24 
55 Sum Road Width Byte 44 
56 Truck ADT Long Integer 760 
57 Total ADT Long Integer 6210 
58 ESALX1000 Long Integer 288 
59 PSI Single 3.69 
60 LIRI Integer  
61 RIRI Integer  
62 HCS Integer  
63 RN Single  
64 PCR Date Date 6/10/1996 
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A typical pavement condition text file exhibits the data structure shown in Figure C-25. 
 

 
FIGURE C-25. Snapshot of Pavement Condition File 

 
6.3.2 Calculate PCR and Deducts 
 
This tool calculates the “PCR,” “Structural Deduct,” “Cracking Deduct,” and “Rutting Deduct” 
as well as individual deducts. The original pavement condition data contains “PCR,” “Distress” 
ratings, “TDC” (Total Deduct), “STRD” (Structural Deduct), and “CRD” (Cracking Deduct). 
However, individual distress deducts are not provided. This tool enables a user to calculate all 
necessary fields for future analysis. In fact, any table with distress information can be used with 
this tool. However, its main purpose is to populate DATA_ODOT table.  
 
Figure C-26 shows the tool interface. Select the table in the “Tables” list box. Check the 
required deducts to be calculated fields in the “Options” frame, and select the year for which 
the PCR and deducts needs to be calculated. Click “Calculate” to fill the selected table with the 
selected fields. 
 

 
FIGURE C-26. Calculate PCR and Deducts 
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6.3.3 Calculate PQI 
 
This tool is used to calculate the Pavement Quality Index (PQI). PQI represents a combination 
of PCR and IRI (average of LIRI and RIRI). PQI is calculated by Equation C-(1). 
 
 bIRIaPCRPQI ×−= ,      C-(1) 

Where a and b  are read from LU_PQIParameters table. 
 
 
6.4 Apparent Projects Determination 
 
Note: This tool must be run before using the “Generating Performance Base Table” and 
“Generate Performance Analysis Table” functions. 
 
This tool creates a new table called DATA_Project History_Apparent in the database that is 
similar to DATA_Project History. However, this table contains extra fields such as “App Blog,” 
“App Elog,” and “App Year” which are determined from matching PCR jumps with treatments. 
This tool also creates 999’s and 995’s if it finds a PCR jump of greater than or equal to 6, but 
does not find a corresponding matching treatment. DATA_PERF_BASE and 
DATA_PERF_ANALYSIS are generated based on this table. 
 
6.5 Generate Performance Base Table 
 
This tool generates the DATA_PERF_BASE table. The DATA_PERF_BASE table is the base of 
most analysis functions and should be generated before DATA_PERF_ANALYSIS. Note: It is 
recommended to perform a database compacting operation before and after using this function. 
 
6.6 Generate Performance Analysis Table 
 
This tool generates the DATA_PERF_ANALYSIS table from the DATA_PERF_BASE table. 
Most of the analysis tools in ODOTPMIS use this table. Note: It is recommended to perform a 
database compacting operation before and after using this function. 
 
6.7 Generate Cost Lookup Table 
 
To perform an “Average Cost” analysis of projects, a lookup table LU_COST is required to 
begin analysis. This tool is used to generate the LU_COST table. 
 
6.8 Populate Performance Base Table 
 
The “Populate Performance Base Table” function opens a window to display variances of user 
specified attributes in DATA_ODOT over time with respect to specified values of 
DATA_Project History.  
This tool replaces the “Key” and “Entry” numbers in the DATA_PERF_BASE table. The keys 
are replaced with the selected values in the “DATA_ODOT” list box and entries are replaced 
with selected parameter values in “DATA_Project History” list box. 
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Note: The resultant table cannot exceed 256 columns in width.  Thus, if many parameters are 
desired, the number of years selected should be decreased or conversely, if many years are 
selected, the number of parameters may need to be reduced. 

 

Source Table: DATA_PERF_BASE, DATA_Project History_Apparent, DATA_ODOT 
Output Table: The default name is Result_Base.  However, the user can assign a different 
table name by changing the text in the “Output Table Name” textbox. 
 

 
FIGURE C-27. Populate Performance Base Table 

 
6.9 Populate Performance Analysis Table 
 
The “Populate Performance Analysis Table” tool determines the changes of selected 
DATA_ODOT values between consecutive projects on the same pavement section with respect 
to data in DATA_Project History_Apparent.  
 
This tool replaces the key and entry numbers in the DATA_PERF_ANALYSIS table with the 
selected values. The Fields Corresponding to Entry-1, Entry and Entry2 List boxes are used to 
select fields from DATA_Project History_Apparent table and Fields Corresponding to Key List 
box is used to select fields from DATA_ODOT table. Like the Populate Performance Base 
Table tool, the resultant table can support a maximum of 256 columns of data.   
 

Source Table: DATA_PERF_ANALYSIS, DATA_Project History, DATA_ODOT 
Output Table: The default name is Result_Analysis.  However the user can assign a 
different table name by changing the text in the “Output Table Name” textbox. 
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FIGURE C-28. Populate Performance Analysis Table 

 
6.10 Populate District Field 
 
This tool is used to populate the district field in a table, provided the selected table contains a 
“County” field. 
 
6.11 Import Planned Projects 
 
This tool allows the importing of a work plan into ODOTPMIS. Generally, the work plan file 
contains the planned treatments for the future, project cost, and location information. The 
imported file is stored in DATA_FutureProjects. Each time this tool is used to import a new 
work plan, the previous existing work plan in ODOTPMIS is overwritten. To import condition 
data correctly, the source data file must have the required format. 

 
Stored Table: DATA_FutureProjects 
Data file type: Microsoft Excel File 
Data format: Shown in Table C-4. 
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In the work plan file, certain columns can be left empty if they do not contain data. However, 
the necessary fields (bolded) “PID,” “NLF ID,” “County Begin Number,” “County End 
Number,” and “Pavement Treatment Type” should contain values. 
 

TABLE C-4. Work Plan File Format 
Order Field Name Example 

1 PID 21052 
2 SUM Adjusted Total Amt 8300000 
3 Sale Amount   
4 District   
5 Project Name (ie CRS)   
6 Primary Work Category   
7 Award Date Current   
8 Award Date Actual   
9 Requested STIP Yr 2009 

10 NLF ID SLUCSR00002**C 
11 County Begin Number 30.23 
12 County End Number 30.8 
13 Actual Priority Miles 0 
14 Actual Urban Miles 0 
15 Actual General Miles 1.14 
16 MAX Pvmt Treat Category Cd   
17 Pavement Treatment Type 60 - AC Overlay with Repairs 

 
 
6.12 Generic Classification Tool  
 
This tool, shown in Figure C-29, is used to classify numerical fields in a table. If the original 
field name in the table is [fieldname], a new field called [fieldname classification] will be 
added to the table. 
 
If the table selected is [DATA_PERF_ANALYSIS], this field will automatically show in the 
“Group By” list box provided on most of the analysis tools, such as “Average Deterioration 
Trend,” “Time To Treatment (Actual),” “Time To Treatment Survival Analysis” and “Derived 
Performance Trend.” 
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FIGURE C-29. Generic Classification Tool 

 

Value Range Reference Options 
Lowest:  Lowest value of the parameter 
Average:  Average value of the parameter 
Highest:  Highest value of the parameter 

 
Classifications Options 
 
Number of Categories : Number of categories to classify the selected “Fields” 
Apply Change (button): Enter number of categories in the “Number of Categories” text 

box and click this button to change the categories 
Lower Bound : Lower bound/limit of a category (This value cannot be changed.) 
Upper Bound : Upper bound/limit of a category (This value can be changed. The 

changed value becomes the lower bound of the next category.) 
Description : The description of each category. This description for each 

category of fields is stored as a new field in the table. 
 
 
 
 
Example: 
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The following example classifies AvgESAL in [DATA_PERF_ANALYSIS] into two 
categories: High, If ESAL ≥ 1500 and Low if ESAL < 1500.  

1. Open the “Generic Classification Tool” 
2. In the “Tables” list select “DATA_PERF_ANALYSIS” 
3. In the “Fields” list select “AvgEsal” 
4. Change the number of categories to 2 and click the “Apply Change” button 
5. Change the Upper bound of Category 1 to 1500 and change its description to “Low” 
6. Change the description of Category 2 to “High” 
7. Click the “Classify” button 
8. Close the tool and open the “Average Performance Trend” under the “Report” menu. 

“AvgEsal Classification” will be displayed in the “GroupBy” list.  
 
6.13 Linear Superposition 
 
The “Linear Superposition Operation” is a merge of multiple tables to obtain a single 
dynamically segmented table.  The output is stored in the “Output Table.”  If the output table 
named in the input box already exists, the tool will ask the user to replace the existing table or 
exit from the tool. Figure C-30 shows the user interface. 
 

 
FIGURE C-30. Linear Superposition User Interface 
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Commands 
Tables: Lists all the tables in the database 
Fields: Lists all the fields of the table selected under “Available Tables” 
Selected Fields: Lists all the selected fields from “Fields” 

 
The attributes listed in the “Fields” list box can be added to the query in three ways: 
 

1. Select a field in the “Fields” list and drag it into the “Selected Fields” list (a hand icon 
 will appear when dragging and dropping)  

2. Double click a field to be selected under “Fields” 

3. Select a field under “Fields” and click  
 
The “Selected Field” window also provides the option of constraining the records selected for 
merging.  The comparison field in the “Selected Field” window provides a drop down list of 
how the constraint is to be implemented (≥, ≤, >, <, or =).  The “Value” column specifies the 
desired value of the constraint. 
 
Matching Fields 
The “Matching Field” sub-window lists the fields required for merging.  The default selections 
are “County,” “Route,” and “Station,” as they typically specify a linear feature.  In some 
situations, “Year” may also be included.   
 

Adding Matching Fields 
 
Two techniques exist for adding additional selections into the “Matching Field” box. To 
remove a matching field, double click a field in the “Matching Fields” sub-window. 
 

1. Double click on field under “Selected Fields” 
2. Select a field under “Selected Fields” and drag it to the “Matching Fields” box 

 
The “Pull Out” option check boxes under “Options” limit the tables used to create internal 
program indices. Consequently, if DATA_Project History or DATA_ODOT is excluded in the 
analysis, its respective index should not be pulled out. 
 
The “Unique Route ID” window displays all unique linear features specified in the merge. Each 
button is assigned a specific operation and described below. 
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Example 1: 
 
The following example shows how to obtain the PCR History for Route 032R in Adams 
County. 
 

1. Select DATA_ODOT in the “Tables” list 
2. Select PCR in the “Fields” list, and double click it to include it in the “Selected Fields” 

list 
3. Under the “Fields” list, add “County” and “Route” 
4. In the “County” row, double click the “Value” column and enter “ADA” 
5. In the “Route” row, double click the “Value” column and enter “032R” 

6. Click the  button 
 
At this point, the “Linear Superposition” window should resemble Figure C-31. 

 

 
Add a selected field 

 
Add all fields from a table 

 
Remove a selected field 

 
Remove all the selected fields 

 
Run the linear superposition operation 

 
Stop the linear superposition operation 

 
Reset the values in the “Comparison” and 
“Value” columns of “Selected Fields” 
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FIGURE C-31. Get PCR Series for Route 032R in Adams County 

 
The result should resemble Figure C-32.  Note: Not all PCRs are displayed because of the size 
of the window. Scroll to reveal the hidden PCRs. 
 

 
FIGURE C-32. PCR Series for Route 032R in Adams County 

 
Example 2: 
 
To obtain the treatment history as well as the PCR history for Route 032R in Adams County, 
follow this procedure: 
 

1. Select DATA_Project History in the “Tables” list 
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2. Double click “Activity Code” in the “Fields” list to include it in the “Selected Fields” 
list 

3. Select DATA_ODOT in the “Tables” list 
4. Double click “PCR” in the “Fields” list to include it in the “Selected Fields” list 
5. Add “County” and “Route to the “Selected Fields” list 
6. In the “County” row, double click the “Value” column and enter “ADA” 
7. In the “Route” row, double click the “Value” column and enter “032R” 

8. Click the  button 
9. After above 8 operations, the interface looks like the following figure 

 
At this point, the “Linear Superposition” window should resemble Figure C-33. 

 

 
 

FIGURE C-33. Get PCR and Treatment History for Route 032R in Adams County 
 
The result should resemble Figure C-34.  Note: Not all PCRs are displayed because of the size 
of the window. Scroll to reveal the hidden PCRs. 
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FIGURE C-34. PCR and Treatment History for Route 032R in Adams County 
 
 
 
 
6.14 Clean Pavement Data Table 
 
This tool is used to remove redundancy in dynamically segmented tables. For example, the two 
records in Table C-5 represent consecutive sections in a road and are identical except for the 
“Blog” and “Elog” figures. Therefore, these two records can be merged. 
 

TABLE C-5. Original Data 
County Route Station Blog Elog Year PCR 

ADA 032R Down 2.33 2.84 2002 91 

ADA 032R Down 2.84 6.29 2002 91 

 

TABLE C-6. Data After Using Clean Pavement Data Table Function 
County Route Station Blog Elog Year PCR 

ADA 032R Down 2.33 6.29 2002 91 

 
 
6.15 Modify Activity Legend 
 
This tool is used to add new activity codes, modify activity legend colors for project history 
checking, and ensure data integrity between the activity code and the modified activity code.   
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FIGURE C-35. Modify Activity Legend 

 
To add a new activity code, click “Add.” This will add a new row at the end of the window 
(Figure C-36). Enter the required information including the “Code” (numerical), “Color,” 
“Activity,” “Class,” “SN Item,” and “Max Life.” Avoid entering duplicate data. 
 

 
FIGURE C-36. Add New Activity 

 
6.16 Edit Lookup Table 
 
This tool updates the lookup tables necessary for all analyses in ODOTPMIS. 

 
Table to Apply: [LU_XXXXX] 
Tool to use: [Data]  [Edit Lookup Table]  
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FIGURE C-37. Edit Lookup Table 

 
Users can add, modify, or delete a current record in a lookup table. However, the user cannot 
change the field name or add/delete a field from a lookup table.  
 

 Record navigator 

 Add a new blank record 

 Copy the current record as a new record 

 Restore the original record 

 Update and make all changes permanent 

 Delete current record. Deleted records cannot be restored. 

 Close this tool 
 
Example 1: 
 
In the current ODOT database, only ten distresses are defined for Continuous Reinforced 
Concrete pavement. To change distress information for distress code 11 for pavement type 1 
(Continuous Reinforced Concrete), 

1. Select “Edit Lookup Table” under the “Data” menu 
2. Select LU_Distress in the “Lookup Table” list 
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3. Go to “Pavement Type 1” and “Code 11” by using the  button in the record 
navigator.  The interface of the tool should resemble Figure C-38. 

4. Click the “Field Name” to be changed 
 

 
FIGURE C-38. LU_Distress Table 

 

Figure C-39 demonstrates the valid format of the data to be entered. 

                        
FIGURE C-39. Modifying LU_Distress 

 
5. After entering the changes, click “Update” 
6. The changes will be made in two tables: LU_Distress and LU_Deduct. ODOTPMIS 

uses LU_Deduct table to calculate “PCR,” “Structural Deduct,” “Cracking Deduct,” and 
individual deducts. 

Distress Weight (Valid Positive
Distress Name (Cannot be Null)

Distress Multipliers 
(Valid Positive Number) 

Distress is Cracking Distress if 
Distress is Structural Distress if true.

Severity and Extent  
Descriptions (Null 

Accepted)
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7. To restore old values, click “Restore.” This only works if the user clicks the “Restore” 
button before closing the tool, and only restores one record at a time. 

 



 

 C-41 

Analysis Tools Menu 
 
This menu contains functions that perform analyses comparing time to treatment, condition 
deterioration, pavement condition prediction, and remaining life estimation. 
 

 
FIGURE C-40. ODOTPMIS Analysis Tools Menu 

 
7.1 Exclude activity option 
 
Analysis tools such as “Time To Treatment (Actual),” “Time To Treatment Survival Analysis,” 
and “Derived Performance Trend” provide an option giving the user the ability to exclude 
certain activities from the analysis. For example, consider a pavement section with the 
treatment history as shown in Figure C-41.  
 

 
FIGURE C-41. Example for Exclude Activity 

 
This pavement section will not be included in the analysis if the “From Activity” is set to 50 
and the “To Activity” to 50 because this tells the program to search for projects that are 
Activity 50 (overlay without repairs) and immediately followed by another Activity 50. 
However, this pavement section is included in the analysis, if both the “From Activity” and “To 
Activity” are set to 50, and Activity 20 is selected in the “Exclude Activity” list box. 
 
7.2 Time To Treatment (Actual) 
 
This tool is used to determine the average time between types of treatments or the average time 
to a certain PCR threshold. 

 

Source Table: DATA_PERF_ANALYSIS 
Intermediate Table Generated: DATA_PERF_AVGLIFE 
Output Table: The default name for the output table is “Actual Time to Treatment 
Analysis.” Users can update this table name by changing the text in the “Output Table 
name” text box. 
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FIGURE C-42. Time to Treatment (Actual) 

 

Example 1: 
 
To generate the “Average Life of Overlay on Priority System Flexible Pavements,” select the 
following options on the tool: 
 

1. “All Systems” under “System” 
2. “All” under “Priority” 
3. “All Districts” under “District” 
4. “All Counties” under “County” 
5. “All Types” under “Pave Type” 
6. “All Directions” under “System” 
7. “1985” under “From Year,” and “2006” under “To Year” 
8. “Activity Code” under “Activity” list 
9. “50” and “60” under “From Activity” list, and “Add All” under “To Activity” list  
10. “By Mileage” under “Analysis Options” 

 
Enter an output table name in the “Output Table Name” text box and click “Calculate.” 
 



 

 C-43 

Figure C-43 shows the mileage of pavements that failed or received treatment in each time 
period. The average life of an overlay on priority systems, according to the calculations, is 7.6 
years.  

 
FIGURE C-43. Time to Treatment (Actual) Output for Flexible Overlays on Priority 

System 
 
7.3 Time To Treatment Survival Analysis 
 
This tool is used to calculate the time to the next treatment based on the Kaplan-Meier Survival 
Curve method. The advantage of Kaplan-Meier Survival Curve method is that it allows the 
inclusion of surviving pavement sections in the analysis. 
 

Source Table: DATA_PERF_ANALYSIS 
Intermediate Table Generated: DATA_PERF_REMLIFE 
Output Table: The default name for the output table is “Pavement Survival Life Analysis.” 
Users can update this table name by changing the text in the “Output Table name” text box. 
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FIGURE C-44. Time to Treatment Survival Analysis User Interface 

 
Analysis Options 
 

Include Open End Projects: Checking this option will include open-ended projects 
(projects or pavements still in existence) 

PCR Threshold: A pavement is considered failed if it undergoes treatment. Checking this 
option marks all pavements with PCR levels below the threshold as failed. 

 
Output Options 
 

Histogram: This option plots a histogram showing the number of censored and uncensored 
points for each section. 

 
Survival Analysis Output 

In certain scenarios including open ended projects, the survival curve will not reach zero 
percent surviving. This curve is called a stub survival curve. In the PMIS, a Weibull 
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survival function is used to complete the survival curve. The Weibull fit, along with the 
original survival curve, is shown in the output graph. 

 
Example 1: 
 
The following example shows the survival analysis of “Overlay on Priority System Flexible 
Pavements.” Select the following options on the tool: 
 

11. “All Systems” under “System” 
12. “All” under “Priority” 
13. “All Districts” under “District” 
14. “All Counties” under “County” 
15. “All Types” under “Pave Type” 
16. “All Directions” under “System” 
17. “1985” under “From Year,” and “2006” under “To Year” 
18. “Activity Code” under “Activity” list 
19. “50” and “60” under “From Activity” list, and “Add All” under “To Activity” list  
20. “By Mileage” under “Analysis Options” 

 
Enter an output table name in the “Output Table Name” text box and click “Calculate.” 
 
Figure C-45 shows the “Survival Curve (Raw Data),” the survival curve obtained using the raw 
data. It can be seen that this survival curve does not reach 0% probability, and any estimates 
using this curve are not reliable. Hence a “Survival Curve (Weibull Fit)” is fitted to the original 
curve. 
 

 
FIGURE C-45. Time to Treatment (Actual) Output for Overlays on Priority System 
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A histogram showing mileages of projects that have been repaired and still exist can also be 
generated by selecting “Histogram” under “Output Options.” Figure C-46 shows the mileage 
histogram for the survival curve in Figure C-45. 
 

 
FIGURE C-46. Time to Treatment Survival Curve Mileage Histogram 

 
7.4 Derived Performance Trend 
 
This tool analyzes the series of survival curves to determine the pavement condition 
deterioration of a group of user specified pavement repairs.  
 

Source Table: DATA_PERF_ANALYSIS, DATA_ODOT 
Intermediate Table Generated: DATA_PERF_ SURVIVAL 
Output Table: The default name for the output table is “Derived Performance.” The user 

can change this table name by updating the text in the “Output Table Name” text box. 
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FIGURE C-47. Derived Performance Trend 

 
Output Options 
 

Survival Curve: Display survival curves for PCR from 100 to 50. 
 
Example 1: 
 
The following example shows the Derived Performance Trend for District 3 General System 
Flexible Pavements with Overlays. Select the following options on the tool: 
  

1. “All Systems” under “System” 
2. “G” under “Priority” 
3. “All Districts” under “District” 
4. “All Counties” under “County” 
5. “All Types” under “Pave Type” 
6. “All Directions” under “System” 
7. “1985” under “From Year,” and “2006” under “To Year” 
8. “Activity Code” under “Activity” list 
9. “50” and “60” under “From Activity” list, and “Add All” under “To Activity” list  
10. “By Mileage” under “Analysis Options” 
11. Check “Survival Curve” under “Output Options” 
 

Enter an output table name in the “Output Table Name” text box and click “Calculate.” 
 
Figure C-48 shows the “Derived Performance Curve.” 
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FIGURE C-48. Derived Median Performance Curve For District 3 General System 

Flexible Pavements with Overlays 
 
This tool also generates the survival curves used for the “Derived Median Performance Curve” 
shown in the following figure. It can be seen that Weibull curves are used instead of stub 
survival curves. 
 

 
FIGURE C-49. PCR Survival Curves 
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7.5 Generate Markov predictions 
 
This menu can be used to predict the PCR and distress for every pavement section in the 
database based on Markov process. However, for certain groups of pavements, the Markov 
transition matrix cannot be generated since only a few pavement sections are available. In that 
case, simple linear extrapolation is used for predicting distress and PCR. 
 
The tools available under this menu are “Statewide Rigid Pavements,” “Statewide Flexible 
Pavements,” “Statewide Composite Pavements,” “Individual Pavement Prediction,” and 
“Selected Predictions.” 
 
The transition matrix table DATA_TransitionMatrix is created when using the “Statewide Rigid 
Pavements,” “Statewide Flexible Pavements,” and “Statewide Composite Pavements” options. 
Note: It is recommended that the user not delete this table, since it is used in the “Individual 
Pavement Prediction” and “Show Pavement Prediction” tools.  
 
7.5.1 Statewide Rigid Pavements 
 
This option generates statewide rigid pavement PCR and distress predictions for the next 
twenty years. Four tables will be generated. Note: It is recommended that the user not delete 
these tables unless new pavement condition data and/or project data are added in the database. 
 
The tables created are: DATA_PredictedPCR_JRC, DATA_PredictedDistress_JRC, 
DATA_PredictedPCR_CRC, and DATA_PredictedDistress_CRC. 
 
7.5.2 Statewide Flexible Pavements 
 
This option generates statewide flexible pavement PCR and distress predictions for the next 
twenty years. Two tables will be generated. It is recommended that the user not delete these 
tables unless new pavement condition data and/or project data are added in the database. 
 
The tables created are: DATA_PredictedPCR_Flex, DATA_PredictedDistress_Flex. 
 
7.5.3 Statewide Composite Pavements 
 
This option generates statewide composite pavement PCR and distress predictions for the next 
twenty years. Two tables will be generated. It is recommended that the user not delete these 
tables unless new pavement condition data and/or project data are added in the database. 
 
The tables created are: DATA_PredictedPCR_Comp, DATA_PredictedDistress_Comp. 
 
7.5.4 Individual Pavement Prediction 
 
This tool can be used to view the predicted PCR of an individual pavement section. Markov 
prediction is combined with Monte-Carlo simulation to generate the PCR predictions and 
confidence intervals. The user has the ability to choose between various confidence intervals. 
Figure C-50 shows the user interface. 
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Source Table: DATA_Transition Matrix 
Output Table: The default name for the output table is “Pavement Section Prediction.” 

Users can update this table name by changing the text in the “Output Table name” text 
box. 

 

 
FIGURE C-50. Individual Pavement Section Prediction 

 
Example 1: 
To view the predicted PCR for Allen County, Route 030R Up Direction, for the next twenty 
years with an 80% confidence limit, select following options: 

 
1. “All” under “County” 
2. “030R” under “Route” 
3. “UP” under “Station” 
4. “80” under “Confidence Limits” 
5. “20” under “Prediction Years” 

 
Enter an output table name in the “Output Table” text box and click “Execute.” 
 
Figure C-51 shows the output grid which displays the results.  
 



 

 C-51 

 
FIGURE C-51. PCR Prediction Grid 

 
Click on any part of the grid to generate a PCR prediction plot that shows the confidence limits 
as shown in Figure C-52. 
 

 
FIGURE C-52. PCR Prediction Confidence Limits 

 
7.5.5 Selected Predictions 
 
This tool has the same functionality as the Markov prediction tool, but is designed for more 
advanced users to select pavement families for transition matrices. 
 
7.6 Show Predicted Pavement Conditions 
 
This tool can be used to view the Markov predicted pavement conditions. Figure C-53 shows 
the user interface to view the predicted conditions. 
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Source Table: DATA_Transition Matrix,  
DATA_PredictedPCR_JRC, DATA_PredictedDistress_JRC, 
DATA_PredictedPCR_CRC, DATA_PredictedDistress_CRC, 
DATA_PredictedPCR_Flex, DATA_PredictedDistress_Flex, 
DATA_PredictedPCR_Comp, DATA_PredictedDistress_Comp, and  
DATA_FutureProjects 

 
Output Table: The default name for the output table is “PavementCondition_WithPlan.” Users 

can update this table name by changing the text in the “Output Table name” text box. 
 

 
FIGURE C-53. View Predicted Pavement Condition 

 
Work Plan Options 
 

Without Work Plan: Analysis based on original PCR and distress predictions 
With Work Plan: Analysis based on result from overlay of PCR and distress predictions 

with DATA_FutureProjects file 
 
Output Options 
 

Start Year: Start year of the analysis 
Forecast Upto: End year of the analysis 
 

Example 1: 
 
To view pavement conditions with the plan for District 3, select the following options: 
 

1. “3” under “District” 
2. “With Work Plan” under “Work Plan Options” 
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3. “2001” under “Start Year” 
4. “2010” under “Forecast Upto 
 

Enter an output table name in the “Output Table Name” text box and click “Execute.” 
 

This procedure generates two grids: (1) “view pavement condition with planned treatments,” 
which displays the predicted PCR overlaid with planned treatments and (2) “view pavement 
condition with planned treatments – recommended treatments,” which displays the 
recommended treatments from the current year until 2010. 
 

 
FIGURE C-54. View Pavement Condition with Planned Treatments 

 
Users can right click the above PCR grid and select “Generate PCR Summary” to generate a 
“PCR Summary” chart as shown in Figure C-55. 

 
FIGURE C-55. PCR Summary 

 
The second grid with recommended treatments is shown in Figure C-56. 
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FIGURE C-56. View Pavement Condition with Planned Treatments – Recommended 

Treatments 
 
Users can right click the above grid and select “Generate Cost Summary” to generate a “Cost 
Summary” chart as shown in Figure C-57. 
 

 
FIGURE C-57. Cost Summary 

 
7.7 Estimate remaining life 
 
This tool can be used to estimate the remaining life of pavement sections based on certain PCR 
and/or distress thresholds. Figure C-58 shows the user interface to view the predicted 
conditions. 
 

Source Table: DATA_PredictedPCR_JRC, DATA_PredictedDistress_JRC, 
DATA_PredictedPCR_CRC, DATA_PredictedDistress_CRC, 
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DATA_PredictedPCR_Flex, DATA_PredictedDistress_Flex, 
DATA_PredictedPCR_Comp, DATA_PredictedDistress_Comp. 

Output Table: The default name for the output table is “Remaining Life.” Users can 
update this table name by changing the text in the “Output Table name” text box. 

 

 
FIGURE C-58. Estimate Remaining Life 

 
Rem. Life PCR Threshold 
 

Enter PCR thresholds in the text boxes. The remaining life is calculated by the time until 
the current PCR reaches the specified PCR threshold. 
 

Use Distress Criteria 
 

Check this option and click “Edit Criteria” to display the window shown in Figure C-59. 
Users can then enter thresholds for individual distresses. The remaining life is calculated 
using both the PCR and distress thresholds, whichever occurs first.  
 

Graph Options 
 

Miles: Analysis will be based on the directional miles 
Sections: Analysis will be based on the number of pavement sections 
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FIGURE C-59. Distress Thresholds 

 
Example 1: 
 
To view the remaining life for “General System Pavements” from 2007 based on a PCR 
threshold of 55, select the following options: 
 

1. “G” under “Priority” 
2. “2007” under “Rem Life From Year” 
3. “55” in the “General” text box under “Rem. Life PCR Threshold” 
 

Enter an output table name in the “Output Table Name” text box and click “Execute.” 
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FIGURE C-60. Remaining Life on General Systems 

 
7.8 Histogram 
 
This tool is used to generate a histogram for a selected field in a table. 
 

 
FIGURE C-61. Histogram Tool 

 
Data Source  

Table/Query: Table or query from which a field is selected to generate histogram 
Statistical Field: Field from the selected table  
Weight field: sum of selected field in each category of statistical field 
Number of Category: Number of categories for histogram 
Use (Elog-Blog): Total mileage under each category. 

 
Example 1: 
 

Figure C-62 shows the histogram for PCR, weighted by mileage from DATA_ODOT.  This 
is generated by selecting “DATA_ODOT” in “Table/Query,” “PCR” in “Statistical Field,” 
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“None” in “Weight Field,” “5” in “Number of Category,” and enabling “Use (Elog-Blog) 
As Weight.” 

 
FIGURE C-62. Example of a PCR Histogram Tool 
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Report Menu 
 
This menu contains tools to generate reports of the database.  
 

 
 

FIGURE C-63. ODOTPMIS Report Menu 
 
 
8.1 Average Performance Trend 
 
This tool generates an average performance report for parameters from DATA_ODOT. 

 
Source Table: DATA_PERF_ANALYSIS, DATA_ODOT 
Intermediate Table Generated: DATA_PERF_CURVE 
Output Table: The default name for the output table is “Average Deterioration Trend 
Analysis.” Users can update this table name by changing the text in the “Output Table 
name” text box. 
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FIGURE C-64. Average Deterioration Trend User Interface 

 
Analysis Options 
 

Include Open End Projects: Enabling this option will include open-ended projects 
(projects/pavements which still exist) 

Change Curve: Enabling this option will generate a graph based on the rate of 
deterioration. 

 
Output Options 
 

Show Average: Enabling this option calculates and displays an average category based on 
the current categories displayed on the chart. For example, if the average deteriorations of 
Districts 1 and 3 are displayed, checking this option will display an additional category that 
is the average of deterioration trends on Districts 1 and 3. 
 

Example: 

The following example shows the average deterioration trend report for PCR and RN for all 
systems, priorities, pavement types and counties in district 1 for Activity codes 50 and 60 
and from 1985 to 2006. Select following options on the tool: 
 

1. “All Systems” under “System” 
2. “All” under “Priority” 
3. “1” under “District” 
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4. “All Counties” under “County” 
5. “All Types” under “Pave Type” 
6. “All Directions” under “System” 
7. “1985” under “From Year,” and “2006” under “To Year” 
8. “Activity Code” under “Activity” list 
9. “PCR” and “RN” under “Parameters” 
10. “50” and “60” under “From Activity” list, and “Add All” under “To Activity” list  

 
Enter an output table name in the “Output Table Name” text box and click “Execute.” 
 
Figure C-65 shows the average deterioration trends for PCR and RN. 
 

 
FIGURE C-65. Performance Trend Curve 

 
This tool also generates a mileage chart as shown in Figure C-66. 
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FIGURE C-66. Performance Curve Mileage 

 
Figure C-67 is generated when the “Change Curve” option is checked in “Analysis Options” 
and shows the change curve for “PCR” and “RN.” The change curve values are obtained by 
taking the difference of two consecutive average deterioration values. It represents the rate of 
deterioration. 
 

 
FIGURE C-67. Change Curve 

 



 

 C-63 

8.2 Rehabilitation Candidates 
 
This menu is used to generate a rehabilitation candidate list based on the treatment decision 
trees provided by ODOT. The tools available under this menu are “Generate Statewide Rehab 
List,” “Generate U/G Rehab List,” “Generate Priority Rehab List,” “Priority System Major 
Rehab List,” and “Modify Repair Logic.” For all the tools under this menu, the following tables 
are used in the background: 
 

Source Tables: DATA_ODOT, DATA_Project History_Apparent, DATA_PERF_BASE, 
LU_Repair Logic, LU_Repair Limits 

 
8.2.1 Generate Statewide Rehab List 
 
This tool generates the recommended treatments for all the pavement sections in the database 
for the latest available PCR. The user interface is shown in Figure C-68. The output is stored in 
the table name given in the “Output Table” text box. In addition to this output table, this tool 
also generates a bin summary table that contains the directional miles that fall under each bin 
category. If the output table name is [table name], the bin summary table created will be named 
 [table name_Bin Summary]. 
 

 
FIGURE C-68. Rehab Candidates 

 
 
8.2.2 General U/G Rehab List 
 
This tool generates the recommended treatments (bin’s) list only for pavement sections on 
urban and general systems. The user interface is similar to above in Figure C-68, however, in 
the “Priority” combo box, the default value is “U/G.” 
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8.2.3 General Priority Rehab List 
 
This tool generates the recommended treatments (bin’s) list only for pavement sections on 
urban and general systems. The user interface is similar to Figure C-68, however the “Priority” 
combo box is defaulted to “P.” 
 
8.2.4 Priority System Major Rehab List 
 
This tool generates the candidate sections eligible for major rehab on priority systems based on 
the decision tree provided by ODOT. The user interface is shown in Figure C-69. The decision 
tree and repair logic are also shown in the user interface. 
 

 
FIGURE C-69. Priority System Major Rehab List 

 
Include Treatments for Treatments Check 

This option allows the user to select the treatments that will be included in the “# of 
treatments” check in the decision tree. 
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Merge Continuous Sections Options 
 These options allow the user to control how continuous sections are merged. The options 

provided are 
 

Default: Two continuous sections are merged into a single record by considering the 
“Minimum PCR,” “Maximum Total ADT,” and “Truck ADT” between the sections, 
provided the remaining fields are equal 
 
All Equal: Two continuous sections are merged into a single record if all the fields are 
equal 
 
All Min: Two continuous sections are merged into a single record by considering the 
“Minimum of PCR,” “Total ADT,” and “Truck ADT” between the sections provided 
the remaining fields are equal 
 
All Max: Two continuous sections are merged into a single record by considering the 
“Maximum of PCR,” “Total ADT,” and “Truck ADT” between the sections provided 
the remaining fields are equal 
 
All Avg: Two continuous sections are merged into a single record by considering the 
“Average of PCR,” “Total ADT,” and “Truck ADT” between the sections provided the 
remaining fields are equal 

 
8.2.5 Modify Rehab Logic 
 
This tool enables the user to change the decision tree and repair logic provided by ODOT. 
Figure C-70 shows the interface for modifying decision trees.  
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FIGURE C-70. Modify Decision Trees and Repair Logic 

 
To modify a decision tree, choose the category by clicking on the appropriate tab in the 
“Modify Priority/Urban/General Rehab Logic” sub-window. Text boxes are provided at various 
stages (for PCR, traffic, etc.). Enter new values in the text boxes and click “Apply” to modify 
the decision tree. 

 
To modify the repair logic (“Preventive Maintenance,” “Major,” “Minor,” and “Priority Major 
Rehab”), click “Miscellaneous Criteria.” Select the “Pavement Type,” “Preservation,” and 
“Priority System” in the “Record Locator” and click “Search.” The “Miscellaneous Criteria” 
tab provides options to change the “Functional Class,” “PCR Limits,” and “Traffic” as shown 
in Figure C-71. This is the basic procedure: 
 
Note: If the value for criteria is empty, it is not considered in the repair logic. 
 

1. Change the “Functional Class” in the “Functional Class” list 
2. Change the “PCR Limits” in the “PCR Lower Limit” and “PCR Upper Limit” text 

boxes 
3. Change the “Traffic Limits” in the “Total ADT” and “Truck ADT” text boxes 
4. Change the “Cracking Index Limit” in the “Max Cracking Index” text box 
5. For two lanes, apply the “Two-Lane Only” option 
6. Select appropriate distress levels for each code under “Allowable Distress” 
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7. Click “Apply” to save the changes 
 

To change the logic for a repair check i.e., to include or remove any distress from the repair 
logic, use the “View and Edit Repair Logic” text box.  

 
Figure C-71 shows the allowable distress for a structural check of a general system, flexible 
pavement. The repair logic is “6 and 9 and ( 15 or 3 )”. The user can edit the text in this text 
box to add or remove any distress, however, the default syntax must be used to make any 
changes. This syntax is shown in Figure C-71. 

 

 
FIGURE C-71. Edit Repair Logic 

 
Syntax for Editing Repair Logic 

1. Enter any distresses by their code numbers 
 Example:  If the logic is “Rutting” or “Wheel Track Cracking” for flexible 

pavement, the user should input “6 or 9” 
 

2. Separate text by spaces 
Example:  The correct syntax for the command “1or2or3” is “1 or 2 or 3” 
 

3. Separate brackets by spaces 
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Example:  The correct syntax for the text “1or(2and3)or4” is “1 or ( 2 and 3 ) or 
4” 

 
8.3 Project Performance 
 
In the “Report” menu, click “Project Performance.” This tool generates the project performance 
reports. 

 

Source Table: DATA_Project History_Apparent, DATA_ODOT 
Output Table: The default name for the output table is “Project Performance.” Users can 
update this table name by changing the text in the “Output Table name” text box. 
 

Figure C-72 shows the window used for generating this report. The “Analysis Range” frame 

selects the project number and parameters to be used to generate the report.  

 

 

FIGURE C-72. Individual Project Performance 
 

Example:   

Figure C-73 shows the Project Performance Report for Project Number 701-99 for PCR and 
RN (Ride Number).  This report is generated by selecting “Project Number 701-99” in the 
“Project Number” list box, and “PCR” and “RN” in the “Parameter” list box. 
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FIGURE C-73. Example of Individual Project Performance Output 
 
 
8.4 PCR Drop 
 
This tool generates a list of pavement sections with a quantity of PCR drops greater than or 
equal to a specified value, and with specific treatments performed. PCR Drop for this tool is 
defined as decrease in PCR value between any two years. 

 

Source Table: DATA_Project History_Apparent, DATA_ODOT, DATA_PERF_BASE 
Output Table: The default name for the output table is “PCR Drop List.” Users can update 
this table name by changing the text in the “Output Table name” text box. 
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FIGURE C-74. PCR Drop Tool 

 
Analysis Options 

PCR Drop >=: When checked, this option will calculate the number of PCR Drops greater 
than or equal to the value selected in the drop down box and between the values 
selected in the “From Year” and “To Year” drop down boxes 

# Of Treatments Performed: When checked, this option will calculate the number of 
treatments performed between the values selected in the “From Year” and “To Year” 
drop down boxes. The treatments selected in “Include Activities” will be counted 

 
8.5 Average Cost` 
 

This tool generates an average cost report for each activity. To generate this report, the look 
up table LU_COST must exist in the database. In the “Data” menu, click “Generate Cost 
Lookup Table” to generate LU_COST. 
 

Source Table: DATA_Project History, LU_COST 
Output Table: The default name for the output table is “Unit Cost Analysis.” Users can 
update this table name by changing the text in the “Output Table name” text box. 
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FIGURE C-75. Average Cost Analysis Interface User Interface 
 
Example: 

Figure C-76 shows the cost report for Activities 50 and 60 per lane mile, for all systems and 
in each district from 1985 to 2006. 
 
This report is generated by selecting “All Systems” under “System,” “All” under “District,” 
“1985” under “From Year,” “2006” under “To Year,” “Activity Code” under “Activity,” 
“District” under “Group By,” “50” and “60” under “Activity,” and “Unit Cost in Dollar Per 
Lane Mile” under “Cost Unit.” 
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FIGURE C-76. Average Cost Per Lane Mile for Overlays 

 
 
8.6 Structural Buildup 
 
This tool generates a current pavement structure report. 
 

Source Table: DATA_Project History, DATA_PERF_BASE 
Output Table: The default name for the output table is “Recent Pavement Structure 
Report” Users can update this table name by changing the text in the “Output Table name” 
text box. 
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FIGURE C-77. Pavement Structure Report 
 
Example: 

Figure C-78 shows the current pavement structural buildup for Route 032R in Adams 
County.  This report is generated by selecting “ADA” in the “County” list and 032R in the 
“Route” list.  
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FIGURE C-78. Recent Pavement Structure Report Output 

 
8.7 Traffic Report 
 

This tool generates the average Traffic, ESAL, and summary statistics report.  
 
Source Table: DATA_ODOT 
Output Table: The default name for the output table is “Traffic Report” Users can update 
this table name by changing the text in the “Output Table name” text box. 
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FIGURE C-79. Traffic Report User Interface 

 
Example: 

Figure C-80 shows the charts for ESALX1000, Total ADT, and Truck ADT for all systems, 
priorities, pavement types, and routes in District 1 from 1985 to 2006. The tool also 
generates a report, shown in Figure C-81. 
 
The charts and report are generated by selecting “All Systems” under “System,” “All” 
under “Priority,” “1” under “District,” “All Counties” under “County,” “All Types” under 
“Pave Type,” “All Directions” under “System,” “1985” under “From Year,” “2006” under 
“To Year,” “Year” under “Group By,” “By Mileage” under “Analysis Options,” “Line 
Chart” under “Output Options,” and “Show Average” under “Output Options.” 
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FIGURE C-80. Traffic Report Charts 
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FIGURE C-81. Traffic Report 

 
 
8.8 PCR and Distress 
 
This menu is used to generate the average PCR and distress by project age or calendar year. 
 

Source Tables: DATA_ODOT, DATA_PERF_ANALYSIS 
 
8.8.1 Average by Project Age 
 
This tool generates the average distresses, CRD (cracking deduct), PCR, and STRD (structural 
deduct) for a project year. The user interface is shown in Figure C-82. 
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FIGURE C-82. Average PCR and Distresses by Project Age 

 

Example:  

Figure C-83 shows “Year 0” or the condition immediately after overlays, on priority 
system, flexible pavements. This report is generated by selecting “All Systems” under 
“System,” “P” under “Priority,” “All” under “District,” “All Counties” under “County,” “3-
Asphalt” under “Pave Type,” “1985” under “From Year,” “2006” under “To Year,” “50 and 
60” under “Activity,” “0” under “Project Year,” “Add All” under “Activity,” and “By 
Mileage” under “Analysis Options.” 
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FIGURE C-83. Average PCR and Distresses by Project Age Output 

 
 
8.8.2 Average by Calendar Year 
 

This function reports the average distresses, CRD (cracking deduct), PCR and STRD 

(structural deduct) by pavement type, district, and county for a given calendar year. 
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FIGURE C-84. Average PCR and Distresses by Calendar Year 

 
Example:  

Figure C-85 shows the PCR and Distress Average by Calendar Year report for all distresses 
in flexible pavements, for all systems, all priorities, in District 1 from 1985 to 2006. 
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FIGURE C-85. PCR and Distresses by Calendar Year Output 

 
 
8.9 Ride Quality 
 

This report gives the ride quality (in terms of LIRI, RIRI and RN) distribution in miles by 

pavement type, district, year, etc 

 
Source Table: DATA_ODOT, LU_Parameter Range (parameter categories defined by 
ODOT) 
Output Table: The default name for the output table is “LIRI Mileage Report.” Users can 
update this table name by changing the text in the “Output Table name” text box. 
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FIGURE C-86. Ride Quality Report 

 

Example: 

Figure C-87 shows the Ride Quality Report in miles for LIRI for categories defined by 
ODOT in District 1 for each year from 1998 to 2006. 
 
This report is generated by selecting “All Systems” under “System,” “All” under “Priority,” 
“1” under “District,” “All Counties” under “County,” “All Types” under “Pave Type,” 
“1985” under “From Year,” “2006” under “To Year,” “LIRI” under “Parameter,” “Year” 
under “Group By,” and “Stackbar Chart” under “Plot Style.” 
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FIGURE C-87. Ride Quality Report Output (Left IRI) 

 
 
8.10 Additional Reports 
 
The tools under this menu are “Project History Plot,” “Statistical Report,” “General Mileage 
Report,” and “Map View of a Table.” 
 
8.10.1 Project History Plot 
 

This tool, shown in Figure C-88, is used for viewing the changes in data – PCR, for 
example – from DATA_ODOT over time for a particular route within a county based on 
the Original Record (Blog and Elog) from DATA_Project History, or Auto Detection (Blog 
and Elog) from DATA_Project History_Apparent. The tool also uses colored backgrounds 
to indicate the repair history of the selected route. 
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FIGURE C-88. Project History Plot 

 
The plot shown in Figure C-89 was generated by selecting “ADA” under “County,” “032R” 
under “Route,” and “Original Record” under “Options.” Figure C-90 was generated with the 
same settings but using “Auto Detected” under “Options.” Figure C-90 demonstrates that the 
Activities are adjusted according to PCR jumps. 
 

 
FIGURE C-89. Project History Plot Based on Original Record 
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FIGURE C-90. Project History Plot Based on Auto Detected 

 
8.10.2 Statistical Report 
 
This tool is used to calculate average or weighted average values for a user selected parameter.  
This tool is similar to Traffic Report explained earlier; however in this tool the user can select 
any parameter from ODOT in addition to traffic and ESAL. 
 

Source Table: DATA_ODOT 
Output Table: The default name for the output table is “Statistical Report.” Users can 

update this table name by changing the text in the “Output Table name” text box. 
 

 
FIGURE C-91. Statistical Report User Interface 
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Output Options 

Bar Chart Output shown in bar chart format 

Line Chart Output shown in line graph format 

Show Average Average of all data shown on graph 

 

Example: 

Figure C-92 shows the Statistical Report for PCR and RN (Ride Number) for all systems, 
all priorities, all pavement types, in each county and on all routes in District 1, for each year 
from 1985 to 2006.  
 
 
This report is generated by selecting “All Systems” under “System,” “All” under “Priority,” 
“1” under “District,” “All Counties” under “County,” “All Types” under “Pave Type,” 
“1985” under “From Year,” “2006” under “To Year,” “PCR” and “RN” under “Parameter,” 
“Year” under “Group By,” “By Mileage” under “Analysis Options,” and “Line Chart,” 
Show Average” and “Print Preview” under “Output Options.” 
 
Figure C-92 shows the generated statistical report. ODOT began collecting RN (ride 
number) data in 1998, and hence RN data slots are empty prior to 1998. 
 

 
FIGURE C-92. Statistical Report Output 
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Figure C-93 shows the PCR chart with an average line. 

 
FIGURE C-93. PCR Chart 

 
Figure C-94 shows the RN chart with an average line. 

 
FIGURE C-94. RN (Ride Number Chart) 

 
 

8.10.3 General Mileage Report 
 
This tool calculates the amount of directional mileage covered for a user selected parameter.  
 

Source Table:  DATA_ODOT,  
Output Table: The default name for the output table is “PCR Mileage Report.” Users 
can update this table name by changing the text in the “Output Table name” text box. 
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FIGURE C-95. General Mileage Report User Interface 

 
Plot Style 

Bar Chart Output shown in bar chart format 

Stack Bar Chart Output shown in stacked bar chart format 

 

Example: 

This report is generated by selecting “All Systems” under “System,” “All” under “Priority,” 
“3” under “District,” “All Counties” under “County,” “All Routes” under “Route,” All 
Directions” under “Station,” “All Types” in “Pave Type,” “1985” under “From Year,” 
“2006” under “To Year,” “PCR” under “Parameter,” “Year” under “Group By,” and 
“Stackbar Chart” under “Plot Style.” 

 
Figure C-96 shows the Mileage Report in directional miles for PCR, in categories defined 
by ODOT in District 3 for each year from 1985 to 2006.  
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FIGURE C-96. PCR Mileage Report Output 

 
 
8.10.4 Map View of a Table 
 
This tool allows for mapping of attributes if the table includes “County,” “Route,” “Station,” 
“Blog,” and “Elog” fields. 
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FIGURE C-97. Map View of Table User Interface 

 
Legend Options 

Classify: Set the number of categories 
Gradient: Determine the middle category colors by grading the top and bottom category 

colors 
Reverse: Flip the selected colors 
Background: Superimpose map against Ohio geographical outline 
 

Example: 

Figure C-98 shows the map view of PCR data in DATA_ODOT for priority system routes 
in the entire state for 2006. 

 
This report is generated by selecting “All” in the “District” list which appears when 
“District” is selected, “All Routes” under “Route,” “DATA_ODOT” under “Table,” 
“DOWN” under “Station,” “2006” under “Year,” and “PCR” under “Event.” 
 
The user can right click on the map to export it as an image. 
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FIGURE C-98. Example of Map View 
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Window Menu 

 
The “Window” menu includes normal Microsoft functions for controlling the simultaneous 
display of multiple open windows. 
 

 
 

FIGURE C-99. ODOTPMIS Window Menu 
 
9.1 Tile Horizontally 
 
Horizontally tile all non-minimized windows. 
 
9.2 Tile Vertically 
 
Vertically tile all non-minimized windows. 
 
9.3 Cascade 
 
Cascade all non-minimized windows. 
 
9.4 Arrange Icons 
 
Arrange icons for minimized windows. 
 
9.5 Close All Windows (Shortcut Key: CTRL+Q) 
 
Close all opened tables and queries. 
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Help Menu 

 

 
 

FIGURE C-100. ODOTPMIS Help Menu 
 
10.1 Contents 
 
Click this option to open the help file. The help file can also be activated by pressing the F1 
key. Select the form or tool in question and press F1. Help for that topic will be displayed. 
 
 
10.2 About 
 
This option provides downloads of the latest updates for ODOTPMIS and specifies the current 
version number. 
 

 
 

FIGURE C-101. ODOTPMIS About Dialog Box 
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D.1: INTRODUCTION 

 
The Infrastructure Information System Laboratory at the University of Toledo has developed a 
database of pavements under local systems for the Ohio Department of Transportation.  The 
database is in Microsoft Access database format.  The LOCALPMIS includes the database and 
a set of reporting tools to extract the data necessary for pavement performance analysis.   
 
All the basic operations of LOCALPMIS are similar to the ODOTPMIS. For more information, 
on the procedure for installation of LOCALPMIS, interface elements, File Menu, Edit Menu, 
View Menu, Windows Menu, Help Menu and Index Menu kindly refer Appendix-A. 
 
However, the Data Menu, Tools Menu and Report Menu have been changed to synchronize the 
PMIS tool with the federal-aid local route pavement condition database. Therefore, this manual 
focuses solely on the detail descriptions of these three revised menus. 
 

D.2: Data Menu 
 
The Data Menu contains functions that add or modify various tables needed for operation of 
LOCALPMIS.   
 

 
Figure D.2-1    LOCALPMIS Data Menu 
 
 

D.2.1 IMPORT ADDITIONAL PCR DATA 
 

Import Additional PCR Data sub menu is meant for importing or appending new 
pavement condition data and subsequently calculate PCR and deducts from the 
available distresses in the database. 
 
In the Data menu choose and click the Import Additional PCR Data. A browser window 
as shown in Fig. D.2-2 appears. Select the required *.txt file(s) from the desired 
location(s) and click the OK button. This allows updating the [Local_PMIS] table. 
Pavement condition data in terms of Pavement Condition Rating (PCR) and severity 
and extent of each individual distress like raveling, rutting, settlements etc. are stored in 
[Local_PMIS] table.  This table also stores road classification and all traffic 
information. Pavement condition data should be updated annually.  To import condition 
data correctly, the source data file must have the required format. 
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Table to Apply: [Local_PMIS] 
Data file type: Coma delimited text file 
Data format: 

First Line: Field Name 1, Field Name 2, …, Field Name 64 
Second and after: Value 1, Value 2, …, Value 64 

 

 
Fig. D.2-2 Import Pavement Condition Data 
 

Comments 

The first line of the input text file is for reference only. Actual field names are specified 

within the software. Field values must be in the order specified in Table D.1. 

 
Table D.1 Field Order, Name and Data Format 

Order Field Name Data 
Type Example 

1 NLFID Text TCOSTS00453**C 
2 District Number 5 
3 County Text COS 
4 Priority Text L 

5 System Text Non-Federal 
Aid(Local) 

6 Jurisdiction Text T 
7 Route Text 453 
8 route_suffix Text  
9 Station Text UP 
10 Blog Number 0.36 
11 Elog Number 0.93 
12 begin_street Text  
13 end_street Text  
14 Length Number 0.57 
15 PCR Number 80 
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16 Total Deduct Number 23 

Order Field Name Data 
Type Example 

17 Structural Deduct Number 15 
18 Rater Text RS 
19 one_if_construction Number 0 
20 rated_date Number 121503 
21 form_number Number 5 
22 NHS Text No (write Yes/No) 
23 PROJECT Text  
24 Lanes Text  
25 Lane Number Text  
26 Plot Last Year Text No (write Yes/No) 
27 Under Const Text No (write Yes/No) 
28 Metric Text No (write Yes/No) 

29-53 code 1 -  code 25 Text 1 = LE 
54 divided_undivided Text U 
55 curb_rating Text N 
56 sidewalk_rating Text N 
57 utility_cut Text  
58 drainage Text  
59 Year Number 2003 
60 begin_description Text COSHOCTON CL 
61 divided_RI Text  
62 street_name_prefix Text  
63 street_name Text T-453 
64 street_name_suffix Text RD 
65 street_name_suffix2 Text  
66 street_name_suffix3 Text  
67 surface_type Text I 
68 surface_width Number 20 
69 roadway_width Text  
70 pavement type Number 5 
71 functional_class Number 17 
72 muni_name Text  
73 muni_street_number_suffix Text  
74 Township_Name Text  
75 mileage_class Number 1 
76 number_lanes Text  
77 proposed Text  
78 ADT Category Text M 
79 ADT Number  
80 Truck ADT Category Text L 
81 Truck ADT Number  
82 Base Text  
83 Notes Text  
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After the new data is appended successfully to the existing [Local_PMIS] table, the 
PCR, Structural Deduct, Cracking Deduct, and Total Deducts are calculated for the 
entire database. The original pavement condition data contains PCR, and Distress 
ratings. After calculation of PCR and deducts, the tool checks for any mismatch 
between the imported PCR and the PMIS calculated PCR values. If any mismatch 
persists, the user is prompted to select either the calculated PCR or the imported PCR 
for all future analysis. The PMIS tool memorize this selected PCR and store it in a new 
field named PCR_Ana in the [Local_PMIS] table. All the analysis in LOCALPMIS is 
based on the PCR values stored under PCR_Ana field in [Local_PMIS] table. 

 
 
D.2.2 Generate Performance Base AND ANALYSIS Table 
 

In the Data menu click Generate Performance Base and Analysis Table. This tool first 
generates the [DATA_PERF_BASE] table and then generates the 
[DATA_PERF_ANALYSIS] table. 
 
Both [DATA_PERF_BASE table] and [DATA_PERF_ANALYSIS] table are the basis 
of most of the pavement condition prediction analysis. Therefore, every time new data 
are added, user is recommended to generate and automatically update these two tables. 
 
This entire procedure of preparing the base table and the analysis table is very time-
consuming.  Do not restart the computer while it is in progress. The database size could 
increase during this procedure.  The user is encouraged to perform a database 
compacting operation before and after using this function.  

 
D.3: Tools Menu 

 
This menu contains functions that pavement condition prediction and remaining life estimation. 
This menu also contains an option to modify the decision tree to identify the repair of pavement 
based on the current condition. 
  

 
 
Figure D.3.1 LOCALPMIS Analysis Tools Menu 
 
D.3.1 FUTURE CONDition prediction 
 

This sub menu can be used for predicting future pavement condition using linear 
regression model. Both PCR and distress for every pavement section in the database are 
predicted for some chosen no. of years. Once the prediction of PCR and distress are 



 

 D-6 

completed, the remaining life of the pavement is estimated based on either PCR or 
distress, as per the choice of the user. 

  
In the Tools menu click on the submenu Future Condition Prediction. The form as 
shown in the Fig D.3.2 pops up. This form guides the user to do the prediction of 
pavement condition and estimate the remaining life. For each pavement type the user 
will have to do the prediction separately. Prediction of pavement can be done either 
based on system or district or county, as per the requirement of the user. However, if 
sufficient data which reveals certain drop in PCR in certain county or district is not 
available, then the results of doing district-wise or county-wise prediction can lead to 
misleading or no result. In that case, users are advised to include more data from other 
districts or counties for doing the prediction. 

  
All the features in the prediction form as labeled in Fig D.3.2(a) are described as below: 
 
 
 

Feature Label as in Fig 
3.1 Description 

Analysis Range 

System 1 Includes either Federal Aid(Local) or 
Non-Federal Aid(Local) or both. 

District 2 
Lists all the 12 districts. The user can 
either select any particular district or can 
select All Districts to do the prediction. 

County 3 

Lists all the counties in the selected 
district(s). The user can either select any 
particular county or can select All 
Counties in the selected district (s) to do 
the prediction. 

Pave Type 4 

Lists all the 7 type of pavements. For 
each pavement type, the user will have to 
select the particular pavement and run 
the prediction separately. There is no 
option like “All Pavements” in this list. 

From Year 5 

The user can select the start of analysis 
year. The model includes the data 
starting from this selected year in the 
regression model. The default value is 
kept as 2003. 

To Year 6 

The user can select the end of analysis 
year. The model includes the data till this 
selected year in the regression model. 
The default value is kept as the latest 
data year available in the database. 

Rem Life 7 The user can select any year from this 
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Feature Label as in Fig 
3.1 Description 

from year drop box. The remaining life of 
pavement is then estimated assuming this 
selected year as the base year. The 
default value is kept as the current year. 

Prediction Option 

# of Years 8 
The user can select any no. of years of 
doing the prediction from this drop box. 
The default value is kept as 5. 

Rem. Life PCR Thresholds 

Local 9 

This field cannot be left blank. The user 
will have to provide the threshold PCR 
value, below which the pavement section 
is deemed to be at the end of its life. 

Use Distress 
Criteria 10 

If the user desires to estimate the 
remaining life based on distress, then this 
field must be checked. 

Edit Criteria 11 

Clicking this button the user can define 
the threshold extent and severity of 
selected distress to estimate the 
remaining life. On clicking, another form 
as shown in Fig. D.3.2(a) will pop up. 
This form will guide the user to define 
the distress and its threshold extent and 
severity that influences the life of the 
pavement 

Output Tables 

All output 
tables 12-15 

It is advised to keep the Table Name 
unchanged. This table names are 
identified in some program to generate 
the reports and graphs 

Generate 16 

The prediction and estimation of life of 
pavement is initiated by clicking this 
button. This process is a bit time 
consuming. So users are asked to be 
patient while running this model. 

Close 17 If this button is clicked the form as 
displayed in Fig D.3.2(a) is unloaded 
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   Fig. D.3.2(a) Future Condition Prediction Form   
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Fig D.3.2(b) Remaining Life Distress Thresholds form 
 
 
D.3.2 MODIFY REPAIR DECISION TREE 
 

This sub menu helps the user to modify the repair decision tree prior to determine the 
recommendations for repair for each pavement section. The treatment logic for Local 
Pavement is shown in Fig. D.3.3 (a) below. The user can change the threshold PCR and 
Structural Deduct in this logic form. As the decision tree for Brick and Gravel 
pavements are not available, currently the decision trees for Jointed Concrete Pavement 
and Local Pavement are only included. To modify the logic for distress, the user will 
have to click the Miscellaneous Criteria, labeled as “1” in Fig D.3.3 (a). The form for 
Miscellaneous Criteria is shown in Fig. D.3.3 (b). In this form the user can first find the 
default setup for the distress logic using the record locator option. Selecting the desired 
pavement type and clicking the Search button will help the user to get the Allowable 
Distress. User can then change the desired extent and level of each available distress for 
the selected pavement type. The repair logic to consider the distress types using “AND / 
OR” can be set up in the View and Edit Repair Logic field. After doing all the necessary 
changes, the user should either click the APPLY or the OK button to make the changes 
in the [LU_Repair Logic]. The recommendation of treatment is then based on this new 
logic setup by the user. 
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Fig D.3.3 (a) Treatment Logic form 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig D.3.3 (b) Treatment Logic for Distress 

1
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D.4: REPORT Menu 

 
This menu contains tools for to generate specific reports and graphs of the database. 
 

 
Figure D.4.1 LOCALPMIS Report Menu 
 
D.4.1 GENERATE CURRENT PAVEMENT CONDITION REPORT 
  

This submenu generates the existing pavement condition report. User can generate the 
report either district-wise or for any particular county. The form as shown in Fig. D.4.2 
guides to generate this report. The grid table generated contains the existing PCR and 
distress for the pavement sections in the selected district or county. The grid table can 
be exported to Microsoft Excel® by clicking anywhere within the grid table. 
 

 
Fig. D.4.2 Current Pavement Condition Report Form 
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A glimpse of the generated grid table for existing pavement condition is shown in Fig D.4.3 
below: 
 
 

Fig. 
D.4.3 Current Pavement Condition Grid Table 

 
 

D.4.2 PCR DROP 
  

This sub-menu lists all the pavement sections whose yearly change in PCR is more or 
equal to the selected PCR Drop value. Fig. D.4.4 below illustrates the PCR Drop form. 
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                   Fig. D. 4.4 PCR Drop List form 

 

D.4.3 show predicted pavement condition 
Under this sub-menu two more menus are available: Generate PCR Grid Table and  
Show Section-wise PCR Trend 

  
Generate PCR Grid Table 

 
This option helps the user to generate PCR grid table either district-wise or for any 
particular district. On clicking the form as in Fig D.4.5 will pop up. 
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Fig. D.4.5 Generate Predicted PCR Grid form 

 
 
The grid table contains all the following fields: 
 

District Pavement 
Type 

County Base 
Route Surface Type 

Station Remaining 
Life 

Blog Remarks 
Elog PCR 

 
The surface type field lists whether the pavement section has asphalt or brick or 
concrete or gravel surface. The Remarks column in the grid table indicates whether the 
predicted distress predominates in the estimation of remaining life. If the cell under 
Remarks column is blank, then it indicates that the future PCR plays dominant role in 
estimation of remaining life. 
 
The PCR field lists the year-wise existing and predicted PCR values. The predicted 
values are displayed till the year the prediction was done using the Future Condition 
Prediction submenu under Tools menu. 
 
This grid table can also be exported to MS Excel ®. 
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  A glimpse of the grid table generated for District – 5 can be seen in Fig D.4.6 
 

 
  

Fig D.4.6 Predicted PCR Grid Table 
 

Show Section-wise PCR Trend 
 
This option helps the user to generate PCR trendlines for any selected pavement section. 
On clicking this menu, the form as shown in Fig D.4.4 pops up. As seen in the form, 
user can select any particular route within any county and can then select the desired 
pavement section from the Blog-Elog list of the selected route. Both existing and 
predicted PCR trends are then plotted for the chosen section when the PLOT button is 
clicked. The graph depicting PCR trends for the section displayed in the Fig D.4.7 is 
shown in Fig. D.4.8. 
 

 
Fig D.4.7 Generate PCR Trendline form 
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Fig D.4.8 Graph showing PCR Trend 

 
For display purpose, the user can change some settings, as shown in Fig D.4.9 
by clicking the right button of the mouse. 
 
 
 
 

 

 
 
 
 
 

Fig D.4.9 Customizing PCR Trend Graph 
 

The scale of the axes can be changed by clicking the Customization Dialog… option as 
seen in Fig D.4.9 and then going to the Axis option within the dialog form. The 
Max/Min options should be clicked to change the scale of PCR axis. 

   
User can also use the Export Dialog…to export the graph in JPEG or PNG or BMP or 
txt format. The graph can also be printed by using the PRINT button available within 
the Export Dialog form. 
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D.4.4 REPAIR CANDIDATES 
  

This submenu is used to generate the recommendation report of repair of the pavement 
sections. The recommendation is based entirely on the repair logic set up by the user. 
Currently there is no default logic set up for the Brick and the Gravel pavements. 
Therefore, the report displays the recommended repair for only local pavement and 
jointed concrete pavement sections. 
 

 
Fig. D.4.10 Repair Candidates Form 
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